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Chapter 3 Functions (Updated 06/29/2016) 

This chapter describes all of the functions available on the Environmental Screening Tool. Not all of the 
functions are available to all of the users. The actual functions which appear will depend on the user’s access 
role defined when the user account is established.  (See Table 1-1 in the Overview chapter for the complete list 
of roles and privileges.) 

Function descriptions are organized in subsequent sections according to major functional categories as they 
appear in the EST main menu: 

 Tools – Used primarily for data entry related functions 

 Reports –  Standard reports and queries which retrieve data from the database 

 Wizards – Composed of tools and reports to step a user through a sequential process 

 Maps – Opens the interactive maps for viewing or editing, and provides access to standard hard copy 

maps 

 Account Settings – Contains options for setting user-specific preferences 

 Help – Includes system help and other help-related information pages, such as Frequently Asked 

Questions 

3.1 Tools (Updated 05/30/2016) 

The main menu tools are used primarily for data entry related functions, which include all input provided 
throughout the life cycle of a project. See Table 2-2 in Chapter 2 of this Handbook for a list of the options 
available in the Tools category.  To open the Tools menu, click on the up arrow. To close the menu, click the 
down arrow. The functions within categories appear to the right when the cursor hovers over the name. 
Features that are not available to users because of their assigned role do not appear on the menu.  

3.1.1 Area of Interest (AOI) (Updated 05/30/2016) 
The Area of Interest (AOI) function allows authorized FDOT users to create and analyze items that are outside 
of the standard ETDM project review process.  As a separate feature, the AOI tool provides you the flexibility to 
digitize and analyze an area without affecting established ETDM projects.  The AOI feature is jurisdictional, 
which allows you and members of your organization to: 

 Define a study area and use the analysis information to support decisions or provide documentation for a 

file.  

 Digitize a shape (point/line/polygon) and apply buffers, if needed. 

 Run the Sociocultural Data Report (formerly known as CCI) to view community boundaries and the 

Standard GIS Study Area Analysis. 

 View report results. 
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The AOI tool is only available to users with the appropriate roles and privileges. This handbook section 
provides steps for: 
 

 Accessing the AOI Screen 

 Opening the AOI from the AOI Tools menu 

 Opening the AOI from the EST menu 

 Using the map bar to open the AOI 

 Searching for an existing AOI 

 Creating an AOI 

 Working with features 

 Working with the buffer distances 

 Running an analysis 

 Downloading shapefiles 

 Editing an existing AOI  

 

 Accessing the AOI Screen 3.1.1.1

1. There are a few ways you can open the AOI screen. 

 Use the menu – Depending on your EST role, you will have one of the following map menus 
displayed on your screen. 

 On the AOI Tools menu, click View Interactive Maps. 

 On the Maps menu, click View Interactive Maps. 

 Click the Map bar. 

 If you are searching for a specific AOI, type a keyword for the AOI into the Golden Search bar, 
located in the upper-right corner of the EST window. 

2. The AOI page displays the interactive map and a panel showing a list of AOIs. Select the list you would like 

to display by clicking on of the following buttons: 

 Only my AOIs – Displays only the maps you have created. 

 All AOIs for {name of agency} – Displays all AOI maps created by members of your agency. For 
example, if you are a District Coordinator, you will see AOIs that have been created by users within 
your district. 
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3.1.1.1.1 Opening the AOI from the AOI Tools menu 

If you have been assigned the AOI editor role, you will see the AOI Tools menu on the left side of the 
screen. Click the View Interactive Maps link to go directly to the AOI tool. 
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3.1.1.1.2 Opening the AOI from the EST Maps menu 

You can access the AOI tool through the EST Maps menu by doing the following: 
 

1. On the Maps menu, click View Interactive Maps. 

2. Click the Tools link, located at the top of the map viewer. 

3. Click the Area of Interest link. 

 
 

3.1.1.1.3 Using the map bar to open the AOI 
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Another way to access the AOI tool is with the yellow Click to Open Map bar, located on the right side of 
your screen.  
 

4. After the map opens, click the Tools link at the top of the map viewer. 

5. Click the Area of Interest link to display the AOI tool. 

 

3.1.1.1.4 Searching for an existing AOI 

Using the Search bar at the top of the EST site provides you quick access to an existing AOI map.  
 

1. Type the name of the map or a keyword related to the map into the Search field. 

2. Click Search, or you can press your keyboard’s Enter key. 

3. The Search Results page will display the results, based on your search query, under the Areas of 

Interest heading.  

 Click the Area of Interest name to display the map. 

 Click the View Standard EST Study Area Report link to open the GIS Analysis Reports page for 
the selected AOI. This report displays the results of the analysis performed on the area. 

 Click View Sociocultural Data Report link to display the demographic information for the area. 
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 Creating an AOI 3.1.1.2

On the left side of the map view is a box, which is the Area of Interest wizard. The wizard will guide you step-
by-step through the process of drawing features within an area and running an analysis.  The tools you will need 
to work with an area are provided on the wizard screen. The first screen you will see is a list of available AOIs. 

 

 

1. Click the New button to begin. 

2. Click on the map to zoom in on the area. 

3. On the Area of Interest box, enter the following information: 

 Name – By default the name My Area of Interest appears in this field.  You will want to change 
the default to a name that applies to the AOI you are creating, such as a cross street or 
neighborhood name. 

Note: Be sure the name you give the AOI is unique to prevent confusing it with another AOI 
created by your colleagues. 

 Keep Until – AOIs are kept for a limited time, with a default time limit of 30 days. You can establish 
the length of time you would like to keep an AOI by typing the expiration date, or you can click the 
box and use the calendar icon.  

Note: To remove an AOI that you created, change the expiration date to the current date. 

 Description – Type a description of the AOI. This can include your name, along with information 
about the AOI, why it’s needed, who created it, etc. 

4. Click Next.  

Note: Clicking the Next button for each step of the wizard automatically saves your information. 
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The next screen displays the tools you can choose to create a feature. You will be able to create 
multiple features for an area. 

3.1.1.2.1 Working with features 

You can add one or more features to an area following the steps listed below.  
 
Tip!  See the Area of Interest Tool video for instructions on creating the different feature types, such as 
drawing a Polygon or using the Extract Segment tool. You can find the AOI training video, along with other 
informative EST videos, in the ETDM Library. Go to the Help menu and click on the Training Videos link.  

 

1. Select the feature type by clicking the relevant button.  Note that the Draw icon becomes highlighted and a 

crosshair appears on the map. 

2. Name your feature. When you click a feature type, a name for the feature appears in the Feature table, 

along with a description of the feature Type and options for deleting and zooming.  You can keep the 

default feature name shown on the table, or you can type over it and give the feature another name.  For 

this illustration, this feature’s name is being changed to Bus Stop. 

3. Click on the map to begin drawing. As you start drawing, the Edit tool will become highlighted. This 

indicates your drawing is in edit mode, and you can make changes to a shape by using the AOI tools. 
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Tip! Click the icons on the Area of Interest drawing toolbar to: 

 
Draw feature 

 
Edit feature 

 
Edit buffer (Option not available for polygon) 

 
Undo preceding action 

 
Redo current shape 

 
Zoom to feature 

 Delete feature 
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As you add features, the map displays your drawing on the map, with each feature listed on the Feature 
table. 
 

 

3.1.1.2.2 Working with the Buffer Distances 

When you set a feature, you can establish the buffer distance by selecting the unit and distance values.   
You can change the buffer for an individual feature; not all features have to be assigned the same buffer 
distance.  
 
Note: Polygons do not have buffer distances because you are defining a general area rather than a point, 
line, or segment. The type of each feature is listed in the Feature table.  To set a buffer distance, do the 
following: 
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1. To change the buffer distance, type the distance value into the Buffer Distance box and select the units. 

For this illustration, the default measurement unit is Feet. 

2. Click Update Buffer. 
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The map displays the updated buffer area. 

 

Tip!  At any time, you can check the area on the aerial map. Use the map slider on the right side of 
your screen and move the slidebar upward to reduce the distance. The drawn area displays as a 
transparent red layer.  To return to drawing mode, move the slider downward. 
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3. To make changes to a feature’s buffer, click the Edit Buffer button. 

4. A message will appear, notifying you that editing the buffer will override your drawn line. Click OK to 

proceed with editing the buffer, or click Cancel to stop the edit buffer process. 

When you go into edit buffer mode, the feature type changes to a polygon.  The buffer area around 
your line, point, or segment is now a general area that is separate from your original drawing. 

 

You will also see there are many vertices on the edge of the buffer. You can remove them by right- 
clicking on the vertices.   
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5. To change the shape of the buffer, left-click on a vertex or midpoint and drag it to your desired location. 

Tip!   Go to the Area of Interest Tool training video to see a demonstration of working with map 

features and buffers.  To access the training video, go to the Help menu, click Training Videos, 
and then click the Area of Interest Tool video link. 

6. When you are done creating and editing the features for your AOI, click the Next button to save your 

information.  The map will refresh and then display your feature(s) – highlighted as green and with the 

feature’s name shown as a label. For this illustration, the feature’s name is shown as Corner of E Fowler. 
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This step allows you to review the map before running the analysis. If you want to make changes to 
the map, click the Previous button.  This will take you back to the AOI editing tool.   

3.1.1.2.3 Running an Analysis 

Once you have created or edited a map’s features, you can select the type of analysis or report to run. By 
default all analysis boxes are shown as selected. Click the Run Analysis button to begin generating the reports. 

 

After you click Run Analysis, the list of reports shows as links. 
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Tip!  The analysis runs on the server independent of whether the user is still logged on to the 

EST. You can close out the AOI map and come back later when the analysis has completed. 

After Running an AOI Analysis 

The following list presents a brief explanation of each component of the AOI analysis that is run: 

 Standard EST Study Area – This is a GIS Analysis report of the AOI in an html format. The GIS 
Analysis Report window will open in the EST and display all of the data layers for the issues 
within the AOI. The GIS Analysis Report feature in the EST allows you to view a summary of 
each of the AOI’s features, save a copy of the report to your desktop, and select additional data 
layers for analysis.  

Note: The GIS Analysis Report does not show buffer distances for AOIs.  

 Sociocultural Data Report (SDR) – Displays a demographic profile of an area around a drawn 
AOI boundary. The report shows a summary and analysis for each of the features drawn on the 
map. For more information about the SDR, see the EST User Handbook and the Sociocultural 
Data Report training video.   

 Hardcopy Maps – Click this link to generate a hard copy of an AOI map. Your map will display on 
the Print Hardcopy Maps page, where you can select the type of format (JPG or PDF) for printing 
your map and then save it to your desktop. All maps are formatted for 8.5 X 11 pages. 

 Cultural Resources Data Report – Displays a profile of cultural features within and around an 
AOI boundary.  The report displays as a PDF, showing a summary and analysis for each feature 
along with a map that identifies the locations of historic resources.  

Tip!  See the following training videos for additional information on using these EST features: AOI 

Tools, GIS Analysis Report, and Sociocultural Data Report. 
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3.1.1.2.4 Downloading Shapefiles 

You can download drawn AOI features as shapefiles to your desktop, and then open the files with a 
mapping tool like ArcMap.  The downloaded files provide additional documentation to support the shape 
used for the analysis reports generated with the AOI tool.  Shapefiles display all of the features that were 
created for a file.  
 

1. There are a couple of ways to download an AOI’s shapefile to your desktop: 

 From your list of AOIs – The first screen you’ll see when opening the AOI tool contains a list of 
available AOIs. Click the Download link to download the shape.  

 From the analysis request list – After an AOI has been submitted for analysis, a link to the shapefile 
displays. Click the Download Shapefile link to begin the file’s download. 

2. You will be prompted to download a zip file.  The file displays an ID number for the AOI.  Click Save file, 

and follow the standard process for saving and opening zip files.  

Note: Saving a file includes all of the files for the shapefile.  

 Editing an Existing AOI 3.1.1.3

You can make edits to an AOI that has been created by you or another member of your organization. Your edits 
can be to a single feature or to multiple features. Generally, the editing of features follows the same process 
described in the previous sections of these instructions.  

1. Open the Area of Interest tool. 

2. In the Area of Interest wizard, click the Edit link for the AOI. 

 

3. The Area of Interest panel displays the AOI Name, date of expiration (Keep Until), and Description, if 

any. You can make edits to the information or extend the expiration date. 

4. Click Next. 

5. The AOI map displays, along with the list of current features. To add a new feature, select the feature type 

by clicking the button. 

6. Click the map to begin drawing your shape. 

7. Click the Next button to run the analysis, generate the sociocultural data report, and generate hard copy 

maps. 
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3.1.2 Sociocultural Data Report (New 06/30/2014) 

The Sociocultural Data Report (SDR) replaces the former Community Characteristics Inventory (CCI) report. 
The SDR provides sociocultural effects analysis for community boundaries that have been added by FDOT 
(user-drawn boundaries) and the U.S. Census Bureau, and displays sociocultural effects analyses for project 
alternatives and areas of interest (AOIs).  The data are derived from the U.S. Census Bureau’s decennial 
census (e.g., household and population estimates) and the most recent American Community Survey (ACS).   

Information is presented in a tabular and graphical format, detailing a community’s sociocultural statistics and 
trends for the following: 

 Demographics 

 Poverty indicators 

 Housing values 

 Land-use types 

 Community Resources 

An SDR is generated upon completion of a GIS report and can also be generated within the EST map editor 
(depending on user permission). The following instructions demonstrate the steps for accessing and navigating 
the SDR using the EST Reports menu. 

 

1. On the Reports menu, point to Community Coordination, and then click Sociocultural Data Report. 

 

The Sociocultural Data Report page opens, displaying options for the type of report you want to 
generate.  

 

2. Under Select  your report query, click one of the following option buttons to display the sociocultural 

data: 

 User Defined Community – User-defined community, municipal, and neighborhood boundaries 
created by the user in the EST mapping tool.  

 Census Place – Census designated places as defined by the U.S. Census Bureau. 
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 Area of Interest (AOI) – User-drawn areas for local projects that are not going through the 
ETDM process.  AOIs drawn on the interactive mapping tool will appear on the SDR. 

Note: The Area of Interest (AOI) option will only appear for users who have created 
AOIs in the EST mapping tool.  If you have not created any AOIs, then the option will 
not appear at the top of the Sociocultural Data Report page. 

 County Demographic Profile – Displays demographic profiles for all 67 Florida counties. 

Note: The County Demographic Profiles are also included in the User Defined 
Community and Census Place for any counties that intersect a project area. 

 Current Project Alternatives – Allows you to run a demographic profile for a project alternative.  

 

Tip!  For details about the data shown on the Sociocultural Data Report page, go to the  

Sociocultural Data Report training video.  On the Help menu, click the Training Videos link, and 
then click Sociocultural Data Report. 

 

 

3. After making your selection, additional drill-down fields appear that allow you to narrow your choice. Click 

the drop-down arrow, , to expand a field and view the selected options.  

 For User-Defined Community, a list of communities and buffer distances will display. 
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 For Census Place, do the following: 

 Click the ALL drop-down arrow, . 

 

 A list of Florida’s sixty-seven counties displays. 

 

 Click a county name to select it, or accept the ALL default to include all counties. 

 Click the drop-down arrow  on the next list box to narrow your selection. 
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 Click one of the options to select it. 

 

 For Area of Interest (AOI), do the following: 

 Click the drop-down arrow  to expand the list of AOIs that you created. 

Note: The AOI option will not be available if no AOIs have been created. 

 

 Click the appropriate option. 

 

 For County Demographic Profile, do the following: 

 Click the drop-down arrow  to expand the county list. 
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 Click the appropriate option to select it. 

 For Current Project Alternative, do the following: 

 On the Active project field, click the drop-down arrow , and then select a project 
alternative from the list. 

 

 Click the Current Project Alternative option button.  The project alternative shown on the 
Active project field appears on the box below the report query buttons. 

 

 Click the drop-down arrow  to expand the list of project alternatives, if there are multiple 
alternatives. 

 

 Click the appropriate option to select it. 

4. Click Generate Sociocultural Data Report. 
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The Sociocultural Data Report page refreshes and displays the report, along with a thumbnail of 
the map. 

Tip! Click the Generate County Demographics Profile button to display the data for the county 
where the community is located. 

 

 

Tip!   Click the toolbar icon on the window to: 
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   Export the page to a PDF file. 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 
 
The report sections display trends (e.g., General Population, Race and Ethnicity, Age, and Language) 
and demographic profiles for the selected area.  The information shown on the SDR is based on data 
from the U.S. Census Bureau’s decennial census and the ACS.   
 
Note: The latest ACS data shown is for 2012. Because the ACS is taken every two years, this information 
will be updated when it becomes available. 
 

  
  
 

5. Scroll to the bottom of the Sociocultural Data Report page for information about the sources of the 

reported data under the following headings.   

 Community Facilities 

 Block Groups 

 Data Sources 

 County Data Sources 
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 Metadata  

 

6. Below the SDR you can find the County Demographic Profile.   

Note: If multiple counties intersect a community, all county demographic profiles will be listed. 

The County Demographic Profile (CDP) allows you to perform further comparison between the 
county data with the community data displayed in the SDR.  The only differences in the data 
presentation between the two reports is that the CDP does not include data for land use and 
community facilities.  Additionally, the CDP only provides graphical data for the county profile; the 
community and county comparison is not duplicated. 

 

 

3.1.3 Financial Office (In Development) 

3.1.4 Project Diary (09/30/2015) 

The Project Diary category listed in the Tools menu allows users to create or update the project record and 
ancillary data.  To view the list of available functions, point to Project Diary and then click on a function title to 
open the form. 
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 Create New Project Record (Updated 09/25/2014) 3.1.4.1

The Create New Project Record function in the Environmental Screening Tool (EST) Tools menu 
enables authorized users to do the following: 

 Add a project to the EST database, including Project Description Summary, Purpose and Need, 

Federal Consistency, and other related project information.  

 Designate a project as a Local Agency Program (LAP) project, assign a new or existing LAP agency, 

and enter the assigned LAP agency's PD&E LAP certification status. 

 Designate agencies that will be exempted from participating in the project’s Environmental Technical 

Advisory Team (ETAT) review.   

Users with the following EST roles may access the Create New Project Record tool: Environmental 
Management Office liaisons and managers, FDOT ETDM Management Team, FDOT ETDM Data Entry, 
District ETDM Coordinators Primary, District ETDM Coordinators, Metropolitan Planning Organization (MPO) 
Coordinators Primary, MPO Coordinators, and Project Managers. 

Creating a New Project Record: 

1. On the Tools menu, point to Project Diary, and then click Create New Project. 

 

The Create New Project Record page opens, displaying a page toolbar and an Overview form.   
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Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

 

2. For the Project Name and Planning ID fields, enter the name of the project and the Planning ID 

number.   

Note: Red asterisks (*) indicate a required field.  If the field is blank, the information must be 

added before the form can be processed. 

3. For the Local Agency Program (LAP) field,  do one of the following: 

 Leave Unknown as the default selection if the project's LAP status has not yet been determined. 
Go to Step 5. 

 Click the drop-down arrow, , and then do one of the following: 

 Click Yes if the project is being contracted out by the FDOT to a local agency. Go to the 
next step. 

 Click No if the project is not being contracted out to a local agency. Go to Step 5. 

 Click Anticipated (Planning Phase only) if the project is in the process of being 
contracted out to a local agency. Go to the next step. 
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4. If you selected Yes or Anticipated (Planning Phase only) for the Local Agency Program (LAP) 

option, the Overview form displays fields for adding LAP information.  Do the following: 

 For LAP Agency, select the LAP agency responsible for the project by doing one of the 
following: 

 Click the LAP Agency arrow to expand the list, and then select an agency by clicking on 
the agency name. 

 If the LAP Agency is not listed, click the Add another agency to this list link, and then 
type the name of the agency in the text box.  

 

Tip!   If the agency is already in the EST database, you need to type only the first three letters 

of the name. The EST automatically displays a list of names that match your text. Click the 
appropriate selection from the list. 

 

 If the agency is being added to the EST database, type the agency's entire name. The 
agency will be added to the database. 

 In the Agency Completing NEPA Document field, do one of the following: 

 Click the FDOT option button if FDOT will be completing the National Environmental Policy 
Act (NEPA) document, and then go to Step 6 of these instructions. 

 Click the Local Agency (with FDOT oversight) option button if the local agency will be 
completing the NEPA document.  

Note:  Local agencies must be PD&E LAP Certified if completing the NEPA 
document with FDOT oversight. 

 



 

 

 

 Environmental Screening Tool Handbook - February 15, 2016 3-34 

The LAP Agency Certification field appears, displaying options for the 
agency’s PD&E LAP Certification status.  

Note:   The agency must be certified by the District LAP Administrator for the 
type of work it will be performing. After the project information has been 
submitted, the District LAP Administrator will receive an email notification 
about the project’s LAP designation and whether the need for agency 
certification has been indicated. 

 In the LAP Agency Certification field, click the appropriate option button beside one of the 
following LAP Certification statements: 

 

 is already PD&E LAP Certified (The agency selected in the LAP Agency field has 
completed the Local Agency Certification Qualification Agreement and has been approved 
by the District LAP Coordinator.) 

 will need to be PD&E LAP Certified via LAP Coordinator (The agency selected in the 
LAP Agency field is pending approval by the District LAP Coordinator.) 

5. Add information for the remaining fields: 

 Financial Management No. – Enter the Financial Management Number, if available. 

 Counties – Use the Counties scroll bar to move down the list. Select one or multiple options by 
clicking the county name(s). 

Tip!  Use SHIFT + click to select adjacent options. Use CTRL + click to select non-adjacent 

options. 

 Beginning Location – Type the project’s beginning location. 

 Ending Location – Type the project’s ending location. 

 Alternative Corridor Evaluation (ACE) – Indicate whether or not this project is participating in 

the ACE process by either accepting the default No or by clicking the drop-down arrow, , and 
then selecting Yes. 

 ETDM Phase – Click the Project Phase link to open the Update Project Phase page, enabling 
you to change the project phase.  

Note: When a screening cycle is completed (i.e., when the phase is changed, or when project 

Alternatives are moved from non-draft to draft status), previously entered consistency 
information will automatically be removed. 

 Project Website – Type the URL to the project's website, if available. More than one URL can be 
entered, if needed. 

 Federal Involvement – Click the appropriate check box to indicate the level of Federal 
Involvement (or No Federal Involvement) for the project. Descriptions for the various levels are 
provided beside each option listed on the screen. 
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Note:  Because PD&E LAP Certified agencies are reimbursed by FDOT with federal funds, 
you must select a level of Federal Involvement for LAP projects.  

 

 Purpose and Need – Make edits, if any, to the project’s Purpose and Need by typing or copying 
and pasting your changes in the text box. 

 Project Description Summary – Make edits, if any, to the Project Description Summary by 
typing or copying and pasting your changes in the text box. 

Tip!  To copy and paste text from another document, highlight the selected text and then 

click Ctrl + C on your keyboard to copy the information. Click Ctrl + V keys to paste the 
information in the text box. 

 Click the Summarize/Modify Public Comments link to open the Summarize/Modify Public 
Comments page, enabling you to add or modify public comments regarding the project.  

 Planning Consistency Status – This section provides an efficient means to enter and track 
planning consistency information that is required for NEPA approval. 

Note:  Planning consistency information is mandatory for NEPA approval. However, providing the 
information via the EST is optional.  

 

 Click the Expand this section link to display the form. 

 Enter the information in the fields and select the appropriate values from the options that 
are presented.  Only fields that have been completed and fields where either a Yes or No 
option has been selected will appear in the report.  

 

Tip!  Click the URL link http://www.dot.state.fl.us/planning/policy/metrosupport 

shown on the screen to get the latest Planning Consistency guidance or download the 
spreadsheet from FDOT’s Metropolitan and Regional Support website. 
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Note: Selecting No requires a written explanation. Type or copy and paste the explanation 
into the appropriate Comments text box. Instructions for what needs to be included in your 
explanation are displayed in light font within the Comments text boxes.  

 The Upload Attachments section will display documents that have been attached for the 
associated transportation plan.  

 Click the Pages link to open the document PDF. 

 Click the delete link to remove the attachment.  

 Click the replace link to make edits to or replace the existing document links. 

 To upload an attachment, click the Browse button and navigate to the document you 
want to upload. 

 

6. In the Designate Exempted Agencies field, indicate agencies that are excluded from reviewing the 

project. 

Note: The Federal Transit Administration (FTA) is exempted by default on all Planning Phase 
projects that do not contain a transit mode. However, if the project will contain a transit mode or if 
there is a reason the FTA needs to review the project, you can remove the FTA exemption by 
clicking the remove link.  
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 Click the Designate Exempted Agencies arrow to expand the list of agencies that qualify for the 
exemption.   

 Select the appropriate agency by clicking the agency name.  Agencies that are qualified for 
exemption are noted as follows: 

 Federal Highway Administration – The project will be a SEIR (State Environmental 
Impact Report) and there is no intent to federalize the project with the FHWA as the lead – 
mostly for projects involving Florida's Turnpike Enterprise. 

 Federal Rail Administration – The project does not involve a rail component. 

 Federal Transit Administration – The project does not involve a transit component. 

 National Park Service – The project is not near any national park assets. 

 U.S. Coast Guard – The project is not near a navigable waterway. 

 U.S. Forest Service – The project is not near any U.S. Forest Service assets. 

 

 Click Add Exemption. The Designate Exempted Agencies area expands and displays the 
Justification For Exemption section. 

 

 Under Justification For Exemption, type the reason for the agency exemption in the 
Justification text box. 

Note: The Justification text box is a required field.  

 

 Repeat the process for additional agencies. 
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Tip!  Click the remove link to cancel the operation and remove the selected agency from the 

exemption list. 

7. Click Save. 

 

The Create New Project Record page refreshes and displays the project information.   

Tip!  Use the Update Project Description function in the Tools menu or Update ETDM Project 

in the Wizards menu to update the project as it moves through the ETDM process. 

 

 Update Project Description (Updated 06/30/2015) 3.1.4.2

The Update Project Description function in the EST Tools menu allows you to make changes to a 
project’s information, where applicable.  After the Project Description has been updated and submitted, 
the updated project information becomes part of the project reports.   
 

Tip! You can also use the Update ETDM Project link on the Wizards menu to make updates to the 

Project Description.  See the EST User Handbook’s Wizards chapter for navigation guidance. 

3.1.4.2.1 Accessing the Update Project Description Page 

 

1. On the project navigation bar located at the top of the EST window, click the Active project arrow and 

then make your selection by clicking on the project name and ETDM number. 

 

Tip!  You can change the list of Active projects using the search tools on the project navigation 
bar. For more information on how to use the project navigation bar search tools (e.g., selecting 
projects using Site Search and Advanced Search functions), refer to the Navigation chapter in the 
EST User Handbook.  

2. On the Tools menu, point to Project Diary, and then click Project Description. 
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The Update Project Description page opens and displays the following sections: 

 Overview – Displays the Project Name and Planning ID 

 Environmental Review Process and Federal Eligibility – Indicates which environmental 
review process will be used (State or FHWA), funding sources (FHWA, other Federal Funding, or 
if the project is Not Federal Eligible), and type of federal permits 

 Purpose and Need – Presents the reasoning for developing the project and how the project will 
solve the initial issues 

 Description – Describes the project 

 Consistency – Provides an efficient means to enter, edit, and track project consistency 
information that is required for NEPA approval (entering information into the EST is optional) 

 Summarize/Modify Public Comments –  Displays any public comments 

 Designate Exempted Agencies – Indicates agencies that are excluded from reviewing the 
project 

 Save – Displays User Identity, items that may need to be addressed before submitting the form, 
and an indicator showing if you have permission to make changes to the project description. This 
section also displays a Save button when you are saving your changes.    

 

Tip!  Click the toolbar icon at the top of the window to: 

  Send feedback about the current page. 

  Access online Help. 
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  Bookmark the page. 

 Add the page to your My ETDM preferences. 

Depending on the project’s status, one of the following screens will display: 

 Edit Project Description  – This dialog box displays if the project is 

 in a Planning Screen or Programming Screen 

 in non-draft status (i.e., not in Editing or QA/QC)  

 being edited for the first time after a summary report has been published  

 

 Update Project Description – The page displays without a dialog box if  the project is 

 still in draft status (i.e., Editing or QA/QC)  

 being edited while a project is within its current screening status and has not had a 
summary report published  

 in the PD&E phase 
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 Permissions - If the project is in active ETAT or AN review, or if you don’t have permission to 
access the page, a message screen will appear, as shown in the next illustration. If a project is in 
active review, you will not be able to make any changes to the project information until the review 
end date has been reached.  

 

 

3.1.4.2.2 Completing the Editing Project Description Dialog Box 

The screen displays an Edit Project Description dialog box in front of the grayed out Update Project 
Description page. This form helps to identify how changes to the information will affect the project’s 
status or if information needs to repeat an approval process. Follow the prompts and select the 
appropriate responses. 
 

1. If the changes you make will be part of the current Programming Screen - Click Yes and then click the 

Continue button. The dialog box will disappear, allowing you to make edits to the project information. 

 

2. If the changes you make will not be part of the current screen – Click No and then follow the prompts that 

appear. 
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 If you are preparing for a new screening event – Click Yes and then click the appropriate link for 
one of the following: 

 For the same phase – Click the Update Status link to go back to draft status (i.e., Editing 
or QA/QC). 

 For a different phase – Click the Update Phase link to change the project phase. 

 

 If you are not preparing for a new screening event – Click No. 

 

 If you are providing updates from PD&E – Click Yes and then click the Update Phase link to 
update the project phase. 

 

 If you are making changes in the current project phase for publication in the summary report – 
Click No and then click Continue to make edits to the project information. 
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3.1.4.2.3 Overview 

This section of the Update Project Description screen displays a project’s general information (Name 
and ID) along with fields showing the following project type, status, organization, and location: 
 

 
 
Enter any updates by typing the information or making the selections in the fields provided. Fields 
involving additional steps or explanation are described in the following subsections. 
 

Note: Fields showing a red asterisk (*) indicate a required field.  

3.1.4.2.3.1 Local Agency Program (LAP) 

This section of the screen indicates if the project is being contracted by the FDOT to a local agency. The 
response in this section affects the Environmental Review Process and Federal Eligibility section of 
the form. 
 

 If a project is labeled as LAP – The project is part of the federal FHWA program and will follow the 

FHWA Environmental Review Process. LAP projects receive FHWA funding.  

 If a project is labeled as not being LAP – The project is not part of the federal FHWA program. LAP 

project funding may come from a federal agency (not FHWA) or may be considered not eligible for 

federal funds. 
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3. In the Local Agency Program (LAP) field,  do one of the following: 

 Leave Unknown as the default selection if the project's LAP status has not yet been determined.  

 Click the drop-down arrow, , and then do one of the following: 

 Click Yes if the project is being contracted out by the FDOT to a local agency. Additional 
fields appear for selecting the LAP Agency and for the Agency Completing the NEPA 
Document. (See Step 2 of these instructions for completing the steps in the LAP form.) 

 

 Click No if the project is not being contracted out to a local agency.  

 Click Anticipated (Planning Phase only) if the project is in the process of being 
contracted out to a local agency. 

4. If you selected Yes or Anticipated (Planning Phase only) for the Local Agency Program (LAP) 

options, the Update Project Description form displays fields for adding LAP information.  Do the 

following: 

 For LAP Agency, select the LAP agency responsible for the project by doing one of the 
following: 

 Click the LAP Agency arrow to expand the list, and then select an agency by clicking on 
the agency name. 

 If the LAP Agency is not listed, click the Add another agency to this list link, and then 
type the name of the agency in the text box.  

 

Tip!   If the agency is already in the EST database, you need to type only the 

first three letters of the name. The EST automatically displays a list of names 
that match your text. Click the appropriate selection from the list. 

If the agency is being added for the first time, type the agency's entire name. 
The agency will be added to the database. 
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 In the Agency Completing NEPA Document field, do one of the following: 

 Click the FDOT option button if FDOT will be completing the NEPA document. 

 Click the Local Agency (with FDOT oversight) option button if the local agency will be 
completing the NEPA document. The screen will display prompts for indicating the 
agency’s LAP certification. 

Note:  Local agencies must be PD&E LAP Certified if completing the NEPA 
document with FDOT oversight. 

 

Note:   The agency must be certified by the District LAP Administrator for the 
type of work it will be performing. After the project information has been 
submitted, the District LAP Administrator will receive an email notification 
about the project’s LAP designation and whether the need for agency 
certification has been indicated. 

 In the LAP Agency Certification field, click the appropriate option button beside one of the 
following LAP Certification statements: 

 is already PD&E LAP Certified. (The agency selected in the LAP Agency field has 
completed the Local Agency Certification Qualification Agreement and has been approved 
by the District LAP Coordinator.) 

 will need to be PD&E LAP Certified via LAP Coordinator.  (The agency selected in the 
LAP Agency field is pending approval by the District LAP Coordinator.) 

Note: The Environmental Review Process and Federal Eligibility section of the Update 
Project Description screen will automatically change to FHWA Process and FHWA 
Funding – Expected when the Yes option is selected, as shown in the next illustration. 
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3.1.4.2.3.2 Alternative Corridor Evaluation (ACE) 

Indicate whether or not this project is participating in the ACE process by either accepting the default No 
or by clicking the Alternative Corridor Evaluation (ACE) arrow and then selecting Yes.  
 

 
 
Note: If a project in the Planning phase will be going through an ACE, the Preliminary Environmental 
Discussion (PED) form must be completed. Click the Preliminary Environmental Discussion (PED) link 
to open the tool for completing the form. 

3.1.4.2.3.3 ETDM Phase 

The ETDM Phase field on the Update Project Description screen displays the project’s current phase 
and is grayed out, indicating this option is disabled. 
 
To update the project phase, click the Project Phase link. The link opens the Update Project Phase 
tool. 
 

 
 
Note: When a screening cycle is completed (i.e., when the phase is changed or when project Alternatives 
are moved from non-draft to draft status), previously entered consistency information (including Air 
Quality Conformity, MPO Goals and Objectives, Local Government Comprehensive Plan, and Coastal 
Zone Management Program) will automatically be removed from the current project data  in preparation 
for a new screening event. The previously entered information remains available in the summary report 
and milestone snapshot reports. 

3.1.4.2.3.4 AN Process 

The AN Process field options appear for projects that are in the Programming Screen. There are two 
options available for selection the way an AN package will be distributed: 

 Along with the Programming Screen notification 

 Separately from the Programming Screen (e.g., AN  review to occur after the Programming Screen) 

 
Click the AN Process arrow and click the appropriate AN Review selection. 
 

 
 
Note: The AN Process field does not appear on the screen for projects in the Planning Screen and 
appears as a grayed out field showing AN Only for projects in the Project Development phase. 

3.1.4.2.4 Environmental Review Process and Federal Eligibility 

This section of the Update Project Description page displays the current status of the project regarding 
the type of funding that is expected. The information shown in this section is dependent on the selection 
made in the LAP Project field that is displayed in the Overview section.   
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 Projects identified as LAP – The screen displays the environmental review process as FHWA, with 

funding shown as Expected. 

  

 Project is not a LAP project, or if there has not been a determination (i.e., unknown) – The screen 

displays options for the environmental process as State or FHWA, with expanded options for federal 

eligibility and funding, which will be explained further in these instructions. 
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Determine State or FHWA Environmental Review Process 

Indicate if the project will follow the State or FHWA environmental review process by clicking the 
appropriate button.  The form displays the available options for selecting the type of review, funding, and 
permit. 
 

 State Process – Click this button only if the project will not be receiving funding from FHWA at any 

point of the project development or implementation. Projects may still be funded by other non-FHWA 

agencies, but will not be required to undergo the FHWA environmental review process. 

 

 FHWA Process – Click this button if the project will be receiving funds from FHWA. Projects receiving 

funds from FHWA at any point during project development and implementation must undergo the 

FHWA environmental review process. When you select FHWA Process, a list of project types 

appears. Do the following: 

 Click the appropriate button to make your selection. 

 Type your supporting comments into the Justification to use the FHWA Process text 
box. 
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Funding 

This section automatically displays the FHWA funding selection, which is based on the type of environmental 
review process the project will undergo (State Process or FHWA Process). 

 Expected – Clicking the FHWA Process button displays this as selected. 

 

 Not Expected – Clicking the State Process button displays this as selected. 



 

 

 

 Environmental Screening Tool Handbook - February 15, 2016 3-50 

 

Other Federal Funding 

This section becomes active if the environmental review will follow either the State Process or FHWA Process, 
and further identifies if project funding will be appropriated from non-FHWA federal agencies.  

Note: Projects identified as going through the State environmental review process can be shown as receiving 
federal funding from non-FHWA agencies. These type of projects are not required to undergo the FHWA 
environmental review process even though federal funding will be used. 

 

Click on one of the following options: 

 Expected – If federal non-FHWA funds are expected to be used. 

 Not Expected – No federal funds will be used. 

 If selecting Not Expected, the Not Federal Eligible (NFE) check box becomes active. 
Click the check box to flag the project as not using any federal funds during any phase of the 
project development or implementation. Only click this check box if you have coordinated 
internally and the District management officially determines that the project should be NFE. 

Federal Permits 

This section identifies which federal permits are expected for the project, or if no federal permit will be used. 
Click the check box beside the appropriate selection. 
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3.1.4.2.5 Updating the Purpose and Need 

You can make changes to the project’s purpose and need; however, you must indicate if the changes to 
an already published purpose and need are strictly editorial (i.e., grammar, punctuation, correction/ 
clarification) or substantive (i.e., revising, adding, or deleting information). Substantive changes made 
after lead agency acceptance will require an extension of the comments period so the lead agency can 
review and accept (or not accept) the updated purpose and need.  
 

Tip! You can also use the Update ETDM Project link on the Wizards menu to make updates to the 

project description.  See the EST User Handbook’s Wizards chapter for navigation guidance. 
 

 
 
To make changes to the project’s purpose and need, do the following: 

1. Click directly on the text box to begin editing. 

2. A dialog box displays and notifies you that You are about to update the Purpose and Need. 

3. Under the Will the changes made to the Purpose and Need be substantial prompt, click one of the 

following option buttons: 

 No, they are only editorial in nature – Click this if changes are only for grammatical, 
punctuation, and spelling issues.  
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 Yes, a re-review by {name of Lead Agency} is required – Click this if information has been 
revised, deleted, or added.  

4. Type your comments supporting the reason for the changes into the Justification text box. 

5. Click OK. 

 

The screen refreshes and displays a draft version of your Justification along with a Purpose and 
Need text box, where you can enter your changes.  

 

Tip! Click Refresh on your browser’s shortcut menu to undo your response and edits. Updating 

the Project Description 

3.1.4.2.6 Updating the Project Description 

You can make updates to the project description by doing the following: 
 

1. Click on the Description text box to activate the editing tools. 
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2. Make edits as needed. 

3.1.4.2.7 Attaching Consistency Information 

You can only enter project consistency information via the EST when a project is in draft status (from Editing to 
QA/QC). To add project consistency information for non-draft projects, you can attach the Project Planning 
Consistency spreadsheet using the EST’s Attach Documents tool. A link to the tool is available for quick 
access. 
 

 
 

Tip!  Click the URL link http://www.dot.state.fl.us/planning/policy/metrosupport shown 

on the screen to get the latest Planning Consistency guidance or download the spreadsheet 
from FDOT’s Metropolitan and Regional Support website. 

3.1.4.2.8 Summarize/Modify Public Comments 

This section allows you to enter a summary of public comments, edit current comments, or edit the 
justification if no public comments are available.  
 

 
 

3.1.4.2.9 Designate Exempted Agencies 
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This section of the Update Project Description screen allows you to indicate agencies that are exempted from 
reviewing the project. 

1. In the Designate Exempted Agencies field, indicate agencies that are not required to review the 

project. 

Note: The Federal Transit Administration (FTA) is exempted by default on all Planning phase 
projects that do not contain a transit mode. However, if the project will contain a transit mode or if 
there is a reason the FTA needs to review the project, you can remove the FTA exemption by 
clicking the remove link.  

 

2. Click the Select Agency arrow to expand the list of agencies that qualify for the exemption.   

3. Select the appropriate agency by clicking the agency name.  Agencies that are qualified for exemption 

are noted as follows: 

 Federal Highway Administration – The project will be a SEIR (State Environmental Impact 
Report) and there is no intent to federalize the project with the FHWA as the lead – mostly for 
projects involving Florida's Turnpike Enterprise. 

 Federal Rail Administration – The project does not involve a rail component. 

 Federal Transit Administration – The project does not involve a transit component. 

 National Park Service – The project is not near any national park assets. 

 U.S. Coast Guard – The project is not near a navigable waterway. 

 U.S. Forest Service – The project is not near any U.S. Forest Service assets. 

4. Click Add Exemption. The Designate Exempted Agencies area expands and displays the Provide 

Justification For Exemption section. 
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5. Under Provide Justification For Exemption, type the reason for the agency exemption in the 

Justification text box. 

Note: The Justification text box is a required field.  

 

6. Repeat the process for additional agencies. 

Tip!  Click the remove link to cancel the operation and remove the selected agency from the 

exemption list. 

3.1.4.2.10 Saving and Submitting the Updated Project Description 

 
After entering changes to the project description, click Save. 

 

A message appears at the top of the page that confirms the project description has been successfully updated.  
Refresh the page to view your changes. 

3.1.4.2.11  Granting Comments After Review 

After saving the updated project description, edits made to the Purpose and Need will require the lead 
agency to review the updated information and either accept or not accept the purpose and need.  The 
Justification that was provided for the changes appears, along with the date the purpose and need was 
modified and the name of the person who made the modification.  
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1. Click the Comments After Review link. 

 

The Allow Comments After Review Period page displays. 

 

2. Under Select Reviewers to Comment After Review Period, enter the name of the person or agency in 

the Search for Reviewers field.  A list of names matching your search criteria appears. 

3. Select the name by clicking on it. 



 

 

 

 Environmental Screening Tool Handbook - February 15, 2016 3-57 

 

A Grant Extension dialog box appears and displays the reviewer’s name and organization along 
with a Justification text box. 

 

4. Type the Justification for granting the extension. 

5. In the Date fields, type the Start/End dates, or click the calendar, , and select a date. 

6. Click Save. 



 

 

 

 Environmental Screening Tool Handbook - February 15, 2016 3-58 

 

The page refreshes and displays the extension information along with an Edit button. 

 

7. To change the End Date or Justification Comments, click the Edit button and repeat Steps 3 through 6 

of these instructions. 

 

 

 FHWA Environmental Review Process Requested (In Development) 3.1.4.3

 Add/Update Alternative Description (New 06/30/2010) 3.1.4.4

Projects may have one or more Alternative corridors. By default, one Alternative is added to the project when 
the project is created.  This form allows users to add more Alternative corridors to an existing project.  
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The Add/Update Alternative Description function in the Environmental Screening Tool (EST) Tools menu 
enables the ETDM Coordinator to modify project Alternative description information. 

Updating Project Alternative Description Information: 

1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project from 
your Saved Searches or Project History lists, or you can click the Advanced Project Search link 
to select another project. See the Navigation chapter of the EST Handbook for information on using 
the Project Navigation Bar. 

2. On the Tools menu, point to Project Diary, and then click Alternative Description. 

 

The Add/Update Alternative window opens as a tabbed page, displaying a page toolbar, project 
header, and an Add/Update Alternative form. 

 

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 
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  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

Note: If fields and buttons in Add/Update Alternative section are grayed out, it means the form 

is inactive. To view the reason for an inactive Add/Update Alternative form, check the 
Permissions Message section located at the bottom of the Add/Update Description window (as 
demonstrated in the next illustration). 

  

3. Complete the form by entering the information in the fields provided. 

4. Click Submit Form. 

 Preliminary Environmental Discussion Comments (Updated 12/31/2015) 3.1.4.5

After reviewing the standardized GIS analyses, and in consideration of local knowledge, planning studies, 
FDOT internal coordination, and other similar appraisals, the FDOT District may prepare a Preliminary 
Environmental Discussion (PED) prior to a screening. The PED provides the District’s initial evaluation of a 
project’s potential effects (direct, indirect, and cumulative, as appropriate) and how the District intends to 
address or evaluate these issues as the project advances. PEDs, which may be provided at both the project 
and alternative levels, provide the Environmental Technical Advisory Team (ETAT) with context and may help 
the ETAT provide focused and actionable comments. The PED may be prepared for the project and alternative 
level at the District’s discretion. This will depend on whether the project is in the Planning Screen or 
Programming Screen, the project scope, and whether or not there are multiple alternatives. The project team 
enters the corridor alternatives into the EST, runs the standard GIS Analysis, and then develops the PED. The 
PED is mandatory for projects undergoing the Alternative Corridor Evaluation (ACE) process. For MPO/TPO 
projects, FDOT coordinates the assessment with the MPO/TPO ETDM Coordinator. The PED is optional during 
a Planning Screen for non-ACE projects and is a part of the Advance Notification (AN) during the Programming 
Screen. PEDs for a Planning Screen can be submitted per issue and alternative to highlight unique or known 
conditions. PEDs are developed based on the instructions found in the PD&E Manual, Part 1, Chapter 3, 
Preliminary Environmental Discussion and Advance Notification. 

Notes: 

♦ Projects submitted to the EST database before October 15, 2012, do not have PED comments. 
Issue names shown in the Preliminary Environmental Discussion Comments page reflect the issues 
and categories currently used on the EST.  

♦ Forms for Preliminary Environmental Discussion Comments, Edit AN Package, Review Project 
Effects, and Cumulative Effects Evaluation Considerations show only the current issue names.  

♦ Reports show the set of issues and categories that were in effect at the beginning of the most 
recent screening event of the active project, or at the time of the latest screening event preceding 
the selected project milestone.  

♦ The Project Effects and Cumulative Effects forms display any available PED comments for each 
issue and alternative as it is reviewed.  

♦ PED comments are required for all new AN Packages.  
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After PED comments have been entered in the Preliminary Environmental Discussion Comments form, the 
comments will appear in the AN package; however, PED comments do not appear in AN packages published 
on or before October 15, 2012. ETAT reviewers cannot view PED comments until a review cycle begins. 

3.1.4.5.1 Accessing the Preliminary Environmental Discussion (PED) Page 

On the Tools menu, point to Project Diary and then click Preliminary Environmental Discussion (PED). 

 

The Preliminary Environmental Discussion Comments page opens and displays a list of resource issues 
that require comments. 

 

3.1.4.5.2 Adding PED Comments 

ETDM Coordinators use the Preliminary Environmental Discussion Comments form in the EST to enter 
comments and select Degrees of Effect (DOEs) for a project or an alternative. 

Tip! If you are creating a project that will be going through the ACE process, you can access the PED 

form by clicking the link on the Project Diary>Create New Project Record tool. 
 

 

 

5. On the Preliminary Environmental Discussion Comments page, click New PED Comment.  
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6. On the PED Editor dialog box, do the following: 

 Click the issue you will be commenting on and then click Next.  

Tip! To select multiple issues, press Ctrl + click. 

 

 Select the appropriate option button for one of the following: 

 Click the option button beside Project PED if the comment applies to the overall project. 

 

 Click the option button beside Alternative PED if the comment applies to one or more 
alternatives and then click the check box beside the Alternative name. 
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 Click Next. 

 Click the Degree of Effect arrow to display the DOE options and then, if desired, click a DOE to 
indicate a potential degree of effect, if known (this step is optional). 

 

 Type your comments in the text box and then click Finish. 

3.1.4.5.3 Editing Project PED Comments 

After comments have been added, you can make changes to the DOE and comments. You can apply your 
changes to one or multiple issues. 

 

1. Click the Edit button for the selected Issue. 

 

The PED Editor dialog box opens, allowing you to make your changes. 

2. Click Finish. 
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The screen refreshes and displays your updated comment for the selected issue. 

 

3.1.4.5.4 Editing Alternative PED Comments 

After comments have been added, you can make changes to the DOE and comments. You can make changes 
to one or multiple resource issues, following the same steps for editing project-level PED comments. 

3.1.4.5.4.1 Editing PED Comments by Single Issue 

1. Under Alternative PED Comments, click the Edit button located on the row of the selected  

Alternative(s) and Issue(s). 

 

The PED Editor dialog boxes opens.  

2. Make the appropriate changes. 
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3. Click Finish. 

3.1.4.5.4.2 Making changes to PED Comments by Resource Issue 

1. Under Alternative PED Comments, select the group of issues you want to edit. 

2. Click the plus sign, , in the Issue column beside the issue name.   

 

The section expands and displays the Issue(s), Alternative(s), Effect, and Comments. 

 

3. To make an edit to a PED comment for a group of issues, click the Edit button located at the top of the 

column for the selected Issue. 

 

The PED Editor dialog box opens, allowing you to make the appropriate changes. 

4. Click Finish. 
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The screen refreshes and displays the updated entry. 

 

Note: To edit a single issue within a group, click the Edit button beside the selected issue, as 
shown in the next illustration, and then follow the steps listed for editing PED comments for single 
issues. 

 

3.1.4.5.5 Deleting PED Comments 

You can delete PED comments that have been entered for project-level issues or alternative-level issues. 
Additionally, you can delete a single issue or multiple issues.  

3.1.4.5.5.1 Deleting Project-Level PED Comments 

1. Under Project PED Comments, select the issue comments you want to remove from the list. 

2. Click the Delete button on the Issue(s) row. 

 

A Message from webpage confirmation box appears.  



 

 

 

 Environmental Screening Tool Handbook - February 15, 2016 3-67 

 

3. Click OK. The Preliminary Environmental Discussion Comments page refreshes and displays the 

page with the updated changes. 

 

3.1.4.5.5.2 Deleting Alternative-Level PED Comments by Resource Issue 

1. Under Alternative PED Comments, select the Issue you want removed from the list. 

2. Click the plus sign, ,  beside the issue name to expand the issue group. 

 

3. Click the Delete button located on the top row of the issue group to delete all rows in the expanded 

section. 

 

Note: Click the Delete button in one of the other rows in the group to delete only that row (as 
shown in the next illustration). 
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A Message from webpage confirmation box appears.  

 

4. Click OK. The Preliminary Environmental Discussion Comments page refreshes and displays the 

page with the updated changes. 

 

3.1.4.5.6 Viewing a PED Report 

1. On the EST Reports menu, point to Project Diary, and then click Preliminary Environmental 

Discussion (PED). 

 

The Preliminary Environmental Discussion Comments Report page opens, displaying the 
information entered into the Preliminary Environmental Discussion Comments form. Project-level 
PED comments, along with Alternative-level comments, are available for viewing. 
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Note: You can display the information by Project Level or by Alternative. You can choose to 
display only the information for one or multiple Alternatives.  

2. Click a checked box to remove information from a view.  Click the check boxes to mark the information 

you want to display.  

 

3. Click Update to refresh the page and display the information. 

 

The page refreshes and displays the PED issues, degrees of effect, and comments. 
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4.  Click the PDF icon, , to save or print a copy of the report. 

 

 Edit Project on Map (In Development) 3.1.4.6

The Edit Project on Map tool allows you to view and edit a project using the EST’s interactive map. 

1. On the project navigation bar located at the top of the EST window, click the Active project arrow and 

then make your selection by clicking on the project name and ETDM number. 

 

Tip!  You can change the list of Active projects using the search tools on the project navigation 
bar. For more information on how to use the project navigation bar search tools (e.g., selecting 
projects using Site Search and Advanced Search functions), refer to the Navigation chapter in the 
EST User Handbook.  

2. On the Tools menu, point to Project Diary and then click Edit Project On Map. 

 

The map displays the project’s location.  
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For details on using the interactive map, see the Maps chapter of the EST User Handbook. 

 Update Segment Description  3.1.4.7

After project features have been added to a project Alternative, the segment description can be modified by the 
ETDM Coordinator or ETDM Data Entry user using this form. 

To access the Update Segment Description form, go to the Tools menu, point to Project Diary, and then 
click Segment Description.  The Update Segment Description page opens. 

 

Some of the fields will be pre-filled if roadway segments were extracted from the State Highway System (SHS) 
base map.  Enter the information into the form.  Click Add More Sources if space for more funding sources is 
needed.  Table 3-1 describes the information needed for each of the data fields on the form.  When finished, 
click Submit Form. 
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Table 3-1 Project Segment Description 

Field Name Description Valid Values 

Segment Record 
Identifier automatically assigned to the segment by 
the computer and displayed on the map 

 

Segment ID 
Identifier assigned to the project segment by the 
planning organization 

 

Facility Name 
Name of project segment location (for example, street 
name) 

 

Beginning Location 
Boundary location marking the beginning of the 
project segment 

 

Ending Location 
Boundary location marking the end of the project 
segment 

 

Jurisdiction Entity with maintenance responsibility 
FDOT 
County 
City 

Length Length of planned project segment, in miles  

Functional Class 
Functional class of roadway.  Not applicable to 
projects where mode is not roadway. 

RURAL: Principal Arterial – 
Interstate 

RURAL: Principal Arterial - 
Other 

RURAL: Minor Arterial 

RURAL: Major Collector 
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Field Name Description Valid Values 

RURAL: Minor Collector 

RURAL: Local 

URBAN: Principal Arterial - 
Interstate 

URBAN: Principal Arterial - 
Other Freeways and   
Expressways 

URBAN: Principal Arterial - 
Other 

URBAN: Minor Arterial 

URBAN: Collector 

URBAN: Local 

N/A 

Transportation 
Concurrency 
Exception Area 

Indicates whether or not the project segment is in a 
Transportation Concurrency Exception Area, if one 
exists within the county 

In 

Out 

BASE CONDITION 

Year 4-digit year of the existing roadway conditions   

AADT Existing traffic volume  

No. Lanes Total number of existing lanes on road  

Configuration Existing lane configuration 

Lanes Freeway 

Lanes Divided 

Lanes Undivided 

Lanes One-way 

NEEDS ASSESSMENT 

Needs AADT Traffic volume in Needs Assessment  

Needs No. Lanes Number of lanes in Needs Assessment  

Needs Configuration Lane configuration in Needs Assessment 

Lanes Freeway 

Lanes Divided 

Lanes Undivided 

Lanes One-way 

COST-FEASIBLE 

Plan Year 
4-digit year of Cost Feasible horizon year. (For 
example, if the project is proposed for the 2025 LRTP, 
then the plan year would be 2025.) 

 

Plan AADT Traffic volume for Cost Feasible horizon year  

Plan No. Lanes Number of lanes for Cost Feasible horizon year  
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Field Name Description Valid Values 

Plan Configuration Lane configuration for Cost Feasible horizon year 

Freeway 

Divided 

Undivided 

One-way 

Transit 

INTERIM PLAN 

Interim Year 4-digit year for Interim Plan  

Interim AADT Planned traffic volume for Interim Plan  

Interim No. Lanes Planned number of lanes for Interim Plan  

Interim Configuration Planned lane configuration for Interim Plan 

Lanes Freeway 

Lanes Divided 

Lanes Undivided 

Lanes One-way 

FUNDING 

Source Source of funding Funding Source 

Amount 
Estimated segment cost in US dollars (Includes 
Project Development, Design, Right-of-Way 
Acquisition, Construction, and CEI.) 

Funding Amount 

 

 Update Project Phase (Updated 10/30/2014) 3.1.4.8

This tool allows the ETDM Coordinator, Project Manager, or a member of the Coordinator Management Team 
to move a project to another phase.  Moving a project to another phase can affect related reports that have 
been edited but unpublished; therefore, it is important that you check for edits or outstanding actions that need 
to be addressed before moving a project forward to another phase. Some of the actions allowed in this feature 
include: 

 Setting the AN process review and comments schedule (Programming phase) 

 Selecting additional alternatives to be eliminated (Project Development phase) 

3.1.4.8.1 Accessing the Update Project Phase Page 

 

1. On the project navigation bar located at the top of the EST window, click the Active project arrow and 

then make your selection by clicking on the project name and ETDM number. 

 

Tip!  You can change the list of Active projects using the search tools on the project navigation 
bar. For more information on how to use the project navigation bar search tools (e.g., selecting 
projects using Site Search and Advanced Search functions), refer to the Navigation chapter in the 
EST User Handbook.  
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2. On the Tools menu, point to Project Diary, and then click Project Phase (Planning, etc.). 

 

The Update Project Phase page opens and displays the project’s current phase, which will fall into 
one of the following categories: 

 Planning Phase 

 Programming Phase 

 Project Development Phase (PD&E) 

 
Note: A grayed out option indicates an action cannot be completed (e.g., trying to move a project 
from the Planning Phase to the Project Development Phase). Pointing the mouse over the grayed 
out button displays a tip about why the option is not available. If you need further assistance, 
contact the ETDM Help Desk (help@fla-etat.org  or (850) 414-5334). 

 

Tip!  Click the toolbar icon in the Update Project Status window to: 

  Send feedback about the current page. 

  Access online Help. 

mailto:help@fla-etat.org
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  Bookmark the page. 

 Add the page to your My ETDM preferences. 

3.1.4.8.2 Updating a Project to the Programming Phase 

When a project is moved to the Programming phase, you must also choose when the Advance 
Notification (AN) review process will be conducted.   
 

3. Click the option button beside Programming Phase. 

Tip! For additional guidance, hover the mouse over the Project Phase selection. A screen note 

will appear. 

 

4. To indicate when the AN review will be conducted, do the following: 

 Under Update AN Process, click the relevant option for selecting when the AN review will be 
conducted. 

 The AN review will be conducted when the Programming Screen notification is sent. 

 The AN review will be conducted separately from the Programming Screen (i.e., the AN 
package will be sent after the Programming Screen). 

 Click the Update AN Process button. 

 

5. Click Update Phase. 

 

3.1.4.8.3 Updating a Project to the Project Development (PD&E) Phase 

Updating a project to the Project Development phase allows you to indicate additional alternatives for 
elimination.  Alternatives that are not selected for elimination will be moved into the Work Program.  (This 
does not include alternatives that are in Dispute Resolution in Progress.) 
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Note:  Eliminating an alternative will trigger an automatic re-publishing of the Summary Report and/or 
Eliminated Alternatives report.  However, an unpublished Summary Report or Eliminated Alternatives 
Report may block the project phase from being updated or block the project from undergoing a new 
screening event. Click the Project Milestone Needs Report link that is located under the Update Phase 
button to check for actions that need to be addressed before publishing/re-publishing reports.  
 

1. Click the option button beside Programming Phase. 

2. To eliminate alternatives, do the following: 

 Click the relevant check box beside the Alternative that is to be eliminated. 

 In the Justification text box, type the reasons for eliminating each selected alternative. 

Note: You must provide ample details for how you came to your conclusion (e.g., people and 
factors that led you to your decision). 

3. Click Update Phase. 

 

 

 

 Update Project Status (Updated 05/30/2015) 3.1.4.9

This tool allows the ETDM Coordinator, Project Manager, or a member of the Coordinator Management Team 
to monitor the status of project alternatives as they move through the ETDM process. Generally, the EST 
automatically displays the status indicator (green check mark) as a project progresses; however, users with the 
roles listed here can use the Update Project Status tool to make changes at certain points (e.g., changing an 
alternative’s status to Eliminated, reactivating an eliminated alternative, and setting the status to Dispute 
Resolution in Progress). The information provided in this section gives more guidance about using the form. 

Note:  Changes in the ETDM phase affect the entire project.  Before addressing the status of a project 
alternative, be sure the project is in the correct project phase. To view or update a project’s phase, go to the 
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EST main menu, under Tools, click Project Diary, and then click the Update Project Phase link. See the 
Update Project Phase section of the EST Handbook for further instructions.   

The following information presents the navigation steps for opening the Update Project Status page and 
describes the status points that appear on the screen. 

3.1.4.9.1 Accessing the Update Project Status Page 

 

1. On the project navigation bar located at the top of the EST window, click the Active project arrow and 

then make your selection by clicking on the project name and ETDM number. 

 

Tip!  You can change the list of Active projects using the search tools on the project navigation 
bar. For more information on how to use the project navigation bar search tools (e.g., selecting 
projects using Site Search and Advanced Search functions), refer to the Navigation chapter in the 
EST User Handbook.  

2. On the Tools menu, point to Project Diary, and then click Project Status (Editing, etc.). 

 

The Update Project Status page opens and displays a project status grid showing the list of 
project alternatives and columns labeled according to the sequential steps of a project review 
process. 

 

The status grid displays are dependent on which phase/screen the project is in (Planning Screen, 
Programming Screen, or Project Development), and if the project is an Alternative Corridor 
Evaluation (ACE) project. Examples of the status grid screens for the respective project types are 
shown in the Update Project Status Grids section of these instructions. 

Tip!  Click the toolbar icon in the Update Project Status window to: 
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  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

3.1.4.9.2 Update Project Status Grid 

 
This section provides illustrations for the types of status grids that are displayed.  The Update Project 
Status page displays the status grids based on one of the following project types: 
 

 Planning Screen – Projects reviewed during the Planning phase 

 Programming Screen – Projects reviewed during the Programming phase 

 Project Development – Projects reviewed during the Project Development phase  

 ACE – Projects undergoing an ACE review, which result in the creation of an ACE report (ACER) 

 AN Process – Projects may have AN Review concurrent with Programming Screen review, after 
Programming Screen review, or during PD&E. 

The following information provides an overview of the status grids for the project types listed above.  
 
Planning Screen 
 
The status grid for a project moving through a Planning Screen displays the following columns: 
 

 Editing 

 Ready for GIS Analysis 

 GIS Analysis Complete 

 SIS Consistency Review (SIS projects only) 

 ETDM QA/QC 

 ETAT Review 

 ETAT Review Complete 

 Eliminated 
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Programming Screen 
 
The status grid for a project moving through a Programming Screen displays the following columns: 
 

 Editing 

 Ready for GIS Analysis 

 GIS Analysis Complete 

 FHWA Process Approval 

 SIS Consistency Review 

 ETDM QA/QC 

 ETAT Review 

 ETAT Review Complete 

 AN Review (only for AN after Programming Screen) 

 AN Review Complete (only for AN after Programming Screen) 

 Dispute Resolution In Progress 

 Eliminated 
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Project Development 
 
The status grid for a project moving through the Project Development phase displays the following 
columns: 

 Editing 

 Ready for GIS Analysis 

 GIS Analysis Complete 

 ETDM QA/QC 

 AN Review 

 AN Review Complete 

 Location and Design Concept Acceptance 

 Work Program 

 Eliminated 
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ACE Project 
 
The status screen for an ACE project displays additional columns to track ACE Methodology 
Memorandum (MM) and ACER reviews (in progress and completed).  Columns for tracking ACE project 
alternatives are listed as follows: 
 

 ACE MM Review 

 ACE MM Review Complete 

 ACER Review 

 ACER Review Complete 
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Tip!  See the EST Handbook for more information on the navigation steps for using the Manage ACE 
Review Events feature.  For more information about the ACE process, see the ETDM Manual at 
http://www.dot.state.fl.us/emo/pubs/etdm/etdmmanual.shtm.  
 
 
Eliminated Alternative 
 
Alternatives that have been deemed “non-viable” can be manually moved to the Eliminated column. You 
can also reactivate an alternative that has been eliminated.  
 
Tip!  See the EST Handbook for more information on the navigation steps for using the Update 
Alternative Elimination feature. For more information about the alternative elimination process, see the 
ETDM Manual at http://www.dot.state.fl.us/emo/pubs/etdm/etdmmanual.shtm.  
 
 

http://www.dot.state.fl.us/emo/pubs/etdm/etdmmanual.shtm
http://www.dot.state.fl.us/emo/pubs/etdm/etdmmanual.shtm
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3.1.4.9.3 Updating a Project Status 

 
You can use this tool to manually set the status of one, multiple, or all alternatives.  To change a project 
alternative status, do the following: 
 

1. On the row of the alternative you are setting, click the option button under the appropriate column 

heading. 

Note:  Some of the status columns are actions that are only set by the application (such as ETAT 
Review Complete).  Buttons that are grayed out indicate the option is not available for manual 
action.   Pointing the mouse over the grayed out button displays a tip about why the option is not 
available. For example, the status of an alternative cannot be changed to Ready for GIS Analysis 
until the alternative’s geometry has been digitized. If you need assistance regarding a status that is 
showing as unavailable (i.e., grayed out button), contact the ETDM Help Desk at help@fla-etat.org  
or (850) 414-5334. 

mailto:help@fla-etat.org
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Tip!  To make a change for the entire project, click the All button at the top of the column. 

2. Click the Update Status(es) button. 

 

Tip!  Click the Reset Form button to reset the form to the previous status.  

 

 



 

 

 

 Environmental Screening Tool Handbook - February 15, 2016 3-86 

3.1.4.9.4 Description of Status Columns 

 Editing: Allows the geometry of the alternative to be digitized and attributes edited. This is the default 

setting when a project is first created. 

 Ready for GIS Analysis: Adds the alternative to the queue for the GIS analysis program to run. Used 

after the features have been added or modified.  

 GIS Analysis Complete: Set by the application after the GIS analysis routine is complete. 

 FHWA Approval Process: Set by the District staff to request the FDOT State Environmental 

Management Office for approval of the project’s eligibility to follow the FHWA Environmental Review 

Process. 

 SIS Consistency Review: Used by District staff to inform the SIS Central Office that a SIS project is 

ready for a consistency review of the project description and representation in the EST. 

 ETDM QA/QC: Used to indicate that a project is ready for final review prior to releasing to the ETAT for 

review.  

Note: A clear representation of a project’s extent and location is essential for an accurate 
ETAT review and commentary. Refer to the GIS Quality Review Checklist in the next section 
to verify the accuracy of the features that have been defined in the EST.   

 ETAT Review: Used by the ETDM Coordinator to initiate a review of the project by the ETAT. Locks the 

record for editing until the review cycle is complete. When a project is in "ETAT Review," its status 

cannot be changed until the 45-day review period is over. Once the 45-day review period has ended, 

the status will automatically be changed to "ETAT Review Complete." This will unlock the project and 

allow the ETDM Coordinator to once again set the status, for example to ACE MM Review.  

 ETAT Review Complete: Automatically set by the application at the end of the review period. 

 ACE MM Review: Automatically set by the application at the beginning of an ACE Methodology 

Memorandum (MM) review period.  The ETDM District Coordinator initiates the ACE MM review 

through the Manage ACE Review Events tool. The start of the review event is triggered by an email 

that is sent to ETAT members.  The ETAT members normally have 30 days to indicate within the EST 

their understanding of and to comment on the MM. 

 ACE MM Review Complete: Automatically set by the application at the end of the ACE MM review 

period.  

 ACER Review: Automatically set by the application at the beginning of the ACE report (ACER) review 

period.  

 ACER Review Complete: Automatically set by the application at the end of the ACER review period. 

 AN Review: Automatically set by the application at the beginning of the Advance Notification review 

period when it occurs separately from the Programming Screen review.  

 AN Review Complete: Automatically set by the application at the end of the AN review period. 

 Dispute Resolution in Progress: Set by the ETDM Coordinator to flag projects that are undergoing the 

dispute resolution process. 



 

 

 

 Environmental Screening Tool Handbook - February 15, 2016 3-87 

 LDCA (Location and Design Concept Acceptance): Set by the ETDM Coordinator during the Project 

Development phase after acceptance of the Location and Design Concept by the Lead Federal 

Agency. 

 Work Program:  Automatically set by the application when the project is moved to the Project 

Development phase, if the alternative is not currently in Dispute Resolution in Progress. 

 Eliminated: Set by the ETDM Coordinator at any time in the process for non-ACE projects if an 

alternative is determined to be non-viable or should be eliminated from further consideration.  

Justification is required for changing the status of an alternative to Eliminated. Elimination of ACE 

project alternatives requires approval from the Lead Federal Agency. 

3.1.4.9.5 GIS Data Quality Review Checklist (ETDM QA/QC Review) 

A clear representation of a project’s extent and location is essential for accurate reviews and commentary by the 
ETAT and the public. After digitizing features in the EST, or submitting them to be loaded into the GIS database, 
use the following list to help identify and correct errors: 

 Verify that the number of mapped alternatives is equal to the number of alternatives described in the 
Project Description Report.  

 If the GIS features were loaded into the EST from another source, compare the version in the EST with the 
source to verify that all features loaded correctly. 

 Confirm that mapped alternative endpoints are consistent with the From and To locations described in the 
Project Description Report. 

 Check the relationships among the map features representing your project (also known as “topology”): 

o Lines – alternative segments are adjoined at their respective endpoints unless otherwise intended, and 
there are no duplicate lines representing the same feature 

o Polygons – coincident borders of areas should not overlap, nor should there be gaps between the 
areas unless otherwise intended 

o Points – only one point represents the feature unless otherwise intended 

 Compare the locations of project features to other features represented on the map:  

o Zoom to a scale of 1:5000 or less at the endpoint of an alternative. This scale allows you to use the 
most detailed aerials available in the EST – 1-foot resolution Digital Orthophoto Imagery (DOI). 

o Turn on map layers  that will help confirm locational accuracy, such as the following: 

 DOI aerials  

 Navteq Roads, railroads, or other layers containing useful information for confirming feature 
locations 

 Layers showing resources you plan to avoid (schools, hospitals, parks, etc.) 

o Using the Pan tool, move along each project feature, looking to see if it is in the right place relative to 
other features on the map and consistent with the project description you provided. If the project is 
intended to avoid a sensitive resource in the area, confirm that the project does not intersect the 
resource. For example: 

 If an alternative is intended to be within an existing road right-of-way, confirm that it is in fact within 
a few feet of a road. 
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 If an alternative is intended to avoid a particular park, turn on a layer like Florida Natural Areas 
Inventory’s (FNAI’s) Florida Managed Areas to confirm that the alternative does not intersect the 
park boundary. 

 Compare the value of the length field for a project alternative against the total length value entered in the 
Add/Update Alternative Description form. 

 

 Attach Documents (Updated 07/30/2015) 3.1.4.10

The Attach Documents function in the Environmental Screening Tool (EST) Tools menu allows you to attach 
documents to one or multiple projects within your jurisdiction.  

3.1.4.10.1 Accessing the Attach Documents Form 

1. On the project navigation bar located at the top of the EST window, click the Active project arrow and 

then make your selection by clicking on the project name and ETDM number. 

 

Tip!  You can change the list of Active projects using the search tools on the project navigation 
bar. For more information on how to use the project navigation bar search tools (e.g., selecting 
projects using Site Search and Advanced Search functions), refer to the Navigation chapter in the 
EST User Handbook.  

2. On the Tools menu, point to Project Diary, and then click Attach Documents. 

 

The Attach Documents screen displays. 
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Tip!  Click the toolbar icon at the top of the screen to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

3.1.4.10.2 Selecting Projects 

You can attach documents to the selected project record, or you can add the attachment to multiple records.  
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1. Under Step 1. Select Project(s) do one of the following: 

 To attach documents only to the selected project – Leave the Project option button shown as 
selected and go to the Select Documents section of the screen, which is described later in these 
instructions. 

 To attach documents to multiple projects – Click the Multiple projects button and go to the next 
step of these instructions. 

Tip!  Click the change this link (for the single project option) or change this list link (for multiple 

projects) to select another project from your Current Selection list or choose another project with 
the Project Selection Wizard. 

2. After clicking the Multiple projects button, the section expands and displays a Projects list. 

 

Tip!  Click the project’s ETDM# link to open the project description. 

3. Do one of the following: 

 To select all projects on the list – Click the All check box. 

 To select one or multiple projects – Click the check box shown on the project Name row. 

4. After making your selection(s), go to the Select Documents section of the screen to continue entering 

information. 
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3.1.4.10.3 Selecting Document(s) 

The Step 2. Select Document(s) section allows you to perform the following actions: 

 Upload and attach documents that have not already been added to a project’s document list. 

 Search for project documents that are listed in the database and attach them to a selected project. 

3.1.4.10.4 Uploading and Attaching Documents 

1. Click the Upload a document button. 

 

The section expands and displays a form for describing the document.   

 

2. Under Describe New Document, enter the information into the fields provided. 

Note: Required fields are indicated by red asterisks (*). 

3. Click the Browse button to locate the document PDF file. 

4. Under Step 3. Save, click the Save button. 
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The Attach Documents window refreshes, displaying a message confirming the selected 
document(s) has been attached.   

 

5. Do one of the following: 

 To attach additional documents, click the Attach more documents link.  The Attach 
Documents window refreshes and displays the project and document selection forms.  

 To close the Attach Documents window, click the Close button. 

3.1.4.10.5 Searching for and Attaching Documents 

1. Click the Search for a document button. 

 

The section expands, displaying a search filter. 

2. Under Search Criteria, you can look for a document by doing any of the following: 

 Publication Date Range – Type the date range in the date fields. Use the mm/dd/yyyy format 

for typing dates, or click the calendar icon, , to select the date range. 

 Keyword(s) – Type all or part of the document name, or you can enter the project number. You 
can also use a word related to the document or project. 
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Note:  The Publication Date Range or Keyword(s) field must be entered to complete the 

search process.   

3. Click Search. 

 

The section expands and displays a Search Results table listing the document(s) matching your 
search criteria.  

Note: Search results may include published documents from any region and un-published 
documents from your assigned regions. 

4. Under Search Results, select the document(s) by doing one of the following: 

 Click the check box on the document row for each document you want to attach. 

 Click the check box beside All to select all the documents in the Search Results list. 

Tip!  Click the document link in the Document column to open the document.  Click the 

number link in the ETDM# column to open the Project Description window. 
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5. Click Save. 

 

The Attach Documents window refreshes, displaying a message confirming the selected 
document(s) has been attached.   

 

6. Do one of the following: 

 To attach additional documents, click the Attach more documents link.  The Attach 
Documents window refreshes and displays the project and document selection forms.  

 To close the Attach Documents window, click the Close button. 
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 Assign Project Managers (Updated 06/30/2015) 3.1.4.11

The Assign Project Managers form allows the ETDM Coordinator, Project Manager, ETDM Management 
Team user, or ETDM Data Entry user to assign a project manager to a specific project. A project may have 
more than one project manager. 

 

1. On the project navigation bar located at the top of the EST window, click the Active project arrow and 

then make your selection by clicking on the project name and ETDM number. 

 

Tip!  You can change the list of Active projects using the search tools on the project navigation 
bar. For more information on how to use the project navigation bar search tools (e.g., selecting 
projects using Site Search and Advanced Search functions), refer to the Navigation chapter in the 
EST User Handbook.  

2. On the Tools menu, point to Project Diary, and then click Project Manager Information. 

 

The Assign Project Managers screen displays. 

Tip!  Click the toolbar icon at the top of the screen to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

3. Click the Eligible Project Manager List arrow to expand the list of names that can be assigned as a 

project manager for the selected project. 
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4. Select a name by clicking on it. 

Note: If a name is not displayed on the list, contact the ETDM Help Desk. 

5. Click Add. 

 

The name appears under the Current Project Managers section. 

. 

Tip! Click the X beside a name to remove it from the list. 

 

 Agency Roles in PD&E (New 10/30/2012) 3.1.4.12

During the Programming Screen, agencies may be designated to serve as participating or cooperating agencies 
during the preparation of the federal environmental document in the Project Development & Environment 
(PD&E) phase. For federal projects, these roles and those of the Lead Agency must be designated prior to the 
Class of Action (COA) Determination.  

The Participating and Cooperating Agencies process goes as follows: 

1. After a project’s Lead Agency has been determined, FDOT ETDM Coordinators may send the Lead 

Agency recommendations to invite selected ETAT members to take part in a NEPA project in 

participating or cooperating agency roles.    

2. Alternatively, an ETAT agency may also initiate the request to serve as a Participating or Cooperating 

Agency while submitting their Purpose and Need (P&N) review. A copy of the ETAT agency’s request 

goes to FDOT who recommends, does not recommend, or modifies their request and submits it to the 

Lead Agency with all other requests.  

mailto:help@fla-etat.org
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3. FDOT recommends Participating and Cooperating Agencies to the Lead Agency prior to submitting a 

COA proposal. This includes requests the Lead Agency or FDOT receive from ETAT members to 

serve in one of these capacities during the review period. 

4. As appropriate, the Lead Agency accepts or declines the requests received from the ETAT agencies. 

5. The Lead Agency may also invite other agencies at their discretion to serve in these roles.  

6. ETAT agencies have 30 days to respond to Lead Agency invitations. 

 
Note: Refer to the ETDM Manual and Project Development & Environment (PD&E) Manual for details on 
the Participating & Cooperating Agency process. 
 
The roles, associated EST pages, and available tasks are as follows: 
 
ETDM Coordinators: 

 Agency Roles in PD&E 

 Identify a Lead Agency  

 Recommend agencies and participants 

 Changing or removing an agency recommendation 

 Respond to ETAT member requests 

 Send recommendations to a Lead Agency  

 Class of Action Determination 

 Define the Class of Action and send to the Lead Agency 

Lead Agencies: 

 Manage Participating/Cooperating Invitations 

 Send invitations 

 Review invitation responses 

 Withdraw invitations 

 Review Class of Action Determination 

ETAT Agencies: 

 Review Purpose and Need  

 Request to be a Participating or Cooperating Agency 

 Participation/Cooperating Agency Invitation 

 Respond to an invitation  

3.1.4.12.1 Identifying a Lead Agency 

ETDM Coordinators use the Agency Roles in PD&E tool to select a Lead Agency. 
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1. Select a project from the Active Project list. 

2. In the Tools menu, click Project Diary, and then click Agency Roles in PD&E. 

 

 
Tip!   Click the toolbar icon on the window to: 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

3. On the Lead Agency tab, under Lead Agencies, click the check box beside the agency name you 

would like to designate as the Lead Agency.  

4. Under Sign and Submit, type your Password, and then click Submit Form. 
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3.1.4.12.2 Recommending Agencies and Participants 

ETDM Coordinators use the Agency Roles in PD&E tool to make—or not make—recommendations. 
Recommendations can be made before and during a project review.   

1. Select a project from the Active Project list. 

2. In the Tools menu, click Project Diary, and then click Agency Roles in PD&E. 

 

 

3. Click the Participating and Cooperating Agencies tab. 

 

Notes: The Participating and Cooperating Agencies tab is disabled when one of the following  
occurs:  

 A Lead Agency has not been selected. 

 There is more than one Lead Agency. 

 The project is in the Planning Screen. 

 There is no federal involvement. 

4. Under Recommend an Agency, click the arrow to expand the list of agency names, and then select the 

agency. 
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5. Click Add.  The Edit/Remove Recommendation dialog box opens. 

6. In the Edit/Remove Recommendation dialog box, do the following: 

 Choose Participating Agency or Cooperating Agency and then type your rationale for 
recommending the agency in the text box. 

 Click OK. 

 

The recommended agency appears under the appropriate agency heading. 
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3.1.4.12.3 Changing or Removing an Agency Recommendation 

To change or remove an agency recommendation, do the following: 

1. In the Agency Roles in PD&E page, click the Participating and Cooperating Agencies tab. 

 

2. Under the Participating Agencies or Cooperating Agencies subhead, click the Change button located 

on the agency row.  

 

 In the Edit/Remove Recommendation dialog box, do the following: 

 To change an agency status, click the option button beside Participating or Cooperating, 
type your reason for the change in the text box, and then click OK. 

 To remove an agency from the recommended agency list, click the Remove 
recommendation option button, type your reason for removing the agency in the text box, 
and then click OK. 
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3.1.4.12.4 Responding to an ETAT Member’s Request to act as a Participating or Cooperating 
Agency 

ETAT members may send requests to be a Participating or Cooperating Agency. The ETDM Coordinator 
responds to the agency’s request using the Agency Roles in PD&E during the ETAT Review Screening event. 

1. In the Active Project list, select the project that appears in the ETAT member’s request email.  

2. In the Tools menu, click Project Diary, and then click Agency Roles in PD&E. 

 

3. Click the Participating and Cooperating Agencies tab. 

 

 

4. In the Action column, click the Respond button for the associated request. 
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5. In the Respond to Agency Request dialog box, do one of the following: 

 To not recommend an ETAT member’s request to the Lead Agency, click the Do not 
recommend this agency option button, type your reason for not recommending the ETAT 
member, and then click OK. 

 To accept the ETAT member’s request and recommend the member to the Lead Agency, click 
the option button beside either Participating or Cooperating Agency, type your reason for 
recommending the member in the text box, and then click OK.  
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Notes: 

 To change or remove an ETAT member’s recommendation, do the following: 

 In the Participating and Cooperating Agencies screen, click the Change button.  

 

 In the Respond to Agency Request dialog box, do one of the following: 

 To change a member recommendation, click the option button beside Participating or 
Cooperating, type your reason for the change in the text box, and then click OK. 

 To remove a member’s recommendation, click the Do not recommend this agency 
option button, type your reason for not recommending the ETAT member, and then 
click OK.   
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3.1.4.12.5 Sending Recommendations to a Lead Agency 

The ETDM Coordinator uses the Agency Roles in PD&E tool to send Participating and Cooperating Agency 
recommendations to the Lead Agency after the review period is complete.  

1. Select a project from the Active Project list. 

2. In the Tools menu, click Project Diary, and then click Agency Roles in PD&E. 

 

3. Click the Participating and Cooperating Agencies tab. 
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4. After providing a recommendation for each ETAT member, including member requests, click Send 

Recommendations. 

Note: The Send Recommendations button only becomes enabled after each recommendation 

has a response. 

 

 

5. In the Confirm Send box, click Send Recommendations. 

 

An email is sent to the Lead Agency, notifying them that they have Participating and Cooperating 
Agency recommendations to review. 
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 Note: If there are no agencies to recommend, click the Recommend Agencies button, and do the 
following: 

 In the Confirm Send dialog box type a confirmation statement noting that there are no 
recommended Participating or Cooperating Agencies. The Send Recommendations button 
becomes active after you start typing in the text box. 

 

 Click Send Recommendations. An email notification is sent to the Lead Agency, informing them 
there are no agency recommendations.  

After receiving an email notification stating that all invitations have received responses or 
expired, the ETDM Coordinator defines, signs, and submits the Class of Action (COA) to the 
Lead Agency for approval.  

Tip! See the Define Class of Action section of this handbook for navigation instructions. 

 

 Update Project Recommendations/Responses 3.1.4.13

This tool allows the ETDM Coordinator, Project Manager, ETDM Management Team user, or ETDM Data Entry 
user to add or modify commitments and/or responses made to the ETAT or public regarding the project.  To 
update commitments and/or responses for a project, select a project from the Project Navigation Bar, and 
then go to the Tools menu, point to Project Diary, and click Recommendations and Responses.   
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The Update Project Recommendations/Responses page opens and displays a General Project 
Commitments section that shows any previously entered commitment descriptions.  Add additional 
commitments in the Add Project Commitment text box. Type or copy and paste text into the box, and then 
click Add Commitment. 

 

 

 

 Identify Required Permits (Updated 11/30/2011) 3.1.4.14

The Identify Required Permits function in the Environmental Screening Tool (EST) Tools menu enables 
ETDM District Coordinators and Project Managers to identify permits required for a project and add information 
about specific permit conditions.  

Identifying Required Permits: 

1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project from 
your Saved Searches or Project History lists, or you can choose another project using Advanced 
Project Search. See the Navigation chapter of the EST Handbook for information on using the 
Project Navigation Bar. 

2. Go to the Tools menu, point to Project Diary, and then click Permits. 
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The Identify Required Permits page opens, displaying a form that enables you to select permits 
required for a project.  

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

3. Click the plus sign, , beside Permits to expand the list. 
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Tip!  Bold categories indicate categories of permits that have been previously identified for the 

project. 

4. Do one of the following: 

 Click the plus sign, , icon to expand an existing permit category.  Go to Step 5. 

 

 

 If a permit category is not listed, scroll to the Add new category field at the bottom of the Identify 
Required Permits page, and then do the following: 

 Type the category name. 

 Click add. 

 

 In the Add new permit to "New" category field, type the name of the permit and click add. 

 Repeat the above step for each permit associated with the new permit category. 

 

 

5. Select the permit(s) required for the project by clicking the check box beside the permit name. 
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Tip! If a permit is not listed, click the Add new permit check box.   

The EST automatically bolds the permit name and a Conditions text box appears below the 
selected permit, enabling you to add a condition required for the permit. 

 

 

6. To make changes in a Conditions text box, click the Edit link. The text box becomes active, allowing 

you to add text or edit existing text. 

 

 

7. Click Save Required Permits. 

 Identify Required Technical Studies 3.1.4.15

This tool allows ETDM Coordinators or Project Managers to identify technical studies required for a project.  To 
identify required technical studies for a project, do the following: 

1. Select a project from the Project Navigation Bar. 
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Note: You can use the default project that appears in the Active project box, select a project from 
your Saved Searches or Project History lists, or you can choose another project using Advanced 
Project Search. See the Navigation chapter of the EST Handbook for information on using the 
Project Navigation Bar. 

2. Go to the Tools menu, point to Project Diary, and then click Technical Studies. 

 

3. Select the required technical studies from the list by clicking on the name of the technical study.  A 

checkmark will appear next to the technical study, and the name will be bolded.  A text box also opens, 

where details about the required technical study can be added.  

 Propose Class of Action (formerly Class of Action Determination)(Updated 02/18/2015) 3.1.4.16

The Propose Class of Action form allows the ETDM Coordinator or Project Manager to add a recommended 
Class of Action Determination after the completion of the Programming Screen and notifies the federal Lead 
Agency Environmental Technical Advisory Team (ETAT) representative that the Class of Action is ready for 
review. 

1. Open the Propose Class of Action page in the EST using one of the following actions: 

 Click the link provided in the email notification. 
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 In the Tools menu, go to Project Diary, and then click Propose Class of Action. 

 

 

The Propose Class of Action Determination page opens, displaying the Define the Class 
of Action form. 

 

2. Under Define the Class of Action, click the Class of Action button to make your selection and, if 

required, select Other Actions by clicking the appropriate check box(es) . 

Tip! To change a Lead Agency, click the Change Lead Agency link.   

3. Click Save Class of Action. 
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The Review Class of Action page opens, displaying the selected COA. 

4. In the Review Class of Action page, click the Accepted or Not Accepted option button. If you select 

Not Accepted, you must type your reason for not accepting the COA in the Comments text box. 

5. Under Sign and Submit, type your Password, and then click Submit. 

 

 

6. A Signature Submission Notice appears. Verify your comments and acceptance are correct and then 

click OK. 
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 Notes: 

 After submitting the COA determination, the Lead Agency receives an email notification stating 
the COA is ready for their review. 

 The COA can be modified as needed. All modifications after the Lead Agency signature require 
concurrence from the Lead Agency, and the signatures on the previous determination are 
erased. 

 

 Project Schedule Tool (New 07/31/2009) 3.1.4.17

The Project Schedule Tool function in the Environmental Screening Tool (EST) Tools menu enables ETDM 
Coordinators and Project Managers to update events related to Project Development & Environment (PD&E) 
milestones and view previously recorded events for projects with assigned Class of Actions (COAs). 

Updating a Project Schedule: 

1. To update a project schedule, you must first select a project that has been assigned a COA. You can use 

the default project that appears in the Active project field in the Project Navigation Bar or you can click 

the Advanced Project Search link to select another project. 

Tip!  To search for projects with all or specific COAs, click the Advanced Project Search link in 

the Project Navigation Bar.  In the ETDM Filter field, select Class of Action, and then select a 
variable from the Class of Action Type field.   
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Note:  See the Navigation chapter of the EST Handbook for information on using the Project 
Navigation Bar. 

 

2. On the Tools menu, point to Project Diary, and then click Project Schedule. 

 

The Project Schedule Tool window opens as a tabbed page and displays a project header, page 
toolbar, and a Class of Action. 
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Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 
The Class of Action: Type section is composed of the following columns: 

 Event  

 Scheduled Date 

 Actual Date 

 Related Document 

The EST displays pre-populated dates in the Actual Date column for the following events listed in 
the Event column: 

 Planning Screen Notification 

 Planning Screen Summary Report Published 

 Advance Notification 

 Programming Screen Summary Report 

 Class of Action Determination 

Note: These dates are automatically recorded when the events occur in the EST and cannot be 
edited in the Class of Action: Type section. 
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Tip! To view a brief description of an event, place your mouse pointer on an underscored event 

listed in the Event column, as shown in the next illustration. A callout box appears with the event 
description. 

 

 

3. To view the report details of an event, click the corresponding View Live Report button in the Related 

Document column. 

 

The Summary Report screen opens for the selected document. 

The remaining events listed in the Event column in the Class of Action: Type section can be 
updated. The events will depend on the Class of Action type for the selected project.  The EST 
displays a different list of PD&E events for each Class of Action type.  

The following PD&E events are commonly listed in the Event column of the Class of Action: Type 
section in the Update Project Schedule window: 

 Date Initiated   

 Estimated Number of Months to Complete PD&E  

 Public Hearing  

 Location Design Concept Acceptance (LDCA)  

 Re-evaluation Complete 

 100% Permit Issuance 

To demonstrate the process for navigating the Update Project Schedule window, only the PD&E 
events that are commonly listed in the Class of Action: Type section are illustrated below.   

Note:  The update process is the same for the specific events that are only associated with a 
project’s COA type.  
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4. For the Date Initiated event, click the drop-down  arrow in the Date Initiated field, and then select 

the action that started the PD&E phase.  To continue the update process, follow Steps 10 through 12. 

 
 

 

5. For Estimated Number of Months to Complete PD&E, type or edit the number of estimated months in 

the Actual Date column.  To continue the update process, follow Steps 10 through 12. 

Note:  You must enter whole numbers when typing the number of estimated months. 

 

 

For Public Hearing, type or edit the date the required public hearing was held prior to the LDCA in 
the Actual Date column.   

 

 

Tip!  To add another public hearing event, click the Add button located in the Public Hearing 

row. 

 

 

6. For Location Design Concept Acceptance (LDCA), type the date the LDCA was granted by the lead 

agency in the Actual Date column.  To continue the process, follow Steps 10 through 12. 
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7. For Re-evaluation Complete, click the drop-down  arrow in the Re-evaluation Complete field and 

then select the type of re-evaluation that was completed.   

 

 

 Do the following: 

 To indicate if a significant design change is needed, click the Major Design Change checkbox 
located beneath the date field in the Actual Date column. 

 

 To add another Re-evaluation Complete field, click the Add button located in the Re-
evaluation Complete row. 

 

 To continue the update process, follow Steps 10 through 12. 

 

8. For 100% Permit Issuance, enter the date the permit was issued in the Actual Date field.  To continue 

the update process, follow Steps 10 through 12. 

9. In the Actual Date column, type the date for the selected Event. 

 

Tip!  When typing dates, use the mm/dd/yyyy format.  You can also click the calendar icon 

 and select the dates. 

Note:  If you add or change data in any of the Actual Date column fields, you must enter a 
reason for your change in the Comments field located at the bottom of the Class of Action: 
Type section. You will not be able to save your information until you type a reason in the 
Comments field. 

10. In the Comments field, enter your reason for adding or changing the data in the Actual Date column. 

11. To save your information, do one of the following: 
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 Click the Save button located on the same row as the selected Event. 

 

 Click the Save All button located at the bottom of the Class of Action: Type section beside the 
Comments field. 

 

12. To view or add documents associated with an event in the Event column, click the following buttons in 

the Related Documents column: 

Note: You must click Save before you can view or add related documents. 

 To view an attachment, click View Attachment. If there are any attachments, the View 
Attachment window opens as a tabbed page.  If no attachments are available, a message will 
appear stating there are no documents found for the selected event. 

 To add an attachment not currently stored in EST, click Add Attachment. The Attach 
Documents window opens as a tabbed page.  

 To select an attachment already stored in EST, click Select Attachment. The Select Project 
Attachment window opens as a tabbed page. 

The information in the Update Project Schedule window appears in the Project Schedule Report 
function in the EST Reports menu.  

 Publish Project Updates During PD&E (New 06/30/2015) 3.1.4.18

This tool lists all changes to information for projects that have entered the Project Development and 
Environment (PD&E) phase. If significant changes have been made to the project’s purpose and need, the 
updated information will be displayed on the screen along with comments justifying the reason for the change. 
Approved changes will be recorded outside of the EST in the project’s environmental document. Comments 
entered in the Publication Notes section will appear on the EST‘s Milestone Report.  

 

1. Select a project that is currently in the PD&E phase by going to the project navigation bar located at 

the top of the EST window, click the Active project arrow, and then make your selection by clicking on 

the project name and ETDM number. 

 

Tip!  You can change the list of Active projects using the search tools on the project navigation 
bar. For more information on how to use the project navigation bar search tools (e.g., selecting 
projects using Site Search and Advanced Search functions), refer to the Navigation chapter in the 
EST User Handbook.  

2. On the Tools menu, point to Project Diary, and then click Project Updates During PD&E. 
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The Publish Project Updates During PD&E page displays a history of edits to the project 
information along with any substantial changes to the purpose and need.  
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Tip!  Click the toolbar icon at the top of the window to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

3. Click the view report link to view a report. 

 

4. Enter any additional comments by typing into the Publication Notes text box. 

5. Click Publish. 
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Comments will be displayed in the EST’s Milestone Report.  
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3.1.5 Advance Notification Package (Updated 05/18/2015) 

 Edit Advance Notification Package (Updated 12/14/2014) 3.1.5.1

The Advance Notification (AN) is initiated by the Florida Department of Transportation (FDOT) through the 
Environmental Screening Tool (EST) as part of the Efficient Transportation Decision Making (ETDM) process.  

The AN package can be prepared offline and then added into the EST, or completed through the EST.  The AN 
package consists of a cover letter, transmittal list, Application for Federal Assistance (if a project is receiving 
federal funds), location maps, a fact sheet, and any anticipated permits and technical studies. 

Note: For details on compiling an AN package and the AN process, go to the FDOT Environmental 
Management Office website at http://www.dot.state.fl.us/emo/pubs/pdeman/pdeman1.shtm 

3.1.5.1.1 Accessing the Edit AN Package Screen 

6. On the project navigation bar located at the top of the EST window, click the Active project arrow and 

then make your selection by clicking on the project name and ETDM number. 

 

Tip!  You can change the list of Active projects using the search tools on the project navigation 
bar. For more information on how to use the project navigation bar search tools (e.g., selecting 
projects using Site Search and Advanced Search functions), refer to the Navigation chapter in the 
EST User Handbook.  

7. On the Tools menu, point to Advance Notification Package, and then click Edit AN Package. 

 

The Edit AN Package page opens and displays an Overview of the AN process along with a 
panel on the left side of the screen showing the order of the items that need to be included in the 
package.  

http://www.dot.state.fl.us/emo/pubs/pdeman/pdeman1.shtm
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Tip!  Click the toolbar icon on the Edit AN Package window to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

3.1.5.1.2 Selecting How the AN Package Will Be Distributed 

There are two ways the AN package can be distributed: 

 Along with the Programming Screen notification 

 Separately from the Programming Screen (e.g., AN  review to occur after the Programming Screen) 

To choose a distribution option, do the following: 

1. On the outline panel, click Select AN Process. 

 

2. The Update AN Process form appears on the screen’s main view. 
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3. Do one of the following: 

 Leave the current selection (in which case no action is required at this point). 

 Change the selection by clicking the button next to the desired option. Go to the next step of 
these instructions. 

4. If you change the option, click Update AN Process. 

 

3.1.5.1.3 Choosing the Method for Assembling the AN Package  

The EST provides you the option of uploading a PDF version of an AN package that has been created 
outside of the EST or using the system-generated AN package using the outline shown on the screen. At 
the top of the Edit AN Package screen are two option buttons for making your selection. 
 

Tip!  Click the question mark icon, , for additional guidance. 

 

 Generate AN Package in the EST – Select this option if you want to use the system-generated 

package in the EST. This option allows you to follow an outline of the required AN package sections, 

with links to open the pages for the relevant forms. 

 Upload AN Package – Select this option if you want to create an AN package outside of the EST and 

upload it for distribution. 

3.1.5.1.3.1 Using an AN Package That Has Been Created Offline 

The Edit AN Package feature in the EST enables ETDM Coordinators to use an AN package that has been 
created outside of the EST.  
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1. On the Edit AN Package screen, click the Use your own AN Package option. 

 

2. Click Browse, and then navigate to the relevant file on your desktop. 

 

3. Click Upload. 

 

The screen displays a confirmation and a PDF of the AN package. 

Note: Be sure to include the official EST-generated transmittal list with the uploaded AN package. 
The list is available for download in PDF and XLS (Excel) format. 

4. To download the EST-generated transmittal list, do one of the following:  

 Click on either the PDF or XLS link in the Reminder message shown on the page. 

 

 On the Tools menu, point to Advance Notification Package, and then click Transmittal List.  

 

Note: If you change the AN package option from Use your own AN Package to Generate AN 
Package in EST, the package created outside the EST will be deleted. 

3.1.5.1.3.2 Generating an AN Package in the EST 
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The AN package that is generated in the EST provides a step-by-step process for assembling the required AN 
package documentation. The instructions in this section show the steps for generating an AN package within 
the EST. 

The Generate AN Package in EST option is automatically selected by default. 
 

  
 
The components of the AN package are listed as an outline in the left window pane.  
 

Tip!  A red asterisk, *, indicates information that needs to be completed before the AN package can be 

generated. 
 

 

3.1.5.1.4 Cover Letter 

The AN package includes a cover letter addressed to Florida State Clearinghouse, but distributed to all 
recipients of the AN package.  The cover letter should include the project name, ETDM number, Financial 
Management Number if available, and Federal Aid project number if one has been assigned. If the project has 
been previously screened this should be acknowledged as well. 

Note:  Before uploading the cover letter, be sure it is in PDF format. 

1. On the outline panel, click the Cover Letter link. 
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The Cover Letter pane displays a Browse button and File path field. 

 

2. On the File field, click Browse, and then navigate to the relevant file. 

3. After the file path appears, click Upload. 

 

The screen displays the uploaded cover letter.  

 

Tip!  You will see an X positioned beside the uploaded letter on the Cover Letter screen. Clicking 

the X will delete the letter that is displayed.   
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Tip! You can replace a cover letter that has previously been uploaded to the AN package by repeating 

the steps listed in this section. 

3.1.5.1.5 Location Maps 

The AN package contains a project location map and may also include a project aerial map.  These maps (and 
others if needed) can be uploaded to or generated by the EST.  They should include the state road number (if 
applicable), the project's common name, city and/or county of location, project boundary/limits, and any 
alternatives.  The maps are combined with the rest of the information and distributed as a part of the AN 
package.  

Note: Location maps and GIS analyses are generated before the AN package is generated.  

On the outline panel, click the Location Maps link. 

 



 

 

 

 Environmental Screening Tool Handbook - February 15, 2016 3-132 

The Location Maps pane displays the system-generated maps and a User Uploaded Maps form for adding 
maps that were generated outside of the EST. The next illustration displays the view when system-generated 
maps are available. 

 

The next illustration shows the screen when no maps have been generated in the EST for the selected project.  

A red asterisk, *, and a re-generate hardcopy maps link displays under the System Generated Maps 

subheading. 

 

The following sections describe the navigation steps for performing the actions listed below: 

 Include system-generated maps in the AN package 

 Re-generate hardcopy maps 

 Upload maps generated outside the EST 

3.1.5.1.5.1 Including system-generated maps in the AN package 

To include system-generated maps in the AN package, click the check box beside each map you want to 
include in the AN package. 
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Tip!  To deselect a map from inclusion in the AN package, click the marked box to clear it.  

3.1.5.1.5.2 Re-generating hardcopy maps 

If no map icons appear under the System Generated Maps heading, you can generate them and then add 
them to the AN package by clicking the re-generate hardcopy maps link. 

 

After clicking the link, your request will be added to a map processing queue.  

Note: Requests for system-generated hard copy maps are processed within 24 hours. The icons for the 
generated maps will appear on the screen the following day.  Follow the steps listed under the Including system-
generated maps in the AN package section of these instructions. 

3.1.5.1.5.3 Uploading maps generated outside of the EST 

1. Type the name of the map in the Name field. 

2. Click the Browse button and then navigate to the relevant file on your desktop. 

3. Click Upload.  

 

The uploaded map name and icon will then appear as a PDF or JPG. 
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Tip! To remove a map, click the X beside the map icon. 

4. Click the check box beside each  map you want to include in the AN package.  

3.1.5.1.6 Fact Sheet 

The fact sheet describes the project, specifies all permits potentially required for a project, and states whether 
the project will occur in navigable waters. The AN process provides the initial opportunity for agencies to 
become aware of proposed actions by FDOT, provide comment, and share information with FDOT regarding 
potential effects associated with the proposed activities.  The fact sheet includes the following components: 

 Purpose and Need – Provides Information that has been coordinated with the District planning 
office. The status of planning consistency should be included in this section. 

 Project Description – Includes a summary of project information. 

 Preliminary Environmental Discussion – This section is prepared by the District and includes 
the identification of environmental issues/resources, including community features, a description 
of potential involvement with issues/resources, and a discussion of anticipated technical reports 
and permits. 

Tip! For additional details concerning what information should be included in each section of the 

AN package, go to http://www.dot.state.fl.us/emo/pubs/pdeman/Pt1Ch3_101912-current.pdf .  

3.1.5.1.6.1 Editing the Purpose and Need and Project Description  

1. Click the Purpose and Need or Project Description link on the Edit AN Package outline.  

 

2. To make changes to the Purpose and Need or to the Project Description, click the Edit button. 

http://www.dot.state.fl.us/emo/pubs/pdeman/Pt1Ch3_101912-current.pdf
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 Type your edits in the text box. 

 Click the Save button to submit your changes and continue editing. 

 Click the Save and Close button to save your changes and return to the read-only view. 

 

 

3.1.5.1.6.2 Updating analysis types and running a GIS analysis 

When you select an issue from the Edit AN Package outline, the screen displays the form for entering 
the Preliminary Environmental Discussion (PED) comments for the selected issue, along with tabs 
containing information used to support the development of the PED, including Summary Degree of 
Effect Information and the GIS Analysis Results for the issue. Analysis types for an issue may have 
been added or updated since the last time the GIS analysis report was run. The EST notifies you of 
outdated analysis types and provides you the option of updating the analysis types for the selected issue 
and for the project as a whole. 
 

Tip!  This icon, , will display if analysis types have been added or updated since the GIS analysis 

report was last run for the selected issue. 
 
You can update analysis types by doing the following: 
 

1. Select an issue from the Edit AN Package outline by clicking the issue link. 
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2. On the issue page (for this illustration, we show the issue Land Use Changes), click the GIS Analysis 

Results tab. 

 

3. On the GIS Analysis Results screen, do any of the following: 

 View a list of analysis types that have been added to the selected issue:  Scroll down the GIS 
Analysis Results screen to view a list of the analysis types that have been updated or added to 
the selected issues since the GIS Analysis report was last run. 

 View a list of analysis types that have been added for all issues for the project: Click the click 
here link to view a list of all added/updated analysis types for all issues for the project. 
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4. Click Update Analysis Results. 

 

A confirmation box with a link to a list of updated analysis types displays on the screen. 
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5. To proceed with the analysis update for the listed types, click the OK button. 

 

The system displays a message, noting that the project has been queued for an analysis update. 

Note: Your request to update the analysis types must go through the queue before the results are 
displayed. It is recommended that you return to the page at a later time to view the revised 
information.  

 

 

6. Click the appropriate check boxes  beside  the Analysis Types and Buffer Distances you want to  

display in the report. 

7. Click Run Report. 
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3.1.5.1.6.3 Adding new Preliminary Environmental Discussion (PED) comments 

The Preliminary Environmental Discussion section of the AN package outline displays links to 
resources/issues in the project area. 

1. Under Preliminary Environmental Discussion, select a resource issue by clicking the link.  

 
 

The screen for the selected issue displays the tabbed form for the New PED Comment, with two 
tabbed pages that link to the Summary Degree of Effect Information and GIS Analysis Results. 

Tip!  See the Updating Analysis Types and Running a GIS Analysis section of these instructions 

for information on updating analysis information. 

 

2. Click the green tabs to display the Summary Degree of Effect Information and GIS Analysis Results. 

 

 

3. Click the Preliminary Environmental Discussion tab to return to the PED Comments form. 

4. Click New PED Comment. 
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5. In the PED Editor wizard, click one of the following options to indicate the category your comment 

applies to: 

 Project PED – Comments will apply to entire project 

 Alternative PED – Comments will apply to particular alternatives 

 

6. Click Next. 

7. Enter your information by doing the following: 

 For Project PED - Type your comment in the text box and then click Finish. The EST displays 
the added comment. 

 For Alternative PED – Do the following: 

 Click the check box beside an alternative to select it. 

 Click Next. 
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 If you are entering a Degree of Effect (DOE) for ETAT members to consider during their 
review, click the Degree of Effect arrow, and then select the appropriate DOE from the list. 

Note: Selection of a DOE here is optional and it will not appear in the AN 
package.  

 

 Type your comments into the text box. 

 Click Finish. 

3.1.5.1.6.4 Editing or deleting Preliminary Environmental Discussion (PED) comments 

Resource issues that have been commented on will not display a red asterisk, *, on the Edit AN Package 
outline.  You can edit or delete existing comments to an issue by doing the following: 
 

1. Under Project Environmental Discussion level, select a resource issue by clicking the link.  
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The screen for the selected issue displays the form for entering PED comments along with buttons 
for editing or deleting existing comments.  Also shown are two tabbed pages that link to the 
Summary Degree of Effect Information and GIS Analysis Results. 

 

2. Do any of the following: 

 To modify an existing comment — Click the Edit button adjacent to the comment. 

 

  Do the following:  

 In the PED Editor dialog box, type your edits into the text box. 

 Click Finish. 

 To delete a PED comment – Click the Delete button adjacent to the comment: 
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3.1.5.1.7 Anticipated Permits and Anticipated Technical Studies 

The Anticipated Permits and Anticipated Technical Studies sections of the AN package allow you to 
identify what permits and technical studies are anticipated and indicate any conditions.  The navigation 
steps for both of these features are the same and are listed as follows: 
 

1. Click the Anticipated Permit or Anticipated Technical Studies link on the Edit AN Package outline. 

 

The Anticipated Permits/Anticipated Technical Studies page displays a form showing a search 
box at the top of the page and a list of permits/studies. 
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2. To narrow your search for Permits/Technical Studies – Type a keyword into one of the search boxes 

that are shown under the following columns: 

 Category (e.g., permitting authority, field, water, other) 

 Type (e.g., utility and water classifications, dredge and fill) 

 Conditions (e.g., keyword for site-specific condition) 

 

Tip!  Click the reset icon   that is located at the bottom of the page to clear the fields. 

3. Click the check boxes beside the appropriate item on the form. 
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After checking an item, a Create Conditions button appears. 

 

4. To add a condition, do the following: 

 Click Create Conditions. 

 In the Edit Record text box, type or copy and paste the information. 

 Click OK. 

After clicking the OK button, the screen refreshes and displays the comments along with an 
Edit Conditions button. 
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5. To edit conditions comments, click the Edit Conditions button and repeat the steps listed above in Step 

4 of these instructions. 

3.1.5.1.8 Application for Federal Assistance 

If a project includes Federal Involvement, an Application for Federal Assistance must be included in 
the AN package. A link to a blank SF-424 form is available for download. A PDF of the completed form 
can then be uploaded for inclusion in the AN package.   
 

1. Click the Application for Federal Assistance link on the Edit AN Package outline. 

 

The Application for Federal Assistance page displays a form with links for doing the following: 
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 Changing the Federal Involvement selection 

 Downloading Instructions for completing the Application for Federal Assistance 

 Downloading a Blank Form 

 Attaching a completed Application for Federal Assistance PDF to the AN package 

 

Under the Application for Federal Assistance heading, you will see the project’s Federal 
Involvement status and a notice stating that an Application for Federal Assistance is required or not 
required.   

 

3.1.5.1.8.1 To Change a Project’s Federal Involvement 

You can change a project’s Federal Involvement status through the Edit AN Package feature by doing 
the following: 
 

1. Click the change this link. 

 

The EST opens the Update Project Description page, where you can change the Federal 
Involvement selection. 
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2. After you submit your changes on the Update Project Description page, return to the Edit AN Package 

page. 

3. Do one of the following: 

 If the project does not involve federal funding, no further action is required.  

 If the project does involve federal funding, follow the steps listed in the next section of these 
instructions. 

3.1.5.1.8.2 Attaching the Application for Federal Assistance to the AN package 

This section provides the steps for downloading the instructions for completing the Application for Federal 
Assistance, for downloading a blank application form (SF-424), and for attaching a completed application 
to the AN package. 
 

 To download the Instructions for completing the application form - Click either the PDF icon or 
the Microsoft Word icon to select the document format type. Follow the instructions for opening 
or saving the document. 

 To download a blank application form - Click either the PDF icon or the Microsoft Word icon to 
select the document format type. Follow the instructions for opening or saving the document. 

Note:  In order to attach the completed Application for Federal Assistance to the AN 
package, you must convert the document to PDF before uploading it. 
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 To upload a PDF of the completed Application for Federal Assistance - Click the Browse button, 
select the file name, and then click the Upload button. 

 

3.1.5.1.9 Transmittal List 

A transmittal list is a record of the recipients of the AN, and must be provided in the AN package. 
Recipients of the AN package include the following:  
 

 ETAT members 

 Consistency reviewers 

 Elected officials 

 Federally recognized tribes 

 Other local, state, and federal agencies that need, or have requested, to be notified  

 
Note: Not all the contacts listed are applicable for all projects. The appropriate stakeholders should be 
identified by the District. The EST has a list of mandatory AN contacts managed by the State 
Environmental Management Office (SEMO). The District is responsible for adding additional project-
specific contacts to the list. See the Manage Contact List section in the  Account Settings chapter of the  
EST User Handbook for information on adding and managing contacts. 
 

1. Click the Transmittal List link on the Edit AN Package outline. 
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The Advance Notification Package Transmittal List opens and displays the contacts who will be 
receiving the AN package.  

 

Tip!  Click a column heading to display the list in ascending/descending order. 

2. The transmittal list tool at the top of the page allows you to perform the following actions: 

 Search for contacts 

 Add contacts 

 Create new contacts 

 Edit or remove contacts  

 

3.1.5.1.9.1 Searching for contacts 

1. Type part of the name you are searching for (this can be the name of a person or organization). 

2. Select the appropriate option by clicking on it. 
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The Advance Notification Package Transmittal List screen displays the name and related 
information. 

 

3.1.5.1.9.2 Adding contacts 

1. Click Add from Contact List. 

 

The screen displays a list of contacts. 

2. Under Contacts, click the check box beside the name of the contact you want to add to the AN package 

transmittal list.   

Tip!  If you do not want to include a name on the transmittal list, click the checked box beside 
the name to remove the checkmark.  

3. Click Finish. 
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3.1.5.1.9.3 Creating new contacts 

1. Click Create New Contact. 

 

2. The screen displays a wizard  for adding the contact information. Follow the step sequence to complete 

the forms provided on each of the wizard pages.  Click the Next button to display the next form. 

Note: Highlighted fields marked with an asterisk, *, indicate the information is required and must 

be completed. 

3. Click Done. 

 

3.1.5.1.9.4 Editing or removing contacts  

You can edit and remove project-specific contact information that you have added to the list by doing the 
following: 

 To make edits to a recipient’s contact information - Click the Edit link for the selected name to open the 

contact information wizard, where you can make your edits.   
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 To remove a name from the contact list – Click the Remove link for the selected name.  

Note: Removing a name from the list will not affect the contact’s account information. 

 

3.1.5.1.10 Previewing the Draft AN Package 

Once you have completed reviewing the AN package and have included the required components, you can 
preview a PDF of the draft AN package and print it for internal distribution before publishing the final document. 

1. On the Edit AN Package outline, click the Preview Draft PDF link. 

2. A File Download box appears with a message asking you to select an action. Select Open or Save. 

3. Follow the standard steps for opening and saving a file. 

3.1.5.1.11 Saving the Final Draft of the AN Package 

1. Check each component listed in the outline to ensure all red asterisks have been cleared.   

2. In the left panel of the Edit AN Package window, click the Save Final Draft PDF link.  

 

The Sign and Generate Final Draft page displays. 

 

3. Type your Password. 
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4. Click Save Final Draft. 

 

The page refreshes and displays the PDF of the final draft, where you can review the contents of 
the final version of the AN package. 

Note: If an “out-of-date” notice displays, this means there are items within the draft that have been 
updated since the last time the draft was saved.    
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3.1.5.1.12 Replacing an Out-of-Date Draft 

If the Sign and Generate Final Draft page displays an out-of-date notice, do the following: 

1. Click the relevant links on the AN package outline. 

2. Review/update the most recent information. 

3. Click the Save Final Draft PDF link on the AN package outline to return to this page. 

4. Enter your Password. 

5. Click Save Final Draft. 

 

 Respond to AN Package Comments (New 03/11/2014) 3.1.5.2

The Respond to AN Package Comments feature in the EST Tools menu allows ETDM District 
Coordinators to review comments made by Environmental Technical Advisory Team (ETAT) and Advance 
Notification (AN) Commenting Interested Party members following their review of an AN package. 
Coordinators can respond to reviewer comments for projects within their jurisdiction. 
 
The instructions for this feature provide navigation steps for the following actions: 

 Accessing the AN Package Comments and Responses page 

 Responding to review comments 

 Displaying the comments and responses in a grid format 

3.1.5.2.1 Accessing the Review AN Package Comments and Responses Page 

 

1. On the project navigation bar that is located at the top of the EST window, click the Active project arrow 

and then make your selection by clicking on the project name and ETDM number. 

 

2. On the Tools menu, point to Advance Notification Package, and then click Respond to AN Package 

Comments. 
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The AN Package Comments and Responses page opens. The review comments will be shown 
under the Advance Notification Package Comments heading. Coordinators that have the project 
within their jurisdiction will see an Edit Response button displayed on the page. 

Tip!   Click the toolbar icon on the window to: 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

3.1.5.2.2 Responding to Review Comments 

1. Click Edit Response. 
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The Edit Response dialog box appears. 

 

2. Type your response comments into the text box.  

3. Click Save. 

 

Your response will appear below the reviewer’s comments. 
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4. To revise or make edits to your comments, click the Edit Response button and repeat the steps listed 

above. 

Tip!  The reviewer comments and your responses will also appear in the AN Comments and 

Responses Report, which is located in the Reports menu. 

3.1.5.2.3 Displaying the Comments and Responses in a Grid Format 

 
The Advance Notification Package Comments page allows you to choose the option of displaying the 
information in a grid format. 
 

1. Click View Grid. 

 

The comments and responses are displayed, as shown in the next illustration. 

The Edit button also appears on the grid.  Follow the steps shown in the Responding to Review 
Comments of these instructions to add or edit your comments. 

 

2. To return to the previous list format, click the View List button. 

Tip!  Click the View Grid/View List buttons to toggle between the list and the grid views.  
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 Advance Notification Package Transmittal List (Updated 03/03/2015) 3.1.5.3

The AN package must include a transmittal list of recipients. Recipients of the AN package include the 
following:  
 

 ETAT members 

 Consistency reviewers 

 Elected officials 

 Federally recognized tribes 

 Other local, state, and federal agencies that need, or have requested, to be notified  

 
The State Environmental Management Office (SEMO) maintains the contact information for state and 
federal agencies and federally recognized Native American Tribes receiving AN packages. The 
responsibility for local or project-specific contacts falls to the FDOT project team.  
 
Whenever possible, the AN package should be sent electronically after coordinating with the recipient. All 
federally recognized Native American Tribes affiliated with Florida should be sent a hard copy of the AN 
package.  
 
Note: Refer to PD&E Manual, Part 1, Chapter 3 Preliminary Environmental Determination and Advance 
Notification for guidance on distributing the AN package. 
 
The Advance Notification Package Transmittal List tool in the EST allows you to perform the following 
actions: 

 Manage your contact lists 

 Edit your contact lists  

 Remove contacts from a list 

3.1.5.3.1 Accessing the Transmittal List from the Main Menu 

 
On the Tools menu, point to Advance Notification Package, and click Transmittal List. 
 

  

The Advance Notification Package Transmittal List opens and displays the contacts who will be receiving 
the AN package.  



 

 

 

 Environmental Screening Tool Handbook - February 15, 2016 3-160 

Tip!  Click a column heading to display the list in ascending/descending order. 

 

Tip!   Click the toolbar icon on the window to: 

  Export the page to a PDF file. 

 Export the page to an Excel spreadsheet. 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

3.1.5.3.2 Managing Contacts  

The top of the  Advance Notification Transmittal List  screen provides a contact search box and links for 
managing the list of transmittal list contacts. You can add names from contact lists you created and create new 
contacts. Click on one of the following links to jump to the navigation steps for an action: 

 Search for contacts 

 Add contacts from Contact Lists 

 Create new contacts 
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3.1.5.3.2.1 Searching for contacts 

1. Type part of the name you are searching for in the Search for Contact to Add to List field (this can be 

the name of a person or organization). A list of matching contacts will be displayed. Continue typing to 

further narrow down the list. 

2. Select the contact name by clicking on it. 

  

The Advance Notification Package Transmittal List screen displays the name and related 
information. 

 

3.1.5.3.2.2 Adding contacts 

1. Click Add from Contact List. 

 

The screen displays the Contact Lists box.  

 

2. Click the list name to select it. 
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3. Under Contacts, click the check box beside the name of the contact you want to add to the AN package 

transmittal list.   

Tip!  If you do not want to include a name on the transmittal list, click the checked box beside the 
name to remove the checkmark.  

Note: Grayed out check boxes are disabled because the contact is already on the transmittal list. 

 

4. Click Finish. 

 

3.1.5.3.2.3 Creating new contacts 

1. Click Create New Contact. 
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The screen displays a wizard for adding the contact information.  

 

2. Follow the step sequence to complete the forms provided on each of the wizard pages. Click the option 

button to indicate the following: 

 Notification Type 

 Allow Comments in the EST 

3. Click the Next button to display the next forms for adding the contact’s information. 

Note: Highlighted fields marked with an asterisk, *, indicate the information is required and must 

be completed. 

4. After completing the forms displayed in the wizard, click Done. 

 

3.1.5.3.3 Editing or Removing Contacts  

You can edit and remove project-specific contact information that you have added to the list. However, some 
contacts cannot be edited or removed by individual users. Please see notes indicating these exceptions in the 
steps below. To edit or remove a contact, do the following: 

 To make edits to a recipient’s contact information - Click the Edit link for the selected name to open the 

contact information wizard, where you can make your edits.   
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Note: Names that are managed by SEMO are not available for editing (i.e., no Edit link will be 
displayed). These contacts can only be edited by the ETDM Help Desk at help@fla-etat.org or 
call 850-414-5334. 

   

 To remove a name from the contact list – Click the Remove link for the selected name. Removing a 

name from the list will not affect the contact’s account information. 

Note: Mandatory recipients cannot be removed from a list (i.e., no Remove link will be 
displayed). Contact the ETDM Help Desk if you know the recipient isn’t valid. 

 

 

 AN Transmittal List: Batch Uploader (Updated 04/03/2015) 3.1.5.4

The AN Transmittal List: Batch Uploader function in the Environmental Screening Tool (EST) Tools menu 
enables District ETDM Coordinators to add additional non-mandatory recipients to the Advance Notification 
(AN) Package transmittal list using an Excel spreadsheet provided by the EST. 

When you enter a recipient’s contact information in the AN Package transmittal list spreadsheet, it must match 
the information listed in the EST database for it to be validated.  Recipients listed in the uploaded spreadsheet 
who do not match records in the EST database are treated as new contacts. 

Note: Changes to a recipient’s contact information cannot be made using the transmittal list spreadsheet. To 
update contact information in the EST, go to Tools>Advance Notification Package>Transmittal List and 
then click on the Edit link for the respective recipient.  (See the Advance Notification Transmittal List section of 
the EST Handbook for guidance). For further assistance please contact the ETDM Help Desk at help@fla-
etat.org for assistance. 

3.1.5.4.1 Accessing the AN Transmittal List Upload Screen 

1. On the project navigation bar located at the top of the EST window, click the Active project arrow and 

then make your selection by clicking on the project name and ETDM number. 

 

Tip!  You can change the list of Active projects using the search tools on the project navigation 
bar. For more information on how to use the project navigation bar search tools (e.g., selecting 
projects using Site Search and Advanced Search functions), refer to the Navigation chapter in the 
EST User Handbook.  

2. On the Tools menu, point to Advance Notification Package, and then click Upload Transmittal List. 

mailto:help@fla-etat.org
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The AN Transmittal List: Batch Uploader screen displays the form for uploading the list along 
with a link for validating the spreadsheet. 

 

Tip!   Click on the toolbar icons to: 

   Send feedback about the current page. 

   Access online Help. 

    Bookmark the page. 

   Add the page to your My ETDM preferences. 

3.1.5.4.2 Opening a Blank Spreadsheet 

 

1. Click the batch upload spreadsheet link to download a blank Excel spreadsheet from the EST 

database.  
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2. Follow the standard steps for downloading and saving a file to your computer.  

 

3. Open the blank transmittal list spreadsheet in Excel and enter the information into the appropriate 

columns. 

 

3.1.5.4.3 Validating the Transmittal List 

The Validate feature within the spreadsheet ensures that all fields have been completed and that the 
information in the spreadsheet matches the information in the EST database.  
 

1. After you have logged the information into the spreadsheet, click the Validate button located on the 

Excel spreadsheet (Column U).  
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Note: Required cells that have been left blank will display as shaded. 

 

Note: If the Validate button does not work, it may have been blocked by your system’s security 
program. Check the Excel message bar (located beneath the ribbon) for a Security Warning 
message (see next illustration).  

 

Note: If a security warning appears on the screen, you can enable the validation macro by doing 
the following: 

1) Click Options. A security alert message will appear. 
2) In the Security Alert – Macros dialog box, click the Enable this content option button. 
3) Click OK. 
4) In the Excel spreadsheet, click the Validate button again. 

 
If there are errors in the spreadsheet, a message will display, as shown in the next illustration. 
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2. Click OK. 

The cells containing the errors will be highlighted in red.  For example, the next illustration shows 
the acronym FHWA was entered instead of the full spelling of the organization’s name—Federal 
Highway Administration. 

Note: Information must be spelled exactly as it appears in the database. This means the full 
spelling of an organization’s name must be entered in the spreadsheet if it appears that way in the 
database. 

 

3. You can make the correction by typing it, or you can click the drop-down arrow and select the appropriate 

option from the list.  

 

4. If the spreadsheet passes the validation, the program displays a message, as shown in the next 

illustration. 

 

5. Click OK. 
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6. Return to the AN Transmittal List: Batch Uploader screen to upload the transmittal list. 

Note:  Bypassing the Validation process before uploading the transmittal list will result in an error 
message displaying on the screen. You will then be required to revise the list and repeat the upload 
process. 

3.1.5.4.4 Uploading the Transmittal List 

 

1. In the Upload File field, upload the transmittal list by typing or copying and pasting the document path, or 

you can click the Browse button to navigate to the document’s location on your desktop. 

2. Click Upload Spreadsheet. 

 

The AN Transmittal List: Batch Uploader screen refreshes and displays the list. Depending on 
whether or not the list contains errors, one of the following screens will display: 

 If the list has been validated and contains no errors, this screen will display: 

 

 If the list contains errors, a message will display on the screen: 
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Tip!  The Status column of the spreadsheet indicates whether a contact was validated (shown 

with a check mark ) or not (shown with an ).  A star icon, , indicates the contact was 
added to the transmittal list but could not be updated in the database.  

3. Click the Upload another spreadsheet link to replace a transmittal list with an updated version. 

4. After the transmittal list has been validated and uploaded, the contacts that were added will appear in the 

official AN Package transmittal list that is generated by the EST database. Go to the Tools menu, point 

to Advance Notification Package, and then click Transmittal List to view the list containing the 

recently added contacts. 

5.  

Note: If you have questions regarding contact permissions, contact the ETDM Help Desk at 
help@fla-etat.org. 

 

 Mailing Labels (Updated 05/18/2015) 3.1.5.5

The Mailing Labels feature in the Environmental Screening Tool (EST) provides you with printing label options 
for mailing hard copies of the Advance Notification (AN) package.     

The AN package Mailing Labels list is based on the AN package transmittal list, where recipients receiving 
hard copies of the package are indicated by the Notification Type column (see next illustration). The database 
automatically retrieves the names of the hard copy recipients and makes mailing labels available for printing. An 
Excel option is available if the label size you need is different from the ones shown on the Mailing Labels list. 
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3.1.5.5.1 Accessing the AN Package Mailing Labels Feature 

1. On the project navigation bar located at the top of the EST window, click the Active project arrow and 

then make your selection by clicking on the project name and ETDM number. 

 

Tip!  You can change the list of Active projects using the search tools on the project navigation 
bar. For more information on how to use the project navigation bar search tools (e.g., selecting 
projects using Site Search and Advanced Search functions), refer to the Navigation chapter in the 
EST User Handbook.  

2. On the Tools menu, point to Advance Notification Package, and then click the Mailing Labels arrow. 

 

The Mailing Labels menu displays links to different label sizes. Labels are based on standard 
Avery templates, with links to particular labels that are identified by label size and number of labels 
per sheet. An Excel File link at the bottom of the menu allows you to export recipient mailing 
addresses to a spreadsheet. 
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3.1.5.5.2 Printing a Sheet of Labels 

1. Select one of the label options by clicking the menu link. For this illustration, the Avery 5160 – 2.635” x 1” 

– 30/sheet is shown as selected. 

 

The mailing labels display as a PDF in a separate window. 

 

2. Follow the standard process for saving or printing a PDF. 

Tip! Before printing onto a label sheet, first print onto a blank piece of paper. Place the printed 

sheet in front of a label sheet, and then hold the sheets up to a light to make sure the positioning is 
correct. If the positioning reveals the labels do not match the position on the label sheet, you may 
need to select another label size. 

3.1.5.5.3 Exporting Labels to an Excel File 

The Excel File menu option allows you to export recipient addresses to a spreadsheet, where you can 
print to label sizes that are not available on the Mailing Labels tool. 
 

1. Click Excel File. 
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2. Follow the standard process for opening or saving the file. 

 

A separate screen displays the list of addresses in Excel. 

 

3. Follow the standard process for saving or printing the file. 

Tip!  If you want to send a mass mailing to an address list that you maintain in a Microsoft Office 

Excel worksheet, you can use a Microsoft Office Word mail merge. The mail merge process 
creates a sheet of mailing labels that you can print, and each label on the sheet contains an 
address from the list. Information for performing a mail merge can be found on the Microsoft Office 
website at https://support.office.com/en-us/article/Create-and-print-mailing-labels-for-an-address-
list-in-Excel-c56e9814-df0b-43ba-bec3-999db728169d#bm1. 

https://support.office.com/en-us/article/Create-and-print-mailing-labels-for-an-address-list-in-Excel-c56e9814-df0b-43ba-bec3-999db728169d#bm1
https://support.office.com/en-us/article/Create-and-print-mailing-labels-for-an-address-list-in-Excel-c56e9814-df0b-43ba-bec3-999db728169d#bm1
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3.1.6 Review Project (Updated 10/30/2014) 

 Review Advance Notification Package (Updated 03/30/2014) 3.1.6.1

The Review Advance Notification Package feature in the Environmental Screening Tool (EST) Tools 
menu enables Commenting Interested Parties to review the Advance Notification (AN) package and 
record their comments. The AN package is a means of informing agencies and interested parties of 
FDOT’s intent to proceed with a project. It also provides them with a consistent, comprehensive project 
record. 
 
Commenting Interested Parties assigned to review the AN package are usually regional planning council 
and local government personnel who are authorized by a State Clearinghouse Coordinator (Federal 
Consistency – Commenting Interested Parties) or District ETDM Coordinators and Project Managers 
(Advance Notification – Commenting Interested Parties) to access the secure EST. The tasks of  
Commenting Interested Parties are as follows: 

 Federal Consistency – Commenting Interested Parties provide advisory comments, based upon such 

issues as consistency with the strategic regional policy plan or the local government comprehensive 

plan, or conflict with other known area activities. 

 Advance Notification – Commenting Interested Parties review ETAT comments and submit additional 

comments, if warranted, on a project’s effects. 

Individuals assigned to a Commenting Interested Party role receive electronic notification from District 
ETDM Coordinators notifying them that the review process has started. Commenting Interested Parties 
have access to EST maps and standard reports about the project and resources, including confidential 
information such as locations of archaeological sites. They are also able to view draft ETAT commentary 
and submit comments regarding federal consistency or project effects within 45 days of receiving 
notification. 
 
The instructions for this feature provide navigation steps for the following actions: 

 Accessing the Review AN Package page 

 Viewing the AN package 

 Entering comments 

 Submitting comments 

3.1.6.1.1 Accessing the AN Package Comment Page 

 

1. On the project navigation bar that is located at the top of the EST window, click the Active project arrow 

and then make your selection by clicking on the project name and ETDM number. 

 

2. On the Tools menus, point to Review Project, and then click Advance Notification Package. 
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The Review AN Package page opens and displays a link to the AN package and a text box for 
comments. 

3.1.6.1.2 Viewing the AN Package  

A PDF version of the AN package for the current review screen can be accessed from the Review AN 
Package page.  
 

1. Under View Advance Notification Package, click the Advance Notification Package link to the PDF 

document. 

 

The Advance Notification Package opens as a PDF in a separate tabbed window.  

2. Follow the standard steps for opening and saving a PDF document. 

3.1.6.1.3 Entering Comments 

After you have completed your review of the AN package, you can add any additional points of 
consideration that need to be included in the Programming Screen.  
 

Tip!  Use the formatting toolbar at the top of the text box to display your comments as a list, or use the 

bold, italics, and underline functions to add emphasis. 
 

Note: The Comment field is a required field.  
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3.1.6.1.4 Submitting Comments 

When you have finished adding your comments, click the Submit Review button. 
 

 
 
 
Your review will be sent to the District Coordinator and will be included in the AN package and 
Programming Screen Summary Report. 
 

 Review Purpose & Need (Updated 10/30/2012) 3.1.6.2

The Review Purpose & Need form displays the Purpose and Need for the project; allows ETAT 
representatives to acknowledge, on behalf of their agency, that the project purpose and need is understood or 
not understood; and provides space for comments on the project purpose and need. During the programming 
screen, agencies may request an invitation to act as a Participating or Cooperating Agency for projects with 
federal involvement  

1. Select a project from the Active Project list. 

2. In the Tools menu, click Review Project, and then click Purpose & Need. 

 

The Review Purpose & Need page displays. 
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3. Under Participating or Cooperating Agency During NEPA, click the check box beside the appropriate 

role selection. 

 

 

4. A Confirm Request box appears showing the agency selection.  Do the following: 

 Type a reason for wanting to serve in the selected capacity (i.e., Cooperating or Participating). 
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 Click Accept. 

 

 Notes: 
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 ETAT agencies can only make their participating or cooperating agency requests during a 
Programming Screen when a project is in active review and when a project has federal 
involvement. 

 FDOT ETDM Coordinators receive an email from the ETAT agency requesting an invitation to act 
in a participating or cooperating role. These requests are passed along to the federal Lead 
Agency, once it has been designated. 

 After the review period ends, the Lead Agency will send invitations to agencies it wants to invite 
as participating or cooperating agencies. Every request will receive a response - either an 
invitation or a reason the agency was not invited. 

5. Complete the remainder of the Review Purpose & Need form and then click Submit Review. 

Tip!  Details for completing the Review Purpose & Need form are provided in the tools chapter of 

this handbook. 

6. The Confirmation screen displays your agency’s responses on the Review Purpose & Need form, 

allowing you to review the information and make changes, if necessary. 

Tip! Click the Edit link to make changes to the corresponding Purpose and Need section. 

 

Tip!   Click the toolbar icon on the window to: 

 Display the tip reference. 

 Play the training video. 

 Send feedback about the current page. 

 Access online Help for the current page. 

 Bookmark the page. 

 Add the page to your My ETDM preferences. 
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 Project Effects (Updated 10/30/2012) 3.1.6.3

Project review occurs through the web-based Environmental Screening Tool (EST), which is used to 
engage agency participants in the transportation planning process. The EST provides information about 
projects and the surrounding environment. The Environmental Technical Advisory Team (ETAT) 
evaluates the potential direct and indirect effects of each project alternative, on natural, physical, cultural, 
and community resources within their jurisdictions. Optionally, the ETAT may provide considerations 
related to cumulative effects if there is an issue. 
 
If there is a concern about cumulative effects, use the Cumulative Effects Considerations Review form in 
the EST Tools menu to provide considerations that will help the Lead Agency decide on the level of 
evaluation needed in the environmental document. ETAT members are not expected to evaluate 
cumulative effects during the Planning and Programming Screens nor assign a Degree of Effect (DOE). 
See the FDOT Cumulative Effects Evaluation Handbook for guidance (available on the FDOT CEMO 
website).  
 

Tip!  For a complete list of issues your agency reviews, go to the Reports menu, click Agency 

Participation, and then click Agencies and Associated Resource Issues. 

Notes:  

 As of October 15, 2012, the issue names shown in the Project Effects page reflect the new issues 
and categories.  

 Projects sent for review on or after October 15, 2012, will require the new set of issues and 
categories on review forms and in the summary report.  

 Projects sent for review before October 15, 2012, will show the previous set of issues on review 
forms (e.g., if a reviewer has a review extension) and the summary report. 

 Projects beginning a review period after October 15, 2012, use the Project Effects and 
Cumulative Effects Considerations Review forms. Prior to this, comments related to indirect and 
cumulative effects were combined in one section. Comments submitted during screening events 
beginning after that date show separate comments for direct, indirect, and cumulative effects. 
Reports showing results of earlier screening events combine the comments related to indirect and 
cumulative effects. 

Using the Project Effects Form: 

1. To access the Project Effects form in the EST, go to the Tools menu, click Review Project, and then 

click Project Effects. 

 

The Project Effects page opens. 
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2. On the Project Effects page, under Review Options, you can can either review multiple issues or a 

single issue.   

 

 To perform a review of  multiple Alternatives or resource issues, click the Use Short Form check 
box.  This option allows you to select multiple Alternatives and/or issues, and then apply the 
same comment to the selected Alternatives or issues. 

 Click the Alternative arrow to select an Alternative from the list. 

 

 Click the Select an Issue arrow and then select the Expected resource issues check box 
for the issues you are reviewing.  
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 Click Begin Review. 

 

 

 To perform a review for an individual issue, do the following: 

 Click the Alternative arrow and then select the Alternative name. 

 Click the Select an Issue arrow and then select the Expected resource issues check box 
for the issue you are reviewing. 

 Click Begin Review. 

 

3. If there are Preliminary Environmental Discussion (PED) comments that have been entered by the 

District, they will appear in the Preliminary Environmental Discussion section.  

Note: The PED provides the District’s initial evaluation of a project’s potential effects (direct, 

indirect, and cumulative, as appropriate) and how the District intends to address or evaluate these 
issues as the project advances. PEDs, which may be provided at both the project and Alternative 
levels, provide the ETAT with context and may help ETAT reviewers provide focused and 
actionable comments. 
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4. Under Project Effects, click the Select a Degree of Effect arrow and then click the appropriate value. 

 

5. Under the Direct Effects and Indirect Effects sections, type your responses in the text boxes provided 

below the screen prompts.  

Tip!  Click the more info link to display the definition.  
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Note: Include as much detail as possible in your comments. See the ETDM Manual for additional 

guidance. 

Tip!  A red asterisk, , indicates a required field. 

6. In the Future Coordination and Documentation section, click the option button beside the future 

coordination or documentation required for the project, and then type any supporting comments in the 

text box. 

 

7. After completing your review, scroll to the Sign and Submit section to enter your Password and then 

click Save Review(s) to submit your information. 

Note: A Reminder notice is shown above your User Identity, informing you that comments that 

were not captured in your project effects review can be submitted using the Comment on 
Advance Notification Package tool. 
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8. View the confirmation page to review your comments.  Use the links  provided to update your comments 

or to perform other actions. 

 

 

Tip! To view your and other agencies’ cumulative effects comments during a review period, open 

the Project Effects report. To view the report, go to the Reports menu, click Project Effects, and 
then click Agency Comments – Project Effects. 

 

 Cumulative Effects Considerations Review (New 10/30/2012) 3.1.6.4

Project review occurs through the web-based Environmental Screening Tool (EST), which is used to 
engage agency participants in the transportation planning process. The EST provides information about 
projects and the surrounding environment. The Environmental Technical Advisory Team (ETAT) 
evaluates the potential direct and indirect effects of each project alternative, on natural, physical, cultural, 
and community resources within their jurisdictions. Optionally, the ETAT may provide considerations 
related to cumulative effects if there is an issue. If there is a concern about cumulative effects, provide 
considerations to help the Lead Agency decide on the level of evaluation needed in the environmental 
document. ETAT members are not expected to evaluate cumulative effects during the Planning and 
Programming Screens nor assign a Degree of Effect (DOE). See the FDOT Cumulative Effects 
Evaluation Handbook for guidance (available on the FDOT CEMO website).  
 

Tip!  For a complete list of issues your agency reviews, go to the Reports menu, click Agency 

Participation, and then click Agencies and Associated Resource Issues. 

 

Notes:  

 Projects beginning a review period after October 15, 2012, use the Project Effects and 
Cumulative Effects Considerations Review forms. Prior to this, comments related to indirect and 
cumulative effects were combined in one section. Comments submitted during screening events 
beginning after that date show separate comments for direct, indirect, and cumulative effects. 
Reports showing results of earlier screening events combine the comments related to indirect and 
cumulative effects. 

 After October 15, 2012, DOEs are associated with Project Effects (apply to both direct and indirect 
effects). There is no cumulative effect DOE. 

 Consistent with 40 CFR 1508.8, the ETDM process defines Cumulative Effects as: “the impact on 
the environment which results from the incremental impact of the action when added to other past, 
present, and reasonably foreseeable future actions regardless of what agency (federal or non-
federal) or person undertakes such other actions. Cumulative impacts can result from individually 
minor but collectively significant actions taking place over a period of time.”   

1. To access the Cumulative Effects Considerations Review form in the EST, go to the Tools menu, 

click Review Project, and then click Cumulative Effects Considerations Review. 
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The Cumulative Effects Considerations Review page opens. 

 

2. On the Cumulative Effects Considerations Review page, under Cumulative Effects 

Considerations, do the following: 

 Click the Alternative arrow to select an alternative from the list. 

 Click the Select an Issue arrow and then click the issue you are reviewing.  

 Click Begin Review. 

 

The Cumulative Effects Considerations screen refreshes and displays a list of questions. 
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3. Type your comments in the text boxes that appear below the questions listed on the screen. 

Note: Click the Change Options button to select another Alternative and/or Issue. Repeat the 
steps listed in this section for entering and submitting your comments. 

 

4. After completing your review, scroll to the Sign and Submit section to enter your Password and then 

click Save Review(s) to submit your information. 

 

The screen refreshes and displays the confirmation page.   
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5. To make changes to existing comments or add comments, click the Update comments or comment on 

additional issues link, and then repeat the steps listed above. 

 

 Federal Consistency Finding (Updated 02/23/2009) 3.1.6.5

The Federal Consistency Findings tool is used to record and submit agency findings concerning a project’s 
consistency with the Florida Coastal Management Program. The submittal of a Federal Consistency finding 
applies only to projects that are federally funded or require a federal permit or federal action.  

This tool is available to Federal Consistency Reviewers who are not also ETAT members and may also be used 
by Federal Consistency - Commenting Interested Parties for recording and submission of comments.  

Federal Consistency Reviewers who are also ETAT members submit their agency’s federal consistency finding 
using the Purpose & Need Statement tool, located in the Review Project category in the Tools menu.   

To access the Federal Consistency Findings tool, first select the desired project, and then go to the Tools 
menu, point to Review Project, and then click Federal Consistency Finding, as shown in the next illustration.  
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Note:  Federal Consistency Reviewers can also access this tool by clicking the project number in the Projects 
Needing Federal Consistency Review report, which will open a separate tabbed window that contains the 
form; and users with both Federal Consistency Reviewer and ETAT Reviewer roles can access the tool through 
the Purpose & Need Review form on the Projects Needing Review report. 

The Submit Federal Consistency Finding page opens. At the top of the form is the project header, with 
information that identifies the selected project.  This information includes the ETDM number and project name, 
the FDOT District(s) and county (or counties) where the project is located, the ETDM phase, from and to 
locations, the associated Planning Organization and Plan ID number, the Financial Management number, and 
contact information.  

 

The project header is followed by the form used to record the Federal Consistency Finding.  There are three 
possible findings: 

 Consistent 

 Consistent, With Comments 

 Inconsistent 

The definition for each finding appears next to the option, as shown in the next illustration. 
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Click on the option button next to the applicable finding to select that option.  Note that if “Inconsistent” is 
selected, you must cite (in the Comments textbox) the section of the relevant statute, under your agency's 
authority, with which the project is inconsistent, and you must identify actions that can be taken to resolve the 
conflict.  Prior to issuing a finding of inconsistency, the reviewing agency should immediately notify the State 
Clearinghouse of identified problems. 

Use the Comments textbox to type in required information and/or additional comments.  Plain text without 
formatting can also be copied and pasted from another document.   

When finished, verify the identity information, enter your password, and then click  . 

Submit Federal Consistency Finding Header Tools 

The toolbar above the project header provides quick access to commonly used functions. Use the  button 

to provide feedback about the page to the ETDM Help desk.  Click  to access the On-line Help 

information for the Submit Federal Consistency Finding page. Use the  button to bookmark the generated 

Submit Federal Consistency Finding page, or click  to add it to your “My ETDM” pages.   

Accessing Tool Through Projects Needing Federal Consistency Review Report 

As noted above, Federal Consistency Reviewers may also access the Federal Consistency Finding tool 
through the Projects Needing Federal Consistency Review report. To access the report, go to the Reports 
menu, point to Agency Participation, and then click Projects Needing Federal Consistency Review.  
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The Projects Needing Federal Consistency Review report contains the list of active projects that are 
currently in a review period that require Federal Consistency Review.  To narrow the search results, select 
County and/or Organization search criteria. 

 

Click on the ETDM Number of a project to open, in separate tabbed windows, the Submit Federal Consistency 
Finding tool and the reports to be used in conducting the Federal Consistency Review, as described below.  
Note: all reports are project-specific; by default, the information displayed in each window pertains to the project 
number selected from the Projects Needing Federal Consistency Review report by default. 

 Submit Federal Consistency Finding – used to record and submit comments on federal consistency. 

 Federal Consistency Findings report – displays the findings for a project (searchable by agency, project(s), 
and date range). 

 Project Description - gives a detailed overview of a project, from the summary description and Purpose and 
Need Statement to the segment level details.  

 GIS Analysis Results - displays the most recent results of the GIS Analysis routines for a project. 

 Map Viewer – zooms to the project location and provides access to various resource maps 
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There is a Tab title for each tool and report. Click on the Tab title to navigate between the tools and reports.  

 

On the right side of the screen, there is a Show/Hide Map bar.  This bar toggles the display of the Interactive 
Map Viewer.  To view the interactive Map Viewer over the tools and reports, click the Show/Hide Map bar; to 
hide the map and return to the forms and reports view, click the bar again.  (Note that tips for using the 
Interactive Map Viewer are available by clicking “Help” on the upper left side of the map, and a detailed 
description of the Interactive Map Viewer is available in the EST Handbook in the ETDM Library.) 

To close the tools and reports, click on the blue “X”  at the top right-hand side of each page (above the 
Page Tool Bar).  This takes you back to the Projects Needing Federal Consistency Review Report. 

 Review Class of Action (Updated 10/30/2012) 3.1.6.6

After the ETDM Coordinator submits the Class of Action (COA) determination, the Lead Agency is sent an email 
stating the COA is ready for their review. The Lead Agency uses the Review Class of Action Determination 
form to accept (or not accept) the ETDM Coordinator’s COA determination. 

1. Open the Class of Action page in the EST using one of the following actions: 

 Click the link provided in the email notification. 

 In the Tools menu, go to Review Project, and then click Class of Action Determination. 

 

2. In the Review Class of Action Determination screen, go to the Accept the Class of Action 

Determination section, and then click the option button beside Accepted or Not Accepted.  

Note: If you select Not Accepted, you must type your reason for not accepting the COA in the 

Comments text box. 
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3. Under Sign and Submit, type your Password, and then click Submit. 

 

A Signature Submission notice appears. Verify your comments and acceptance are correct and 
then click OK. 

 
 

 Summarize and Publish Eliminated Alternatives Report (Updated 05/09/2013) 3.1.6.7

Once one or more Alternatives has been eliminated, the Publish Eliminated Alternatives Form becomes 
available, which allows ETDM Coordinators to generate the milestone and produce an Eliminated 
Alternatives Report. ETDM Coordinators use the Environmental Screening Tool (EST) to summarize the 
elimination of project Alternatives and publish the Eliminated Alternatives Report, which includes 
Alternatives that have been eliminated along with Alternatives that have been re-activated at some point 
during the project life cycle. 
 
The Summarize and Publish Eliminated Alternatives Report feature in the EST allows you to do the 
following: 
 

 Publish an Eliminated Alternatives Report 
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 View Hard Copy Maps  

 Re-Generate Hard Copy Maps 

 Upload User-Generated Hard Copy Maps 

 Re-Activate a Previously Eliminated Alternative 

 Edit Justification Comments 

3.1.6.7.1 Publishing an Eliminated Alternatives Report 

Eliminated Alternatives are listed in the Summarize and Publish Eliminated Alternatives Report, which 
contains the Alternative descriptions, geometry, and hard copy maps. An eliminated Alternative’s status 
may also be changed using the editing feature. 

 Make changes to an Alternative’s status (i.e., re-enable) or to the justification comments. 

 Attach hard copy maps that have been system generated or have been created outside the EST. 

 View the report PDF before printing it. 

1. Select a project from the Active Project list. 

2. In the Tools menu, click Review Project, click Eliminated Alternatives. 

 

The Summarize and Publish Eliminated Alternatives Report page opens. 
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3. Check the hard copy map status in the Data Currency Notice section. A message displays if all hard 

copy maps are up to date, if there is a map generating request, or there are new data updates available 

and maps will need to be re-generated.   

 

4. Under the This form allows you to heading, click the listed below link to review the list of Alternatives 

that have been marked as Eliminated or Re-Activated. 

 

 Alternatives that have been marked as Eliminated.  
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 Previously eliminated Alternatives will be listed in the Re-Activated Alternatives section. 

 

5. Click the edit icon, , beside the Alternative name to perform the following actions: 

 Re-activate an Alternative that was previously eliminated.  

 Make edits to comments related to an Alternative. 

6. To select the location maps to be included in the report, click one of the following Location Map option 

buttons: 

 System Generated – hard copy maps generated within the EST system 

 User Upload – maps generated outside the EST system 

7. Click the Browse button to navigate to the desired file on your system. 

8. Click Upload. 

 

9. In the Publication Comments text box, type any information that is pertinent to the publication. 
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Note: The Publication Comments text box is a required field. You will not be able to publish the 
report if the box is left blank. 

10. Click Publish. 

 

11. A message appears. Under Would you like to continue?, click OK.  

 

The Summarize and Publish Eliminated Alternatives Report page refreshes and displays a 
confirmation message along with links to the Project Description Report and the Project 
Milestone Report. 

 

12. To return to the previous page, click the Back To Form link. 

3.1.6.7.2 Viewing Hard Copy Maps  
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Thumbnails of maps that have been generated in the EST are shown in the following illustrations for each 
Alternative name.   

1. In the Summarize and Publish Eliminated Alternatives Report page, scroll to an Alternative name.  

2. Next to Location Map, do one of the following: 

 To view maps that have been generated in the EST, click the System Generated button. Thumbnails 

of the available maps will be shown. 

 

 To view maps that were generated outside the EST, click the User Upload button. A PDF or 
JPG icon will display along with a document attachment tool. 
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Tip! Click the map image or PDF icon to enlarge the map size. 

3.1.6.7.3 Re-Generating Hard Copy Maps 

The Data Currency Notice section alerts you to the availability of the most up-to-date maps. If new data 
has become available since the last hard copy map production, the message will alert you to the updates. 
You can then generate the maps containing the latest information.  

 

Note: The Eliminated Alternatives report will not be generated until the hard copy maps have been 
generated. If you are uploading maps from outside the EST, you can ignore the message. 

1. Open the Summarize and Publish Eliminated Alternatives Report page.  

2. Under the Data Currency Notice, click the re-generate hardcopy maps link. 

  

The  Print Hard Copy Maps page opens.  

 

3. In the Print Hard Copy Map page, click the Include Eliminated Alternative(s) check box. 

 

4. Click Go. 

Notes:  

 The estimated time for generating a full set of hard copy maps is approximately two hours.   

 Eliminated Alternative reports are published each night at 8 p.m. and will be available the 
following day.  It is recommended that you generate the hard copy maps by 5 p.m. if you want to 
include them in the report.  
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 You may need to wait an additional day if your project has numerous hard copy maps that need 
to be generated or updated.   

 If you need help with publishing an Eliminated Alternatives report, contact the ETDM Help Desk 
at help@fla-etat.org or call 850-414-5334.  

3.1.6.7.4 Uploading User-Generated Hard Copy Maps 

Maps that have been generated outside the EST can be uploaded and attached to the Eliminated Alternatives 
report.  

Note: Maps must be in PDF or JPG format before being uploaded. 

1. In the Summarize and Publish Eliminated Alternatives Report page, scroll to an Alternative name.  

2. Next to Location Map, do the following: 

 Click the User Upload button.  

 Click the Browse button and then navigate to and click the document name. 

 Click Upload. 

 

A PDF or JPG icon displays.  

Note: The Upload a user Hardcopy Map… message changes to Replace above user 
Hardcopy Map…, enabling you to browse and upload a map to replace the current version. 

 

3.1.6.7.5 Re-Activating a Previously Eliminated Alternative 

You can use the Summarize and Publish Eliminated Alternatives report to change an eliminated Alternative’s 
status. 

1. Select a project from the Active Project list. 
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2. In the Tools menu, click Review Project, click Eliminated Alternatives. 

 

The Summarize and Publish Eliminated Alternatives Report page opens. 

 

3. In the Summarize and Publish Eliminated Alternatives Report page, scroll to an Alternative name.  

4. Click the edit icon, , beside the Alternative name and do the following: 

 Under Status, click the appropriate option button. 

 In the Justification text box, type your comments supporting the selected Status option. 

 Click Update. 
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The re-activated Alternative is listed under the Re-Activated Alternatives (Previously 
Eliminated) heading, with the status information displayed below the Alternative name. 

 

3.1.6.7.6 Editing Justification Comments 

You can edit the justification comments related to an eliminated Alternative.  The comments will appear in the 
re-published Summary report after you publish the Eliminated Alternatives report.  

1. In the Summarize and Publish Eliminated Alternatives Report page, scroll to an Alternative name.  

2. Click the edit icon, , beside the Alternative name and do the following: 

 Under Status, leave the Keep in “Eliminated” Status button as selected. 

 In the Justification text box, make any changes to the comments. 

 Click Update. 
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The Summarize and Publish Eliminated Alternatives Report page refreshes and displays a 
confirmation message. 

 

Tip! To return to the previous page, click the Back To Form link. 

 

 Summarize Results of ETAT Review Screen (Updated 09/24/2014) 3.1.6.8

Following the screening event, the ETDM Coordinator, Community Liaison Coordinators, PD&E Project 
Managers, and other Metropolitan Planning Organizations and/or Transportation Planning Organizations 
(MPOs/TPOs), or District staff, assesses ETAT commentary in order to assign Summary Degrees of Effect 
(SDOEs) and prepare the summary report.  

The SDOE represents the position of FDOT (or the MPO/TPO for projects occurring within MPO/TPO areas) 
and is based on known information about the project area, including ETAT member and public comments and 
other technical resources. 

ETDM Coordinators use this tool to assign SDOEs to all issues and alternatives based on ETAT Degrees of 
Effects (DOEs) and comments received from the ETAT or other stakeholders.  

Tip!   See the ETDM Manual for additional guidance on the process for summarizing DOEs.  You can access 

the ETDM Manual at http://www.dot.state.fl.us/emo/pubs/etdm/etdmmanual.shtm . 

The information in this section will guide you in performing the following actions: 

 Accessing the Summarize Results of ETAT Review page 

 Using the Summarize Results Chart 

http://www.dot.state.fl.us/emo/pubs/etdm/etdmmanual.shtm
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 Reviewing Agency Comments and DOEs 

 Assigning an SDOE 

 Editing a Summary Review 

 Revising an SDOE 

 Providing Feedback to Agencies 

 Publishing/Re-publishing a Summary Report 

3.1.6.8.1 Accessing the Summarize Results of ETAT Review Page 

 

1. On the project navigation bar located at the top of the EST window, click the Active project arrow and 

then make your selection by clicking on the project name and ETDM number. 

 

2. On the Tools menu, point to Review Project, and then click Summary Reports. 

 

The Summarize Results of ETAT Review screen opens and displays the Summarize Results chart.  

Tip!   Click the toolbar icon on the window to: 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

3.1.6.8.2 Using the Summarize Results Chart 

The Summarize Results chart displays the project alternative and SDOEs for resource issues that have been 
organized by category.  Each row of the chart represents a project alternative, and each column on the right-
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hand side represents a resource issue organized into the following categories: Social and Economic, Cultural, 
Natural, and Physical.   

 

The intersection of a project row and issue column is a cell that represents the SDOE for a particular project and 
issue.  For example, under Physical, the resource issue—Air Quality—has been given an SDOE of Minimal 
(color-coded green and labeled number 2). 

 

Note: The Summarize Results chart for projects that went through a screening after October 2012 will no 
longer show the issue Secondary and Cumulative Effects. ETAT Comments on cumulative effects 
considerations will appear as part of the agency review comments.  

As shown on the legend, a number and color code are used for project effects guidance. (Further details are 
provided in the Potential Project Effects Degree of Effect Guidance tables that are in chapters 3 and 4 of the 
ETDM Manual.)  

 

To aid you with assigning an SDOE, certain cells may have been automatically filled in with a tentative SDOE.  
Additional cell colors designed for assisting you in the process are defined as follows: 
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DOE number appears in cyan text to indicate all ETAT reviewers have 
assigned the same DOE to an issue. 
 

 

 

Multiple ETAT reviewers have assigned different DOEs to an issue. An 
SDOE is required before the summary report can be published. 

 
No agency reviews have been submitted for this issue.  An SDOE is 
required before publishing the summary report.  
 
Note: See the ETDM Manual for guidance on addressing resource 
issues that have not been reviewed.  
 

3.1.6.8.3 Reviewing Agency Comments and DOE 

 

1. In the Summarize Results of ETAT Review window, click the DOE cell for the resource issue you want 

to review. For this illustration, a Moderate effect (yellow) cell ( ) was selected for the resource 

issue—Aesthetic Effects. 

 

2. The Summarize Agency Reviews page opens and displays the agency reviews for the selected 

resource issue. 
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If cumulative effects considerations have been reviewed by agencies, they will be included under 
the Cumulative Effects Considerations for… Agency Comments header. 

 

Tip! To hide the agency review details, click the minus sign  located next to the agency name .  

3.1.6.8.4 Assigning a Summary Degree of Effect 

After reviewing agency comments, you can select the SDOE and enter your comments in the Summary 
Degree of Effect section.  
 

1. Click the Summary Degree of Effect arrow. 
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The field expands and displays the DOE list. 

 

2. Click the Degree of Effect to select it.  

3. In the Comments field, type an explanation for making the DOE selection.   

 

Note: Your information will not be saved until the form has been signed and submitted.   

4. In the Summary of Cumulative Effects Evaluation Considerations text box, enter your responses to 

the agency’s comments. 
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5. To sign and submit the form, do the following: 

 Under Sign and Submit, type your Password.  The Update Summary button becomes active. 

 Click Update Summary. 

 

Your SDOE selection and comments will automatically display.   

Note:  Before publishing the project, the ETDM Coordinator must ensure all of the Resource Issues 

are assigned a Degree of Effect (i.e., no black-filled cells ). 

3.1.6.8.5 Editing a Summary Review 

 
After clicking the Update Summary button, the screen displays the SDOE and comments that were 
entered on the form.  To make changes to the summary review, do the following: 
 

1. Click the edit summary review link for the section you want to edit (Summary Degree of Effect Comments 

or Summary of Cumulative Evaluation Considerations). 
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2. Type your changes in the comments box. 

3. Enter your Password. 

4. Click Update Summary. 

The page freshes and displays the revised comments. 

3.1.6.8.6 Revising an SDOE 

 
To change the SDOE, do the following: 
 

1. Follow the steps listed in the Assigning a Summary Degree of Effect section. 

2. Click the refresh chart link (Summary Degree of Effect or Summary of Cumulative Evaluation 

Considerations). 

 

The Summarize Results chart refreshes and displays the updated SDOE for the selected issue. 

3.1.6.8.7 Providing Feedback to Agencies 

After reviewing an agency’s DOE recommendation and comments, you can send a request to the agency 
for additional information or provide a response to the agency’s findings.  
 

1. Click the add coordinator feedback link. 
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The Respond to Agency Reviews page displays.   

 

2. Under Respond to Agency Review, type your comments in the Enter Agency Response Below text 

box.  

  

3. After you enter your response, click Add. 

 

The window refreshes and displays your response.  

4. To make edits to your response, do the following: 

 Click Edit Response. 
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 After you have made your edits, click Update.  

 

Tip!  Click Delete to completely erase your comments. 

5. When you have finished entering your response, return to the Summarize Agency Reviews page. 

 

The EST displays your comments and the date your feedback was submitted on the Summarize 
Agency Reviews window under Agency Reviews for the…..Issue. 

Note: You will need to refresh your browser to view your comments. 

 

6. To delete or make changes to your comments, click edit coordinator feedback. 
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The EST returns you to the Respond to Agency Review window, where you can change your 
response using the previous steps for adding, editing, or deleting comments. 

3.1.6.8.8 Publishing/Re-Publishing a Summary Report 

After all resource issues have been assigned an SDOE, the SDOE chart will no longer display any black or gray 
cells.  The Publish button becomes active. 

Note:  If the report is being re-published, the Re-Publish button will display. 

 

1. Click Publish or Re-Publish.  

 

The screen refreshes and displays Publication Instructions.  

Note: Clicking the Publish button will make the screening event results available to the public.  If 
you have questions pertaining to the summary results, click the Cancel button to return to the 
Summarize Results of ETAT Review Screen.  
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Tip!   Click the toolbar icon on the window to: 

   Open the training video. 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

2. If you are ready to make the report available, click Publish. 

 

A confirmation message displays, along with a link to the published summary report. 

 

 

 Track State Clearinghouse Projects (Updated 07/31/2009) 3.1.6.9

The Track State Clearinghouse Projects function in the Environmental Screening Tool (EST) Tools menu 
enables the State Clearinghouse Coordinator to track a project's Federal Consistency Review and to select a 
final Federal Consistency Determination.   

Before selecting a Federal Consistency Determination, the State Clearinghouse Coordinator can view the 
comments and recommendations made by Florida Coastal Management Program (FCMP) member agencies 
regarding a project's consistency with FCMP statute authorities.   
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Tracking State Clearinghouse Projects: 

1. To track State Clearinghouse projects, you must first select a project that has a published Advance 

Notification (AN) Package. You can use the default project that appears in the Active project field in the 

Project Navigation Bar or you can select another project using the Project Selection Wizard. 

Tip!  To search for projects with a published Advance Notification Package, click the Advanced 

Project Search link in the Project Navigation Bar.  In the ETDM Filter field, select Published 
Advanced Notification Package Available, and then type the dates in the AN Publication Date 
Range fields. 

 
 

Note:  See Navigation chapter of the EST Handbook for information on using the Project 
Navigation Bar. 

 

 

2. On the Tools menu, point to Review Project, and then click Track State Clearinghouse Projects. 
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The Track Clearinghouse Projects window opens, displaying the form for the selected project 
along with a page toolbar. The next illustration shows the Project Header (for this example, ETDM 
project #2807 is shown) and the top segment of the form. 

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 of the 
EST Handbook. 

3. Click the drop-down arrow  in the Select a Screening Event to Track field to view the screening 

events available for the selected project.  
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Note:  The EST displays the most recent screening event as the default.  If you select another 

screening event from the list, the Track Clearinghouse Projects window will refresh and display 
the form that corresponds with the selected Screening Event. 

The Program Information section consists of a form that displays: 

 Project  information (See Steps 4 through 6 for subsection details) 

 Agency review findings and comments (See Steps 7 and 8 for subsection details) 

 The State Clearinghouse's Federal Consistency Determination (See Step 8 for subsection details) 

 Project Close Information (See Step 9 for subsection details) 

4. For project information related to the screening event selected in the Select a Screening Event to 

Track field, scroll down the Program Information section to view the following subsections: 

 Category  

This subsection displays the proposed Federal action. 

 

 CFDA Number  

This subsection displays the project's Catalog of Federal Domestic Assistance (CFDA) 
Number along with the Department name, Agency name, and program title. (To select or add 
another CFDA Number, see Step 5 of this document.) 

Note:  Because the Track Clearinghouse Projects function is part of the EST, the Department will 
always be the Department of Transportation. 

 

 

 Project Description 

This subsection displays a brief description of the project.  

 

 Review Type 

This subsection displays the type of review the project is undergoing.  

 

 Routing/Consistency 

This subsection displays the routing history of the Federal Consistency Review for the 
selected project.  You can add extension and revision dates along with comments.  (To add 
extension and revision dates and comments, see Step 6 of this document.) 

Note: These fields are only for internal tracking by the State Clearinghouse and are not 

derived from any actual extensions granted to an agency in the ETDM database. 
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 Applicant Information 

This subsection displays the name of the Planning Organization (Applicant), the Name of the 
Planning Organization's contact person, address, phone number, and contact email. 

 

 Type 

This subsection displays the type of Agency. 

 

 

 Funding 

This subsection displays the funding source and amounts for each segment of the project. 

 

 

5. In the CFDA Number subsection, do one of the following: 
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 If the CFDA Number is listed, click the drop-down arrow  in the CFDA Number field, and then 
select the appropriate value from the list. 

 

 To add a CFDA Number that is not already listed, click the drop-down arrow  in the CFDA 
Number field, and then select Other. 

.  

The CFDA Number subsection expands, displaying active fields for adding information. 

 

 Do the following: 

 In the Number field, type the CFDA Number. 

 In the Department field, type the name of the Department. 

 In the Agency field, type the name of the Agency. 

 In the Title field, type the name of the program title. 

6. In the Routing/Consistency subsection, enter dates regarding requested Federal Consistency Review 

extensions and revisions along with any additional comments. 
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 Do the following: 

 In the Extension Requested date field, type the date of the request for extension. 

 In the Revision Due 1 date field, type the due date of the first revision. 

 In the Revision Due 2 date field, type the due date of the second revision. 

Tip!  When typing dates, use the mm/dd/yyyy format. You can also click the calendar icon  

and select the dates. 

 In the Consistency Notes text box, type any comments regarding a requested extension and 
revisions. 

 

7. For information regarding agency Federal consistency findings and AN reviews, scroll down the 

Program Information section to view the following subsections: 

 Federal Consistency Findings 

This subsection displays the review date and findings by FCMP member agencies, regional 
planning councils, and local governments tasked to perform a Federal Consistency Review 
for the selected project.  Agency details, concerns, and recommendations are displayed in 
the next subsection—Advance Notification/Federal Consistency Comments.   

 

 Advance Notification/Federal Consistency Comments 

This subsection displays tables showing comments related to the AN/Federal Consistency 
Reviews conducted by FCMP member agencies, regional planning councils, and local 
governments.  Each agency provides comments on the merits of the proposed project, 
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addresses concerns, and makes recommendations. Agencies who have not yet provided 
their reviews are listed in the bottom half of the subsection, as shown in the next illustration. 

 

 

8. After reviewing the agency findings and comments regarding the project's Federal Consistency status, go 

to the Federal Consistency Determination subsection, and then select the Federal Consistency 

Determination that concurs with agency comments and findings.   

 Do the following: 

 In the Finding column, click the option button next to one of the following:  

 Consistent  

 Consistent With Comments  

 Inconsistent  

 In the Comments text box, type any comments related to your Finding selection. 

Tip!  To ensure you are selecting the correct option in the Finding column, read the 

definition that applies to each option in the Definition column. 
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9. In the Project Close Information subsection, select the final consistency status by doing the following: 

 

 Select an option button for Consistency Status to indicate one of the following:  

 Concur 

 Object 

 Select an option button for Project Affected? to indicate one of the following: 

 Comments 

 No Comments 

 

10. In the Identity subsection, click the drop-down arrow , and then select your name and agency email 

address from the list. 

 

11. Click the Save button at the bottom of the Track Clearinghouse Projects window to save your 

information. 

 

 

The EST displays a message in the top of the Track Clearinghouse Projects window, stating that 
the information has been saved. 
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 Participating/Cooperating Agency Invitation (04/15/2013) 3.1.6.10

After approval of recommended agencies to serve in a Participating or Cooperating capacity, the Lead Agency 
sends the invitations via email notification. Notification recipients have 30 days to accept or decline the invitation 
using the Participating/Cooperating Agency Invitation form in the EST.   

1. To open the Invitation Response form, do one of the following: 

 In the invitation email, click the Participating/Cooperating Invitations link to open the 
Participating/Cooperating Invitation page.  

 

 On the Tools menu, point to Review Project, and click Respond to Participating/Cooperating 
Invitation. 

 

2. In the Participating/Cooperating Agency Invitation page, scroll to the Invitation Response section 

and then click the option button beside your selected response. Response options will appear based on 

the following: 

 If an invited agency has been invited to be a Cooperating Agency, the following options will 
appear (as shown in the next screen illustration): 

 Accept as cooperating agency 

 Accept as participating agency 

 Decline 

  If the agency was invited to be a Participating Agency, the following options will appear: 

 Accept as a participating agency 

 Decline 
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3. In the Comments text box, type your reason for accepting or declining the invitation. 

 

4. In the Sign and Submit section, type your Password, and then click the Submit Response button. 

 

The Respond to Participating/Cooperating Agency Invitation page refreshes and displays a 
confirmation of the agency’s response to the invitation. 
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 Notes: 

 If a Lead Agency has decided not to invite an agency, the ETAT agency receives the following 
statement on the Respond to Participating/Cooperating Agency Invitation page: Your 
organization has not been invited to serve as a participating or cooperating agency. 

 The Lead Agency may withdraw an invitation after it has been sent and even after it has been 
accepted. If an invitation is withdrawn, the invitee will receive a notice that it has been withdrawn. 

 If the invitation has been accepted and not withdrawn, the accepting agency should appear in the 
Class of Action as a participating or cooperating agency. 

 

 Manage Participating/Cooperating Invitations (New 04/15/2013) 3.1.6.11

Lead Agencies use the Manage Participating/Cooperating Agencies Invitations tool to accept or reject 
recommendations sent by the ETDM Coordinator, send invitations, and track ETAT agency invitation 
responses.  

1. Select a project from the Active Project list. 

2. In the Tools menu, click Review Project, and then click Manage Participating / Cooperating 

Invitations. 

 

The Participating/Cooperating Agencies page opens. 

3. The ETDM Coordinator’s recommendations appear under the appropriate Participating or Cooperating 

Agencies section. 
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Tip!   Click the toolbar icon on the window to: 

  Export the page to a PDF file. 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

Note: The information provided at the top of the Participating and Cooperating Agency Roles 
section includes the required timeline to send invitations along with the amount of time since the 
recommendations were sent. 
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4. Click the corresponding Respond button shown on the agency row. 

Note: A red asterisk ( ) indicates an action is required. 

 

 

5. In the Respond to Recommendation dialog box, do one of the following: 

 To accept a recommendation and invite the agency, type your reason for inviting the agency in 
the text box, and then click OK.  

 

 To reject a recommendation, click the Do not invite this agency option button, type your reason 
for not inviting the agency, and then click OK. 
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Tip!  To add an agency to the invitation list, click the Invite an Agency list box arrow, click 

the agency name, and then click Add. 

6. Click Send Invitations.  

 

Note: The Send Invitations button only becomes enabled after each recommendation has a 

response. 

7. In the Confirm Send dialog box, click Send Invitations. 

 

An email is sent to the individual agencies inviting them to be involved with the environmental 
review process.     
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 Note:  For the recommended or requesting agencies not receiving invitations, a notification email 

is sent that contains the Lead Agency’s response and reason for declining the agency’s 
involvement.  

In addition to the email invitations to the recommended/requesting agencies, an email notification is 
also sent to the District, listing the invited and not invited agencies. Agencies are listed according to 
their involvement category. 

 

 

3.1.6.11.1 Reviewing Invitation Responses 
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After sending invitations to the agencies, the Lead Agency can view the list in the Participating and 
Cooperating Agencies page.  

1. Select a project from the Active Project list. 

2. In the Tools menu, click Review Project, and then click Manage Participating / Cooperating 

Invitations. 

 

The Participating/Cooperating Agencies page opens, displaying sections for Participating 
Agencies and Cooperating Agencies. Each section displays a list of agencies and their invitation 
status. The Action column displays Withdraw buttons for agencies that have been sent invitations, 
and ETAT agency invitation responses will appear in the Responses column, as shown in the next 
illustration. 

 

 Note: If the declined agency had requested to be a participating or cooperating agency, then a 
courtesy email is sent indicating they were not invited and why. If the agency made no request, but 
was recommended by the District, no email is sent to the agency. 

3.1.6.11.2 Withdrawing an Invitation 

After an invitation has been sent to an ETAT agency, a Lead Agency can withdraw the agency from the list of 
invited agencies. This includes agencies that have accepted the invitation or have not responded to the 
invitation.  

1. Select a project from the Active Project list. 

2. In the Tools menu, click Review Project, and then click Manage Participating / Cooperating 

Invitations. 
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The Participating/Cooperating Agencies page displays the Withdraw button under the following 
conditions: 

 The Withdraw button displays only after an invitation has been sent.  

 The Withdraw button does not appear on the screen if an agency has declined an invitation. 

 

3. In the Participating/Cooperating Agencies page, select the agency, and then click the corresponding 

Withdraw button.  

 

4. In the Confirm Invitation Withdrawal box, type the reason for withdrawing the agency invitation, and 

then click OK. 
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An email is sent to the agency, notifying them the invitation has been withdrawn, along with a 
reason for the withdrawal. The withdrawal is also noted in the Action column of the agency 
invitation list. 

 

After the ETDM Coordinator submits the Class of Action (COA) determination, the Lead Agency is 
sent an email stating the COA is ready for their review. The Lead Agency uses the Review Class 
of Action Determination form to accept (or not accept) the ETDM Coordinator’s COA 
determination.  

Tip! See the Review Class of Action section of this handbook for navigation information. 

 ACE Documents Review (Updated 10/30/2014) 3.1.6.12

If a project has been identified as an Alternative Corridor Evaluation (ACE) project, the project team develops 
and documents the analysis methodology they will use to either replace the reviewed study area with more 
refined corridor alternatives or eliminate the already refined corridor alternatives in order to avoid and minimize 
potential impacts. The methodology memorandum (MM) provides guidance on how to integrate local land-use 
plans, public involvement and Environmental Technical Advisory Team (ETAT) member commentary, and 
Planning phase analyses. It also highlights specific data, tools (e.g., Land Suitability Mapping and Corridor 
Analysis Tool), and timelines to govern corridor refinements.  

The project team documents the application of the MM in the Alternative Corridor Evaluation Report (ACER). 
The ACER is a stand-alone document that provides support material and justification for replacing a study area 
with more refined corridor alternatives or for eliminating already existing corridor alternatives. A completed draft 
of the ACER is uploaded to the Environmental Screening Tool (EST) as a project attachment.  

ETAT members and Lead Agencies use the EST to review MMs and ACERs and to indicate if they 
understood/approved or not understood/not approved the information presented in the documents.  
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Tip! For additional information about the ACE process, see the ETDM Manual at 

http://www.dot.state.fl.us/emo/pubs/etdm/etdmmanual.shtm 

3.1.6.12.1 Accessing the ACE Documents Review Page 

1. Open the ACE Documents Review page by doing one of the following: 

 In the email notification, click the EST link located at the bottom of the message. 

 

 Use the EST menu by doing the following: 

 Select a project from the Active Project list. 

 On the EST Tools menu, click Review Project and then click ACE Documents. 

 

The ACE Documents Review page displays the form for submitting the review for the MM or 
ACER. 

3.1.6.12.2 Submitting an MM Review 

The next screen illustration displays the screen for the ETAT review of the MM, which shows the options for 
indicating Understood or Not Understood.  

http://www.dot.state.fl.us/emo/pubs/etdm/etdmmanual.shtm
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The next screen illustration displays the screen for the Lead Agency review of the MM. 

 

1. Under Review Methodology, click the links listed under Document (PDF) to review the information.   

2. After reviewing the attached document(s), go to the Acknowledge section and indicate whether the MM 

is Understood/Accepted or Not Understood/Not Accepted. 

Note: If you select Not Understood or Not Accepted, you must enter your comments supporting 
your selection. 

3. In the Comments section, type any comments you have regarding the MM. 

4. Under Sign and Submit, do one of the following: 

 If your response is not final and you plan to return to the form at a later time, click Save as draft. 

 If your response is final, click Save as final. 

5. Type your Password. 

6. Click Submit Review. 
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3.1.6.12.3 Submitting a Review of a Draft Version of the ACER 

The next screen illustration displays the screen if an ACE document is the draft version of the ACER. 
 

 
 

1. Under Draft ACER Review, click the filename link shown under Document (PDF).  

2. In the Enter Comments section, type any comments you have regarding the Draft ACER. 

3. Under Sign and Submit, do one of the following: 

 If your response is not final and you plan to return to the form at a later time, click Save as draft. 

 If your response is final, click Save as final. 

4. Type your Password. 

5. Click Submit Review. 

 

 Review Alternative Elimination (Updated 04/14/2013) 3.1.6.13

The Lead Agency uses the Environmental Screening Tool (EST) to review a District’s proposed Alternative 
elimination and issue an acceptance/non-acceptance. 

1. Open the Alternative Elimination Review page by doing one of the following: 

 In the email notification, click the EST link located at the bottom of the message. 

 Use the EST menu by doing the following: 

 Select a project from the Active Project list. 

 In the EST Tools menu, click Review Project, click Alternative Elimination. 
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The Review Alternative Elimination page displays the form for submitting your review. 

 

 

2. Under Request for Alternative number, do the following: 

 Review the Coordinator Comments. 

 Click the Document PDF link to open a document to review details pertaining to the Alternative 
elimination. 

3. In the Acknowledge section, click one of the following option buttons: 

 Accepted – The District can eliminate the Alternative. 

 Not Accepted – The District must not eliminate the Alternative. 

 Cannot be determined at this time. More information is needed. – The District must provide 
additional details before a decision can be made. 
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Note: If you selected Not Accepted or Cannot be determined at this time, an asterisk , , 

appears beside Comments, indicating you must type a reason supporting the selection in the 
text box.  

 

4. Under Final, do one of the following: 

 If your response is not final and you plan to return to the form at a later time, click Save the 
review as a draft. 

 If your response is final, click Save the review as final. 

 

5. Type your Password. 

 

6. Click Submit Review. 

3.1.7 Community Coordination (Updated 09/04/2008) 

 Community-Desired Features 3.1.7.1

MPOs and Community Liaison Coordinators can add community boundaries and information to describe the 
communities by using the Edit Community tool. In the Tools menu, point to Community Coordination, and 
then click Community Characteristics. 
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The Edit Community page opens, displaying a search filter at the top of the page.  

 

 

 
If there is a default project selected, the tool will open up with the community information that is closest to the 
project. If there is not a default project selected, the form will be blank. To locate your community, select the 

District and then click on the  button in the district row. This will load all of the counties in the 

selected district. After you have selected the correct county, click on the  button in the county row. 
The ‘Community’ drop down list will is now populated with all communities that are in the district and county you 

selected. Once you have found the correct community, click the  button to populate the form 
with the selected community data. 
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After you have updated the community, click the  button at the top or bottom of the form to save the 
changes to the database. 

 

Note:  An asterisk (*) next to a form field indicates the data in these fields were provided by a user and have 

not been updated by the automatic data analysis routine. If you believe that the data in brackets is more up to 
date than the user defined data, and would like to replace the current user-defined value with the calculated 

analysis results, check the box next to that field and click the  button. Edit any of the calculated 

results by typing in the appropriate box. Click the  button when you are finished editing the form. 

 

 Summarize/Modify Public Comments (Updated 12/30/2013) 3.1.7.2

The Summarize/Modify Public Comments form in the EST Tools menu enables you to document public 
comments collected during outreach activities. 

Summarizing and Modifying Public Comments:  

1. In the Tools menu, click Community Coordination, and then click Public Comments. 
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The Summarize/Modify Public Comments page opens and displays a form for indicating whether 
public comments are available for the selected project. 

 

 

Tip!  Click the plus sign, , to expand the project information header. 

 

2. Do one of the following: 

 If you are documenting public comments, click the There are Public Comments available 
button. 

 If no public comments are yet available, click the There are no Public Comments available at 
this time button.  

3. Type the comments, or make changes to the comments, in the text box. 

Note: The comments field is a required field.  Comments must be entered even when there are no 
public comments. 

4. Click Submit Form. 
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Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

3.1.8 Coordinate ETAT (Updated 11/07/2014) 

 Send Email to User Groups 3.1.8.1

Use the Send Email to User Groups tool to correspond with other EST users.  Go to the Tools menu, point to 
Coordinate ETAT, and then click Email User Groups.   

 

 

The tool opens an address book with two columns.  The left-hand column lists the project user roles in each 
FDOT district, displayed in the right-hand column.  To select the email recipient, click the empty checkboxes 
beside the project user role(s) and their district(s).  (Click the checkbox again to unselect).  After selecting email 
recipient(s), click "Select Addresses" to open the Email form (the Email Process Page). 
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On the Email Process Page (example shown below), enter the email subject and comments in the appropriate 
fields.  Manually type in comments or copy and paste from an external document.  To copy from a separate 
document, select the text, right-click on the highlighted text and choose "Copy" from the pop-up menu.  To paste 
the text into the form, right-click in the appropriate summary box on the form and choose "Paste" from the pop-
up menu. (The keyboard shortcuts CTRL-C to copy and CTRL-V to paste also work.  Select source text, CTRL-
C; click target area, CTRL-V.)  To clear subject and comment without closing the email form, click "Clear Form."  
To send the email, click "Send Email."  To change email recipient(s), click "Select New."  The form will close and 
the window will return to the previous address book to allow selection of new recipients.  Note that comments 
entered in the form will be cleared when "Select New" is clicked.    
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 Track ETAT Notifications (New 11/30/2011) 3.1.8.2

The Track ETAT Notifications function in the Environmental Screening Tool (EST) Tools menu enables 
District ETDM Coordinators, Community Liaison Coordinators, and the State Clearinghouse to track 
notifications sent to Environmental Technical Advisory Team (ETAT) members and includes a list of the 
individuals who were sent the notifications.  The Track ETAT Notifications function also enables users to 
forward the notice to additional people on their notification lists.  

Using Track ETAT Notifications: 

1. Select a project from the Project Navigation Bar.  

2. On the Tools menu, point to Coordinate ETAT, and then click Review ETAT Notifications. 

 

 

The Track ETAT Notifications window opens as a tabbed page, displaying the notifications sent to 
ETAT recipients for the selected project. There can be multiple notifications, with each notification 
containing a list of recipients and a Forward button. 

Tip!  Click the minus sign, , to collapse a notification section.  Click the plus sign, , to expand a 

section.  
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Tip!   Click the toolbar icon on the window to: 

 Print a copy of the page. 

  Export the page to a PDF file. 

  Send feedback about the current page. 

  Access online Help for the current page. 

  Bookmark the page. 

  Add the page to your My ETDM preferences. 

Below each Notice section is a Recipients section, listing the individuals who have received the ETAT 
notification. This section displays the number of recipients who were sent the ETAT review notification for 
the project, along with the recipients' Name, Organization name and E-mail address link. 

 

 

3. To forward the list of recipients, click the  button located beneath the selected list. 

 Extend ETAT Review Period (New 11/30/2011) 3.1.8.3

The Extend ETAT Review Period function in the Tools menu enables ETDM Coordinators to grant a 15-day 
extension for projects that are currently in ETAT Review.   

Extending an ETAT Review Period: 

1. Select a project from Project Navigation Bar.  

2. Go to the Tools menu, point to Coordinate ETAT, and then click Extend ETAT Review Period. 
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The Extend ETAT Review Period page opens, displaying a section listing the ETAT review 
participants along with a comment text box for listing a justification for the extension.  

 

3. In the Who Requested This Extension field, click the name(s) of the individual(s) requesting an 

extension. 

Tip!  Press Ctrl + click to select multiple non-adjacent names from the list. Click Shift + click to 

select multiple adjacent names from the list. 

 

4. In the Comments Justifying the Extension** text box, you must enter a reason for granting an 

extension for the selected reviewers.  You can type or cut and paste your comment(s) into the text box. 

5. Click Submit Form. 
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The Extend ETAT Review Period page refreshes and displays a confirmation message stating the 
extension has been granted along with the new review end date, and the list of reviewers and the 
justification is also shown. 

 

 Allow Comments After Review Period (New 11/30/2011) 3.1.8.4

The Allow Comments After Review Period function in the EST Tools menu enables ETDM Coordinators to 
allow agencies to submit late reviews after a review period has ended. Comments collected while the user is in 
the overdue role are stored as draft comments until the extension period is over.  

Allowing Comments After Review Period: 

1. Select the project from the Project Navigation Bar. 

2. Go to the Tools menu, point to Coordinate ETAT, and then click Allow Comments After Review 

Period. 
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The Allow Comments After Review Period page opens, displaying a Select Users To Comment 
After Review Period section with a Search for Users filter. The Search for Users filter is a drill-
down feature that displays options based on previous selections. 

 

3. Under Search for Users, do the following: 

 Click the District arrow, and then click the name of the selected District. 

 Click go.  The Organization field displays. 

 

 Click the Organization arrow, and then select the name of the selected Organization.   

 Click go.  The User field displays, showing the list of names for the selected organization.  
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 Click the name(s) of the individual(s) who are granted an extension. 

Tip!  Click Ctrl + click to select non-adjacent options.  Click Shift + click to select adjacent 

options. 

 

 Click Create Extensions. 

 

The Allow Comments After Review Period page refreshes and displays a Specify End Date 
section, listing the project Alternative(s) and fields for entering the extension begin and end 
dates.  

 

Note:  An extension must be set for each project Alternative and user combination.  
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 In the Extension Begin Date field, type the extension begin date or click the calendar icon, 
,and select the date. 

 In the Extension End Date field, type the extension end date or click the calendar icon, , and 
select the date. 

Tip!  Use the MM/DD/YYYY date format. 

 Click Submit Extension Information. 

 

The EST displays a confirmation message stating the extension for the selected individual(s) 
has been granted. 

 

 Dispute Resolution  3.1.8.5

When a project is flagged for a dispute during the Programming Screen, it does not move forward until the 
dispute is resolved. The purpose of this tool is to record events and actions associated with resolving the 
dispute.  Such events may be meetings, emails, teleconferences, and other correspondences.  The Track 
Dispute Resolution Activities tool opens a form that will be completed for a specific environmental resource 
issue.  To access the form, select the project from the list and then click on the “Track Dispute Resolution 
Activities” option found under the "Coordinate ETAT Activities" heading in the Tools menu (main menu).  Use 
the "Issue" pull-down menu to select the issue of dispute.  In the "Description of Action" entry, record the event 
and actions associated with resolving the dispute.  Click "Select a Date" and enter the date of the event from a 
pop-up calendar.  If applicable, attach a document to the event. A document may be meeting minutes, sign-in 
sheet, memoranda, and other supporting information. This is optional.  To attach a document, click "Browse" 
and add a document.  When a document is added, the Save As name is defaulted to the document's file name.  
Change the Save As name as necessary.  Use logical and recognizable file names.  For example, “Meeting 

Minutes.pdf” is better than “mm.pdf.”  The ETDM document standard is Adobe Acrobat PDF as the document 
format.  The tool can support other file formats, but please consider that users may not have the proper software 

to read the file correctly.  A document that is in Word Perfect may not be useful to MS Word users.  If it is 
necessary to attach a non-PDF file, state the file format in the File Description so that other users are aware of it. 
In File Description, include the document’s title, author, agency, date, status (preliminary, draft, final, etc.), 
purpose and applicable remarks.  Click "Submit" to commit the entry.  Please note that only one document can 
be attached at a time. To attach multiple documents, repeat the process. 
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 Manage ACE Review Events (Updated 11/07/2014) 3.1.8.6

If a project has been identified as an Alternative Corridor Evaluation (ACE) project, the project team develops 
and documents the analysis they will use to either replace the reviewed study area with more refined corridor 
alternatives or eliminate the already refined corridor alternatives in order to avoid and minimize potential 
impacts.  The ACE methodology memorandum (MM) provides guidance on how to integrate local land use 
plans, public involvement and ETAT member commentary, and Planning phase analyses. It also highlights 
specific data, tools (e.g., Land Suitability Mapping and Corridor Analysis Tool), and timelines to govern corridor 
refinements.  

The ETAT members have 30 days to indicate within the EST their understanding of, and to comment on, the 
MM. Their commentary may necessitate updates to the MM before it is sent to the Lead Agency for review and 
acceptance.  Once the Lead Agency accepts the MM, the ETDM Coordinator begins the process of applying 
the methodology to refine or eliminate corridor alternatives.  

The team documents the application of the MM in the Alternative Corridor Evaluation Report (ACER). The 
ACER is a stand-alone document that provides support material and justification for replacing a study area with 
more refined corridor alternatives or for eliminating already existing corridor alternatives. Upon completion of the 
Draft ACER, an email is sent to notify recipients that the document is available for review.  The review of the 
Draft ACER is optional.  After the Draft ACER has been reviewed, the ETDM District Coordinator uploads the 
Final ACER to the EST as an attachment.  The Final ACER becomes part of the summary report. 

Note:  The Final ACER and signed Class of Action must be completed before the Final Summary Report can 
be published.  

ETDM Coordinators use the Environmental Screening Tool (EST) to manage the MM and ACER review 
process, performing the following tasks. 

 Access the Manage ACE Review Events 

 Schedule an Event  

 Set up MM Reviews 

 Set up Draft ACER Reviews 
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 Manage In-progress Reviews 

 Extend Review Periods 

 Grant Extensions to Specific Agencies  

 Display and Respond to Comments 

 Cancel a Review Period 

 Export ACE Reviews 

 Upload Final ACER  

 

Tip! For additional information about the ACER process, see the ETDM Manual at 

http://www.dot.state.fl.us/emo/pubs/etdm/etdmmanual.shtm 

3.1.8.6.1 Accessing the Manage ACE Review Events Page 

After publishing the Preliminary Summary Report for the Planning and Programming Screens, you may initiate a 
review of the MM or the Draft ACER by following the steps listed below. 

1. Select a project from the Active Project list. 

2. On the EST Tools menu, click Coordinate ETAT, and then click Manage ACE Review Events. 

 

The Manage ACE Review Events page opens, displaying a form for scheduling an event, 
selecting the type of event, and for setting up the draft notification. 
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3.1.8.6.2 Scheduling an Event  

 

1. Under Schedule Event, type the Review Start Date and Duration (number of days).   

Tip! You can also select the review end date by clicking the calendar icon,  , and then clicking 

the date. The Duration field will automatically display the number of days. 

2. In the Specify Event Type section, do one of the following: 

 If this is an ETAT review, select ETAT members. 

 If this is a Lead Agency review, select Lead Agency. 

 If the notification is for a review of the ACER draft, Draft ACER will be shown as the default 
option. You will not need to take any action. 

3.1.8.6.3 Setting Up a Notification for Reviewing an ACE MM 

 

1. Open the Manage ACE Review Events page. The page displays the Create screen. 
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2. Under Draft Notification Email, do the following : 

 In the Email Body text box, type your contact information in the areas where [Insert] is shown. 

 Click Preview Email. 

3. Under Attach Methodology Memorandum Files, click the Browse button to locate and select the 

appropriate PDF document.  

 

4. Type your password and click Submit. 

5. A Review Event Confirmation box appears showing the scheduled review dates. Click OK. 

3.1.8.6.4 Setting Up a Notification for Reviewing a Draft ACER 

After completion of the MM review, the District Coordinator prepares a draft version of the ACER and sends it 
out for review through the EST.   

1. Open the Manage ACE Review Events page. 

2. Next to the Specify Event Type label is the default option Draft ACER. You do not need to take any 

action. 

 

An email template is shown, containing standard wording and fields for entering information about 
the review of the Draft ACER. 

Note: The Draft ACER review is optional.  This is noted in the wording on the email that will be sent 
to the recipients. 
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3. In the Email Body text box, type your contact information in the areas where [Insert] is shown. 

4. Click Preview Email to view the completed email as it will appear to the recipient. 

5. Under Draft ACER, click the Browse button to upload a PDF of the ACER draft. 

6. Under Save and Submit, click the Submit button. 

 

A dialog box appears requesting confirmation. 

 

7. Click OK. 

3.1.8.6.5 Managing In-progress Reviews 

After the MM Review and Draft ACER Review event notifications have been sent, you will be able to do the 
following: 

 View ACE MM documents. 

 View the ACER.  

 Review agency comments.  

 Extend or cancel a review period. 

 Grant an extension to individual agencies. 

 Export reviews to Excel or PDF. 
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1. Open the Manage ACE Review Events page. The Progress tabbed page will display. 

 

The Review Period box displays the review event and dates.   

 

2. Click the Review Period arrow to display the list and then click the appropriate selection.  

3. Click Select. 

Tip! To display the list of agencies who have submitted comments, click Show Comments. For 

navigation details on viewing comments and entering responses, see the Displaying and 
Responding to Comments section of these instructions.  For navigation steps on exporting  to MS 
Excel or to a PDF, see the Exporting ACE Reviews section of these instructions. 

3.1.8.6.6 Extending a Review Period 

 

1. Under Review Period, click Extend Review Period. 

 

The Grant Extension dialog box appears. 
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2. In the Grant Extension dialog box, do the following: 

 Type the number of days or select a date from the calendar icon . 

 Enter your reason for the extension in the Comments text box. 

 Click Submit. 

 

Recipients will receive an email notifying them of the extension. The email includes a link to the 
EST, as shown in the next illustration. 
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Note: Each time an action related to a review occurs (i.e., extensions, cancellations), recipients 
involved with the review event will receive an email with a link to the EST. 

3.1.8.6.7 Granting Extensions to Specific Agencies 

1. On the tabbed Progress page, click the Review Event arrow to select the review period you want to 

extend, and then click Select. 

2. Under Reviews, click the Grant Extension button located on the Agency’s row. 

 

 

3. In the Grant Extension to Name of Agency dialog box, do the following: 

 Type the number of days or click the calendar icon , to select a date. 

 Enter your reason for the extension in the Comments text box. 

 Click Submit. 

The Manage ACE Review Events/Progress page refreshes and displays the extension date for 
the selected agency. 
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3.1.8.6.8 Displaying and Responding to Comments 

The District can issue a response to ETAT comments or a Not Understood/Not Accepted acknowledgment by 
doing the following: 

1. On the tabbed Progress page, click the Show Comments button.   

 

The Reviews heading expands and displays any comments submitted by an agency. 

 

2. Click the Respond to Comments button. 

3. Type your response in the Comments text box and then click Submit. 

 

3.1.8.6.9 Cancelling a Review Period 

1. On the tabbed Progress page, click the Review Event arrow and then click on the event you want to 

cancel. 

2. Click Select. 
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3. Under Review Period, click Cancel Review. 

 

4. In the Cancel Review Event Confirmation box, do the following: 

 Enter your reason for cancelling the review in the Comments text box. 

 Click Submit. 

3.1.8.6.10 Exporting ACE Reviews 

You can export reviews to an Excel file or to a PDF document by doing the following: 
 

1. On the tabbed Progress page, click the relevant button: Export to MS Excel or Export to PDF. 

 

2. Follow the prompts for saving the file. 

3.1.8.6.11 Uploading the Final ACER  

After the review period for the Draft ACER has completed, you will then be able to upload the Final ACER 
to the EST.  
 
Note: Following the completed review of the Draft ACER, you will need to upload the Final ACER to the 
EST and re-publish the Summary Report. See the Summarize Results of ETAT Review Screen section of 
the EST User Handbook for instructions on re-publishing a summary report. 
 

1. Open the Manage ACE Review Events page. 
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The ACER form displays. 

2. Complete the required fields shown on the form. 

3. Click the Browse button to locate and upload the Final ACER. 

4. Click Upload. 

 

The Manage Ace Review Events page refreshes and displays a link to the uploaded ACER. 
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Tip!  To replace an uploaded document, click the  under Delete and then follow the steps 

listed above for uploading the Final ACER. 

 Update Alternative Elimination (Updated 04/15/2013) 3.1.8.7

The process for eliminating Alternatives begins with the ETDM Coordinator or Project Manager using the 
Update Project Status form in the Environmental Screening Tool (EST) to flag one or more Alternatives for 

elimination along with a justification for eliminating an Alternative. Projects that have Federal Involvement must 

have active Lead Agency concurrence at the time of the Alternative elimination. (This does not apply to study 
areas, which can be eliminated without Lead Agency approval.) The EST incorporates features for Lead Agency 
and District coordination during the Alternative Elimination Review process. 

Note: Although the EST treats study areas as a type of Alternative, they're not really viable project Alternatives. 
Study areas eventually become refined into one or more practicable project Alternatives, with more specific 
geometry, etc. 

 The following conditions must apply before beginning the Alternative Elimination Review process: 

 The project is listed as having Federal Involvement. 

 Only one potential Lead Agency has been selected to conduct the Alternative Elimination Review. 

 The project is in one of the following Project Status stages:  

 ETAT Review Complete  

 ACE MM Review (if it is an Alternative Corridor Evaluation [ACE] project) 

 ACE MM Review Complete (if it is an ACE project) 

 Dispute Resolution in Progress 

The following sections provide navigation steps for using the Update Alternative Elimination feature in the EST. 

 Starting the Eliminated Alternative Review Process 

 Cancelling an Eliminated Alternative Review 
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 Resubmitting an Alternative Elimination to the Lead Agency 

3.1.8.7.1 Starting the Eliminated Alternative Review Process 

1. Select a project from the Active Project list. 

2. In the EST Tools menu, click Project Diary, click Project Status. 

 

The Update Project Status page displays the project status form.   

 

3. In the Eliminated column, click the option button that corresponds to the Alternative you are eliminating.   

4. Under Eliminated Alternatives, type your comments supporting the elimination of the Alternative in the 

Justification text box. 

5. Click Update Status(es).  
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The page refreshes and displays a confirmation message that states the Alternative elimination 
must be approved by the Lead Agency and that an email notification has been sent to the agency. 

 

 

6. Open the Update Alternative Elimination page by doing one of the following: 

 Click the Proposed link that appears in the Eliminated column.  

 

 In the Tools menu, click Coordinate ETAT, click Update Alternative Elimination.  
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The Update Alternative Elimination page opens, displaying the status of the Lead Agency 
response. 

 

 

3.1.8.7.2 Cancelling an Alternative Elimination Review 

You can cancel an Alternative Elimination Review at any time before the Lead Agency accepts an Alternative 
elimination. 

Note: Once the Lead Agency submits an Accept acknowledgment the Alternative Elimination Review is 
complete, with the Alternative showing as Eliminated.  You will not be able to cancel a review after this point. 

1. Select a project from the Active Project list. 

2. In the EST Tools menu, click Coordinate ETAT, click Update Alternative Elimination. 
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The Update Alternative Elimination page displays the eliminated Alternative status.   

3. Under Edit, click the Restore to button. A Comments box appears 

 

4. Type your comments in the text box, including details supporting your justification for cancelling the 

Alternative elimination review. 

5. Click Submit Comments. 

 

The screen refreshes and displays the cancellation message under the respective Alternative 
heading. 
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3.1.8.7.3 Resubmitting an Alternative Elimination to the Lead Agency 

If the Lead Agency does not accept the Alternative elimination, or if the Lead Agency needs additional 
information before issuing an acceptance, a status statement appears on the screen.  You then have the option 
to restore and cancel the eliminated Alternative or resubmit the eliminated Alternative to the Lead Agency. 

1. Select a project from the Active Project list. 

2. In the EST Tools menu, click Coordinate ETAT, click Update Alternative Elimination. 

 

The Update Alternative Elimination page displays the eliminated Alternative status.   
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3. Under Edit, click the Resubmit to Lead Agency button. A Comments box appears. 

  

 

4. In the Response to Lead Comments text box, type your response.  

5. Click the Browse button to upload and attach supporting documentation. Documents must be in PDF 

format before being uploaded. 

6. Click Submit Comments. 
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3.1.9 Performance Management (Updated 06/30/2010) 

 Answer District ETDM Coordinator Survey (Updated 06/30/2010) 3.1.9.1

Biennially, District ETDM Coordinators complete a survey assessing the performance of participating agencies 
and the ETDM Process. ETDM Coordinators Primary provide a qualitative assessment of ETDM benefits; 
customer service; and the quality of information, coordination and communication. 

Completing the District ETDM Coordinator Survey: 

1. On the Tools menu, point to Performance Management, and then click District Coordinator Survey. 

 

The Answer District ETDM Coordinator Survey window opens, displaying the survey and page 
toolbar.  
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Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 of the 
EST Handbook. 

2. To view, print, or copy the blank survey in PDF format, click Show Blank Survey PDF. 
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The PDF of the blank survey opens as a tabbed page. 

 

 

3. Click the navigation icons in the left column of the Blank Survey window to view the contents of the 

District ETDM Coordinator Survey. 

 

Tip!  You can switch between the Blank Survey PDF and the Answer District ETDM 

Coordinator Survey window by clicking the tabs at the top of the page.  Click the dark-colored tab 
to display a window, as demonstrated below. 

 

 

Once the window opens, the tab turns white. 

 

 

The survey comprises 47 questions, with text boxes provided for additional comments.   
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4. In the Answer District ETDM Coordinator Survey window, respond to the survey questions by clicking 

the appropriate check boxes  and option buttons , and by typing your comments in the text 

boxes. 

Note:  You can select multiple responses in the sections that contain check boxes. However, you 
can only select one response in the sections with option buttons. 

5. For questions requesting you to select a ranking, click the option button,  , below the selected 

ranking: 

 Excellent 

 Very Good 

 Good 

 Fair 

 Poor  

 N/A  

 

Note:  If you click the Fair or Poor option button, please type a reason for your selection in the 
Comments text box. 

Type any additional comments in the Comments text box. 

 

6. Once you have completed and reviewed the survey, select one of the following options located at the 

bottom of the Answer District ETDM Coordinator Survey window: 

 Click Save Draft if you plan to make changes to the survey at a later time.  

 Click Finalize if you do not plan to make any changes. 
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Depending on your selection, a message appears stating you have either saved a draft or 
final version of the survey. The illustration below displays the message for a saved draft 
version. 

 

 

7. Click OK.  

 

 
The View Survey window opens as a tabbed page, displaying the completed survey and a page 
toolbar.  
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Tip!   Click the toolbar icon on the View Survey window to: 

 Print a copy of the completed survey. 

  Export the completed survey to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

Note:  For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 
of the EST Handbook. 

 Answer ETAT Survey (Updated 12/18/2009) 3.1.9.2

Biennially, ETAT members complete a survey to provide feedback on how the participating agencies view the 
management and administration of the ETDM Process, the quality of the working relationship between the 
agencies and FDOT, and recommended improvements or changes. 

Completing the ETAT Survey: 

1. On the Tools menu, point to Performance Management, and then click ETAT Survey. 
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The Answer ETAT Survey window opens as a tabbed page, displaying the survey and a page 
toolbar.  

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

2. To view, print, or copy the blank survey in PDF format, click Show Blank Survey PDF. 
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The PDF of the blank survey opens as a tabbed page. 

3. Click the navigation icons in the left column of the Blank Survey window to view the contents of the 

Answer ETAT Survey PDF. 

 

Tip!  You can switch between the Blank Survey PDF and the Answer ETAT Survey window by 

clicking the tabs at the top of the page.  Click the dark-colored tab to display a window, as 
demonstrated below. 

 

The survey comprises 43 questions, with text boxes provided for additional comments.   

4. In the Answer ETAT Survey window, respond to the survey questions by clicking the appropriate check 

boxes  and option buttons , and by typing your comments in the text boxes. 

Note:  You can select multiple responses in the sections that contain check boxes. However, you 
can only select one response in the sections with option buttons. 
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5. For questions requesting you to select a ranking, click the option button,  , below the ranking: 

 Excellent 

 Very Good 

 Good 

 Fair 

 Poor  

 N/A  

 

 

Note:  If you click the Fair or Poor option button, please type a reason for your selection in the 
Comments text box. 

Type any additional comments in the Comments text box. 

 

6. Once you have completed and reviewed the survey, select one of the following options located at the 

bottom of the Answer ETAT Survey window: 

 Click Save Draft if you plan to make changes to the survey at a later time.  

 Click Finalize if you do not plan to make any changes. 

 

Depending on your selection, a message appears stating you have either saved a draft or final 
version of the survey. The next illustration displays the message for a saved draft version. 

 

7. Click OK.  
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The View Survey window opens as a tabbed page, displaying the completed survey and a page 
toolbar.  

Tip!   Click the toolbar icon on the View Survey window to: 

 Print a copy of the completed survey. 

  Export the completed survey to a PDF file. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 of the 
EST Handbook. 

 Issues Tracking Tool (New 07/31/2009) 3.1.9.3

The Issues Tracking Tool function in the Environmental Screening Tool (EST) Tools menu enables 
Environmental Management Office (EMO) staff to record, assign, and track issues and concerns submitted by 
ETDM participants.  Only ETDM issues related to policy and procedure are addressed. 

After EMO personnel, Invoice Reviewers, or Invoice Administrators become aware of an issue, they forward the 
information to the Performance Management Coordinator.  The Performance Management Coordinator inputs 
the issue into the Issue Tracker and assigns it to a category.  The issue is then assigned to an EMO staff 
member who uses EST to notify the appropriate EMO personnel.  EMO personnel address assigned issues 
according to their program area and ETDM role. 

Issue resolutions are documented in the Issue Tracking Summary Report and the Issue Tracking Details Report 
and are reported in the semi-annual Agency Feedback Report.   

Using the Issue Tracking Tool: 

1. On the Tools menu, point to Performance Management, and then click Issue/Action Tracking. 
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The Issues Tracking Tool window opens as a tabbed page, displaying search filters and a page 
toolbar.  

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 of the 
EST Handbook. 

The Issues Tracking Tool window is divided into two sections—Issues Tracking Query and 
Issues--that enable you to search existing issues or enter a new issue. 

Note:  Before entering a new issue, it is recommended that you first conduct a search using the 
Issue Tracking Query to ensure the issue is not already in the EST.   

2. To search for an issue, complete one or more fields under Issues Tracking Query.  The fields are not 

required fields, so you have the option to enter as much information as you want into the search filter or 

you can leave all the fields blank.  

Note:  Leaving all the fields blank when you submit your query will result in the EST displaying all 
issues listed in the system. 

 

 

3. To narrow your search results, complete one or more of the following fields in the Issues Tracking 

Query search filter:  The EST then displays the issues matching your search criteria. 

 In the Issue ID field, type the identification number assigned to an issue. 

 In the Assignment ID field, type the assignment ID.  
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 In the Reporter field, click the drop-down arrow . The field expands, displaying a pre-populated 
list of people who have reported issues. Do one of the following: 

 Select your name from the list if you want to view or edit issues you have previously reported.  

 Select another name to view all of the issues reported by the selected person. 

 In the Assignee field, click the drop-down arrow , and then select the person assigned to take 
action on specific issues. 

Tip!  You can also select a name in the Reporter and Assignee fields by typing the first letter of 

the person's first name. Keep pressing the letter until the name you are seeking appears.  

 

 In the Category field, click the drop-down arrow , and then select the issue category.  

 

 In the Type field, click the drop-down arrow  and select the issue type. The Type field 
populates with options related to the category you selected in the Category field.  

 In the Status field, click the drop-down arrow , and then select the issue status.  

 

 In the Priority field, click the drop-down arrow , and then select the issue priority. 

 

 In the Resolution field, click the drop-down arrow , and then select the issue's resolution type.  
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 In the Submission Date Range fields, type the date range when an issue was originally 
submitted.  

 In the Due Date Range fields, type the date range for action item due dates associated with an 
issue. 

Tip!  When typing in dates, use the mm/dd/yyyy format. You can also click the calendar icon 

 and select the dates. 

 In the Keywords field, type any words related to your search query. 

4. Click Submit Query. 

 

 

5. In the Issues section, the Select an Existing Issue or create a new Issue field populates with the 

results based on your search criteria, as shown in the next illustration. 
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6. To search for an issue, click the drop-down arrow  in the Select an Existing Issue or create a new 

Issue field.  

 

The field expands and displays a list of issues matching the search criteria you entered in the 
Issues Tracking Query section. 

 Do the following: 

 If the issue you queried appears in the list, EST enables you to view and edit the issue 
information.  Go to Step 7 for directions on selecting, viewing, and editing an issue. 
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 If the issue you queried does not appear in the list of existing issues, do one of the following: 

 Under Issues Tracking Query, click Clear Query, and then enter the information related 
to the new issue (Repeat Steps 2 to 4). 

 

 Create an issue by clicking Create New. Go to Step 11 for directions on creating a new issue. 

 

7. Select an issue you want to view and edit. 
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8. Click Load and Edit. 

 

 

The Issues section refreshes and expands, displaying the issue's details under the following 
sections: 

 Issues  

 CC List and Agencies  

 Action Items  

9. Under Issues, edit the following fields, as needed.  

 Title 

 Category 

 Type 

 Description 

 Priority 

 Resolution 

 Reported by 

 Submission date 

10. To save your changes, click the Save button at the bottom of the screen (Go to Step 12). 

11. After clicking Create New, complete the following fields: 
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 Title 

 Category 

 Type 

 Description 

 Priority 

 Resolution 

 Reported by 

 Submission date 

12. Click Save. 

 

A message appears stating that the issue has been saved. 

13. Click OK. 

 

14. Under CC List and Agencies, you can add a person to an email notification list pertaining to a particular 

issue and add agencies to a notification list. The agencies that are added to the list will receive 

notifications pertaining to an issue, and the information will be documented in the semi-annual Agency 

Feedback Report.  

 To add a person to the CC List, do the following: 

 Click the drop-down arrow  in the Add to CC List field. 
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The field populates with a list of EMO staff members. 

 Click the name you want to add to the notification list. 

 

 Click Add to CC List. 

 

 

The selected name appears in the Name column of the CC List. 

 

Tip! To remove a name from the CC List, click  beside the name in the Name 

column. 

 To add an agency to the issue notification list, click the drop-down arrow  in the Agencies field, 
and do the following:  

 

 Click the agency you want to add to the notification list. 

 

 Click Add Agency. 
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The selected agency appears in the Name column of the Agencies field. 

 

Tip! To remove a name from the Agencies list, click the  beside the agency name in the  

Name column. 

 

15. Under Action Items, you can view, edit, update, or create issue action items.  

 

 

 Do one of the following: 

 To view, edit, or update the details of an existing issue action item, click the drop-down arrow 

in the Select an Existing Assignment or create a new one field, and select an assigned 
issue. Go to Step 16 for directions on viewing, editing, or updating the details of an existing 
issue action item. 
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 To create a new action item, click Create New. Go to Step 19 for directions on creating a new 
action item. 

 
 

 

16. After you have selected an existing issue from the list, click Load and Edit. 
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The Action Items section expands and displays the details of an issue assignment and a 
Comments section, allowing you to view, edit, and update the information.  

 

17. Edit and update the following fields, as necessary: 

 Assign To 

 Assignment Summary 

 Action Items 

 Due Date 

 Select an Existing Status 

18. To save your changes, click the Assign button at the bottom of the screen (see Step 20). 

19. After clicking Create New, complete the following fields: 

 Assign To 

 Assignment Summary 

 Action Items 

 Due Date 

 Select an Existing Status 
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20. Click Assign. 

 

 

A message appears, stating that the issue has been saved. 

21. Click OK. 

 

 

 

 

22. Under Comments, you can add a comment by typing your comment in the Add New Comment field, 

and then click Add Comment. 

 

 

23. To attach a document, click Attach Document. 
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The Issues Tracking: Attach Document window opens as a tabbed page. 

 

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

 

24. In the Upload File field, click the Browse button to navigate to and select files for uploading. 

 

 
In the Description field, type the document description. 
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25. In the Comment field, type any comments related to the document. 

26. Click Attach Document.  

 

 

Tip!  Click Back to Issue Tracking Tool to return to the Issue Tracking Tool window. 

 

Note:  Once you have made edits or created a new issue or action item, the changes or new 

issue will appear in the Issue Tracking Details Report, and the action item will appear in the 
assignee's Issue Tracking Inbox. 
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3.1.10 Agency Invoices (Updated 06/30/2010) 

Invoicing tools are available under the Agency Invoices function in the Tools menu.  These tools are used by 
the Invoice Administrator, Invoice Reviewers, Agency Invoice Submitters, and ETDM District Coordinators as 
part of the Agency On-line Invoicing System.  Depending on the user’s role, links to specific tools are provided.  
The menu options shown below are those available to Agency Invoice Submitters. 

 

 

 Reviewer Preference (New 05/15/2008) 3.1.10.1

The District ETDM Coordinator uses the District 
Reviewer Preference tool to identify agencies for 
which the District wishes to review invoices.  The 
tool presents the District ETDM Coordinator with 
a list of agencies that are members of that 
District’s ETAT, and allows the District ETDM 
Coordinator to select agencies for which the 
District wishes to review invoices.  

In the Tools menu, point to Agency Invoices, 
and then click Reviewer Preference. 
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The form opens and displays  the FDOT District associated with the District ETDM Coordinator (District 3 in the 
example), and displays a list of ETAT agencies associated with the FDOT District (Agencies not Reviewed) 
and a list of previously selected agencies (Agencies to be Reviewed), if any. 

 

 

To add an agency to the District Reviewer Preference list, the District ETDM Coordinator highlights the agency 
name, and then clicks Add. 
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The agency name will be displayed in the Agencies to be reviewed field, as shown in the next illustration. 

 

 

To remove an agency from the Preference List, the District ETDM Coordinator clicks on the name of the agency 
in the Agencies to be Reviewed field, and then clicks Remove. 

 Edit Expenses (Updated 06/27/2008) 3.1.10.2

The Agency Invoice Submitter uses the Edit Expenses tool to provide information needed to complete the 
schedules and summary sheet for an invoice.  In an Advance Pay this would be called current reporting dates 
and in a Reimbursable it is the invoicing period.   

In the Tools menu, point to Agency Invoices, and then click Edit Expenses.   
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The form that opens will be populated with information related to the user name used to log on to the EST.  The 
form accessed using the Edit Expenses tool is the same form provided on the Edit Expenses screen of the 
Prepare Invoice wizard.  In the example shown below, the user name for a Northwest Florida Water 
Management District Agency Invoice Submitter was used.  (The information shown is for example purposes 
only and does not reflect actual Northwest Florida Water Management District agreements or invoices.) 

 

The Agency Invoice Submitter selects an agreement from the Agreement pull-down menu.  If entering 
information about an unsubmitted invoice, the Agency Invoice Submitter selects an invoice from the Invoice 
pull-down menu, and then clicks the Load button.  The form will be populated with information related to the 
selected invoice.   

 

 

If entering information for a new invoice, the Agency Invoice submitter enters the 
Invoicing Period End date by either typing in the date (in mm/dd/yyyy format) or 

selecting the date from a calendar by clicking the  icon.   

The next portion of the Edit Expenses form is used to enter or edit personnel 
costs for the invoicing period.  The Agency Invoice Submitter clicks Add 
Personnel to begin completing or editing this part of the form. 
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If a previously saved draft invoice is being edited, the Agency Invoice Submitter clicks on the field that needs to 
be edited, and enters the new information.  When information is being added for a new invoice, the Agency 
Invoice Submitter clicks Add Personnel, a line is added to the form where the person’s name and job 
classification, number of hours worked during the invoicing period, average hourly rate, an additional overhead 
amount, or the overhead percentage are entered.   

 

 

As the Agency Invoice Submitter types each number, the Cost this Period is automatically calculated.  The 
Invoice Submitter clicks Add Personnel to add additional personnel.  Entries for personnel charges must have 
a unique identifier.   

 

If entering a person and job class more than once, each Name and Job Class entry must include a unique 
identifier (for example AAI for the first entry, AAIb for the second entry, and so forth).  The Agency Invoice 
Submitter should note that all fields must contain data, so if you add a line that is not going to be used, you must 
delete that line before finalizing and submitting the invoice.  To delete a line, the Agency Invoice Submitter clicks 
the Remove button next to the line.  The Agency Invoice Submitter also clicks the Remove button to delete 
personnel charges that were previously entered and are not to be included in the invoice (prior to finalizing and 
submitting the invoice). 

Once the Agency Invoice Submitter completes the Personnel Expense portion of the form, the Agency Invoice 
Submitter moves on to the Travel Expenses portion of the form.  The Travel Expenses portion of the form is 
used to enter or edit travel expenses for the invoicing period.  If editing previously entered Travel Expenses, the 
Agency Invoice Submitter clicks on the field that needs to be edited, and enters the new information.  If entering 
Travel Expenses for a new invoice, the Agency Invoice Submitter clicks the Add Expense button to begin. 
When the Agency Invoice Submitter clicks the Add Expense button, a line will be added to the form, as shown 
below, where a description of the travel expense and the amount are entered.  Note that an image of the receipt 
for each travel expense amount must be uploaded into the database (using the Upload Receipts tool) before 
an invoice can be finalized and submitted. Instructions for uploading a receipt are discussed in Section 3.1.7.9.   
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The Agency Invoice Submitter clicks the Add Expense button again to add additional travel expenses.  Note 
that entries in the travel expense Description field must be unique.  If an employee has more than one travel 
expense for the invoice period, each entry must include a unique identifier (for example, Smith 01-04-06, Smith 
02-01-06, and so forth).  The Agency Invoice Submitter should note that all fields must contain data, so if you 
add a line that is not going to be used, you must delete that line before finalizing and submitting the invoice.  To 
delete a line, the Agency Invoice Submitter clicks the Remove button next to the line.  The Agency Invoice 
Submitter also clicks the Remove button to delete expenses that were previously entered and are not to be 
included in the invoice (prior to finalizing and submitting the invoice). 

After the Agency Invoice Submitter completes the Travel Expense portion of the form, the Agency Invoice 
Submitter moves on to the Training Expenses portion of the form.  The Training Expenses portion of the form 
is used to enter or edit training expenses for the invoicing period.  If editing previously entered Training 
Expenses, the Agency Invoice Submitter clicks on the field that needs to be edited, and enters the new 
information.  If entering Training Expenses for a new invoice, the Agency Invoice Submitter clicks the Add 
Expense button to begin this portion of the form.  

 

 

When the Agency Invoice Submitter clicks the Add Expense button, a line will be added to the form, as shown 
in the next illustration, where a Description of the travel expense and the Amount are entered.   

 

 

Note that entries in the training expense Description field must be unique.  If an employee has more than one 
training expense for the invoice period, each entry must include a unique identifier (for example, Smith 01-04-
06, Smith 02-01-06, and so forth).  The Agency Invoice Submitter should note that all fields must contain data, 
so if you add a line that is not going to be used, you must delete that line before finalizing and submitting the 
invoice.  To delete a line, the Agency Invoice Submitter clicks the Remove button next to the line.  The Agency 
Invoice Submitter also clicks the Remove button to delete expenses that were previously entered and are not to 
be included in the invoice (prior to finalizing and submitting the invoice). 

The next portion of the Edit Expenses form is used to enter or edit other expenses for the invoicing period.  If 
editing previously entered Other Expenses, the Agency Invoice Submitter clicks on the field that needs to be 
edited, and enters the new information.  If entering Other Expenses for a new invoice, the Agency Invoice 
Submitter clicks the Add Expense button to begin this portion of the form.  When the Agency Invoice Submitter 
clicks the Add Expense button, a line will be added to the form, as shown here, where a description of the 
expense and the amount are entered.  The Agency Invoice Submitter should note that an image of the receipt 
for each expense amount must be uploaded into the database (using the Upload Receipts tool) before an 
invoice can be finalized and submitted.  The Agency Invoice Submitter clicks the Add Expense button again to 
add additional expenses.  Note that entries in the other expenses Description field must be unique.  If an 
employee has more than one Other Expense for the invoice period, each entry must include a unique identifier 
(for example, Smith 01-04-06-Supplies, Smith 02-01-06-Supplies, and so forth). 
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The Agency Invoice Submitter should note that all fields must contain data, so if you add a line that is not going 
to be used, you must delete that line before finalizing and submitting the invoice.  To delete a line, the Agency 
Invoice Submitter clicks the Remove button next to the line.  The Agency Invoice Submitter also clicks the 
Remove button to delete expenses that were previously entered and are not to be included in the invoice (prior 
to finalizing and submitting the invoice).  In the example shown, a description of the expense and amount would 
need to be entered before saving the draft invoice. 

The final portion of the Edit Expenses form displays the total cost for the invoice being prepared.  This total cost 
is automatically calculated based on the amounts entered for personnel, travel, training, and/or other expenses.  
A text box is also provided for adding additional notes.  The Agency Invoice Submitter clicks Save Draft.  (Note 
that the Agency Invoice Submitter can use the Save Draft button at any time when entering expenses.  This 
allows the Agency Invoice Submitter to return to the invoice at a later time without having to re-enter expense 
information.)  The draft invoice can be added to or changed at any point prior to submittal.  After the Agency 
Invoice Submitter saves the draft invoice, the Agency Invoice Submitter can submit the invoice by clicking 
Submit Draft Invoice for Review. However, it should be noted that the other invoice components (summary of 
agency activities and uploaded receipts) should be entered into the database before submitting the invoice.  
Section 3.1.7.7 describes how to summarize agency activities for the invoicing period. 

 

When the Invoice Submitter clicks the Submit Draft Invoice for Review button, the View/Submit Invoice 
screen opens.  This screen displays the Payment Tracking Report for the invoice.  The Payment Tracking 
Record includes a summary of the agreement information pertaining to the invoice, followed by the completed 
Schedule A-1 (Salary Costs), Schedule A-2 (Hours Assignments), Schedule E-1 (Reimbursable Direct 
Expense – Travel), Schedule E-2 (Reimbursable Direct Expense – Training), and Schedule  E-3 
(Reimbursable Direct Expense – Other) forms, reflecting the information entered using the Edit Expenses tool.  
The screen also includes the Agency Activity Report, which includes information entered using the 
Summarize Agency Activities tool and the Log Agency Activity tool (if applicable).  The Summarize 
Agency Activities tool and the Log Agency Activity tool are discussed in Sections 3.1.7.7 and 3.1.7.3, 
respectively.  The Invoice Submitter should note that the Agency Activity Report must be submitted prior to 
finalizing the draft invoice. 

If the draft invoice is complete, the Agency Invoice Submitter enters the appropriate password, and then clicks 
Submit Invoice. 
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 Log Agency Activity (Updated 06/27/2008) 3.1.10.3

The Log Agency Activity tool is used to provide 
details about agency activities that are not 
recorded in the EST.  These may include activities 
such as meetings, technical support of non-ETDM 
projects, and permit coordination.  The activities 
may be entered at any time by any of the agency 
ETAT representatives.  Each agency activity is 
logged individually.  The Agency Invoice 
Submitter also uses this tool to edit Activity Logs 
previously submitted via the EST. 

In the Tools menu, point to Agency Invoices, 
and then click Log Agency Activity. 

 

 

 
 
 
 
 
 
The form that opens comprises two sections:  The first section contains pull-down menus for selecting an 
agency and selecting and loading an existing Activity Log.  It also includes a button for clearing the form and 
creating a new Activity Log. 

 

 

The Agency Invoice Submitter selects an agency using the Agency pull-down menu.  The form will be 
populated with a list of Activity Logs using the EST. The Agency Invoice Submitter then selects an existing 
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Activity Log to be edited from the pull-down menu, or proceeds to the second portion of the form to add a new 
Activity Log.  

To edit an existing Agency Activity Log, the Agency Invoice Submitter selects the Activity Log from the pull-
down menu at the top of the form, then clicks the Load button.  The form will be populated with information for 
the selected Activity Log.  The Agency Invoice Submitter makes changes using the pull-down menus and 
textboxes, then clicks Save.  The Agency Invoice Submitter can then use the Clear/Create New button to clear 
the form and select and edit another existing Activity Log or create a new Activity Log. 

The Agency Invoice Submitter first enters the date of the activity by either typing in the date (in mm/dd/yyyy 
format) or selecting the date from a calendar.  To select the date from a calendar, the Agency Invoice Submitter 

clicks the  icon.   

The Agency Invoice Submitter then uses the pull-down menus to select Activity Type, Work Program Phase, 
FDOT Districts, and Counties. 

 

If the activity is related to an ETDM project, the Agency Invoice Submitter types the ETDM project number in the 
Project/ETDM # field.   

 

If the activity is not directly related to an ETDM project, click the ETDM button to toggle to Non ETDM.  

 

The EST displays the Non ETDM button.  Type the project name in the Project/Name field. 

 

In the FDOT FM Number field, type the FDOT Number. 
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In the ETAT Representative field, click the drop-down arrow  and select the ETAT Representative who 
performed the activity. 

Note: The list only displays active EST users within the agency. Click Include Disabled Users to include past 
users who are no longer active EST users in the agency. 

 

In the Hours field, enter the number of hours associated with the activity. 

 

Next, the Agency Invoice Submitter uses the Activity Description textbox to type in a brief text description of 
the activity being logged.  The Agency Invoice Submitter uses the Results or Anticipated Actions textbox to 
describe any actions taken by FDOT or the agency as a result of the activity or any actions anticipated. 

The Agency Invoice Submitter clicks the Save button to save the information entered.   

 

 

 Agency Activities: Batch Uploader (New 06/30/2010) 3.1.10.4

The Agency Activities: Batch Uploader function in 
the Environmental Screening Tool (EST) Tools 
menu displays a form that enables you to upload an 
Excel spreadsheet detailing agency activities that 
are not recorded in the EST. These may include 
activities such as meetings, technical support of non-
ETDM projects, and permit coordination. The 
activities may be entered at any time by any of the 
agency Environmental Technical Advisory Team 
(ETAT) representatives.  

You can enter multiple activities at one time, with the 
option to select and upload logged activities by date 
range. 

Using the Agency Activities Batch Uploader: 

1. On the Tools menu, point to Agency 

Invoices, and then click Upload Agency 
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Activity Spreadsheet. 

 

 

The Agency Activities: Batch Uploader window opens as a tabbed page, displaying a page toolbar, 
and a form for uploading the Agency Activity spreadsheet. 

   

 

Tip!   Click on the toolbar icons to: 

   Send feedback about the current page. 

   Access online Help. 

    Bookmark the page. 

   Add the page to your My ETDM preferences. 

For additional information about using the EST page toolbar buttons, refer to Chapter 2.8 of the 
EST Handbook. 

2. Click the batch upload spreadsheet link to download a blank Excel spreadsheet from the EST 

database.  

Tip!   You can also download the spreadsheet from the ETDM Library. 
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3. A File Download dialog box appears asking you to Open or Save the spreadsheet. Click Save to 

download the spreadsheet to your computer. 

 

4. Navigate to and click the saved file to open it. The spreadsheet opens as a separate Microsoft Excel 

window.  

5. Check the Validation list on the Agency Activities: Batch Uploader window before logging the 

activities into the spreadsheet.  The data must be correct and follow the format criteria detailed in the list. 

 

Note:  The data must be in the first sheet of the Excel file. The first row of the spreadsheet must 

contain the column headings as they appear (see next illustration).  These headings cannot be 
changed or deleted. 

 

6. After you have logged the information into the spreadsheet and saved the file on your computer, click the 

Browse button next to the Upload File field to navigate to and upload the spreadsheet. 
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7. Do the following: 

 In the Agency field, click the drop-down arrow, , and select the agency you are logging the 
activities for. 

 In the Filter Start Date and Filter End Date fields, type the date range to select the activities to be 
uploaded. 

Tip!  Type the date using the mm/dd/yyyy format.  You can also click the calendar icon, , and 

select a date. Only activities that occurred between the filter Start and End dates will be imported; 
you must leave one or both of these fields blank if you would rather import all events instead of 
filtering them.  

8. Click Upload Document for Batch Processing. 

 

 

The Agency Activities: Batch Uploader window refreshes and displays the activities that have 
been imported into the database. 



 

 

 

 Environmental Screening Tool Handbook - February 15, 2016 3-305 

 

Note:  If there is incorrect data or if data has been logged incorrectly, the EST will display a 

validation error message, along with the errors, and a View Excel button to access a read-only 
view of the entire spreadsheet. The next illustration displays the Agency Activities Batch 
Uploader window with an error message. 
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 Manage Master Agreement/Contract (Updated 06/27/2008) 3.1.10.5

When a new agreement between FDOT and a participating agency is executed, the Invoice Administrator logs 
onto the EST and enters basic setup information into the database to describe the agreement.  This information 
is then used on the forms and reports associated with the invoice package.  In addition, if any changes are 
made to an existing agreement, the Invoice Administrator updates the database prior to the next invoicing cycle. 

In the Tools menu, point to Agency Invoices, and then click Master Agreement/Contract.   
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The form that opens has two main functions: Add/Remove Reviewers and Add/Edit Agreement.   
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The Add/Remove Reviewers function is used to add or remove EST users who are responsible for reviewing 
draft invoices and submitting comments to the Invoice Administrator.   

 
To add a reviewer, type the user’s name (or portion of the name) in the text box under “Find a User to Add.”  
The user’s name and log-in identification will be extracted from the database and displayed, as shown in the 
next illustration.   

Click on the user name/log-in identification, and then click   .  The user will be added to the list of 
“Primary Reviewers.”  Click “Save” to add this change to the database.  To remove a reviewer, click on the 
reviewer’s name under “Primary Reviewers,” then click “Remove Selected.”  When finished, click “Save.” 

To add an agreement or contract to the database, scroll down to the Add/Edit Master Agreement portion of the 
form.  First, type in your agency name (or a portion of the name) in the “Organization” text box under 
“Agreement Loading.”  In the example shown below, “FL Department of State” was typed in.  If there are 
existing agreements for your agency in the database, they will be listed in the “Existing Agreements” pull-down 
menu.  Check this list to confirm that the agreement or contract you want to enter is not already in the database. 
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If the agreement to be entered is not listed, use the “Initial Agreement Creation” portion of the screen to enter 
information about the new agreement.  First, type in the agreement or contract number, then select “agreement 
number” or “contract number” from the pull-down menu.  Then select the Primary Invoice Submitter and 
Remittance Contact person for the agreement/contract from the pull-down menus.  Type in the contract limits for 
salary, training, travel, and other expenses, or  check the  “Only use a Single Limit” check box and enter the 
single limit total..  If advance payments are authorized by the agreement, click the Allow Advance Pay Requests 
check box. 

 

To add the dates for Notice to Proceed, End of Service, Agency Operating 
Agreement Renewal, Funding Agreement Renewal, and Master Agreement 

Renewal, either enter the dates in dd/mm/yyyy format or click on the  icon to 
select the date from a calendar.  When finished, click the “Save” button at the 
bottom of the form.  The information will be added to the database.  Any of the 
information can be revised (prior to clicking “Save”) by typing over the existing 
information or selecting different dates.  Click the “Clear Form” button to remove all 
the information entered. 
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To edit information for an agreement or contract already stored in the database, type in the organization name, 

select the agreement from the “Existing Agreements” pull-down menu, then click the  button.  The 
information pertaining to the selected agreement will appear in the form, as shown below.  Make changes by 
typing in the text boxes, or change the dates by typing in the new dates (in dd/mm/yyyy format) or by clicking on 

the  icon and selecting the new date from a calendar.  Add an explanation of the changes made by typing in 
the “Change notes” text box, or you can copy and paste information for this field from an existing document.   

 

When finished, click the “Save” button at the bottom of the form.  The revised information will be added to the 
database.  The “Clear Form” button can be used to remove all the information at any time prior to clicking 
“Save.”  
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 Prepare Advance Pay Request (Updated 06/27/2008) 3.1.10.6

Agencies that are authorized by their ETDM Agency Funding Agreement to receive advance payments can 
request those payments using the EST. The Agency Invoice Submitters within these agencies submit requests 
via the EST using the Prepare Advance Pay Request tool. 

To use the Prepare Advance Pay Request tool, the Agency Invoice Submitter goes to the Tools menu, points to 
Agency Invoices, and then clicks Advance Pay Request.   

  

The form that opens is divided into four sections: Select an Organization, Master Agreement, and Invoice; 
Prepare Advance Pay Request; Compensation Elements; and Final Notes and Submitting.  The form will 
be populated with information related to the user name used to log on to the EST, and by default will display 
information for the last invoice viewed by that user.  In the example shown below, the user name for a 
Northwest Florida Water Management District Agency Invoice Submitter was used.  (The information shown is 
for example purposes only and does not reflect actual Northwest Florida Water Management District 
agreements or invoices.) 
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The Agency Invoice Submitter begins by either loading the invoice highlighted in the 
Invoices pull-down menu, or selecting another invoice.  To select a different invoice, 
first select an agreement using the Existing Agreements pull-down menu.  If the 
Agency Invoice Submitter is requesting an advance payment for an unsubmitted 
invoice, the Agency Invoice Submitter selects the invoice from the Unsubmitted 
Invoices pull-down menu, then clicks the Load button.  The form will be populated 
with information related to the selected invoice.  If the Advance Pay Request is 
associated with a new invoice, the Agency Invoice Submitter enters the Invoicing 
Period End date by either typing in the date (in mm/dd/yyyy format) or selects the 

date from a calendar by clicking the  icon, then clicks Create New Invoice.   

 

 

The Advance Payment Request form that opens is automatically populated with information about the 
agreement.  The Agency Invoice Submitter reviews the information shown in the Prepare Advance Pay 
Request portion of the form, and then proceeds to enter the compensation elements for the Advance Pay 
Request.  

 

The Agency Invoice Submitter enters the amounts for compensation elements (labor and expenses being 
requested), and other notes, if desired.  The Agency Invoice Submitter presses the tab key after entering the 
labor and expenses amounts, and clicks Save when finished. 
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 Summarize Agency Activities (Updated 06/27/2008) 3.1.10.7

The Summarize Agency Activities tool is used by the Agency Invoice Submitter to enter information about 
agency activities for an invoicing period.  It is also used to edit information previously entered.  In the Tools 
menu, point to Agency Invoices, and then click Summarize Agency Activities.   
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The form that opens will be populated with information related to the user name used to log on to the EST, and 
by default will display information for the last invoice viewed by that user.  In the example shown below, the user 
name for a Northwest Florida Water Management District Agency Invoice Submitter was used.  The information 
that is shown is for example purposes only and does not reflect actual Northwest Florida Water Management 
District agreements or invoices. 
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Begin by either loading the invoice highlighted in the Invoices pull-down menu, or 
selecting another invoice.  To select a different invoice, first select an agreement 
from the Existing Agreements pull-down menu.  Then select an invoice from the 
“Load an unsubmitted invoice” pull-down menu, and click the Load button.  The 
form will be populated with information related to the selected invoice.  If entering 
information for a new invoice, enter the Invoicing Period End date by either typing in 
the date (in mm/dd/yyyy format) or selecting the date from a calendar by clicking 

the  icon.  The new invoice number and ending date will be added to the 
Invoices pull-down menu.  Select it, and then click the Load button. 

The next portion of the form is used to enter or edit narrative about agency activities 
during the invoicing period, with separate sections for accomplishments made 
during the period, a summary of ETDM screening activities, and anticipated 
accomplishments for the next period, as shown in the example.  Use the textboxes to enter a brief description of 
activities for each category, or edit the descriptions previously entered.  Note that agencies authorized to receive 
Advance Payments can set a Reporting Period end date that is different from the Invoicing Period end date, by 
entering the date or using the calendar feature described above.  The example shown below includes this 
option.   

The first section is used to enter or edit information about accomplishments made during the invoicing (or 
reporting) period. 
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Following are guidelines for the information for each category under Accomplishments Made During Period: 

 Administrative or Supervision Tasks – discuss management and/or supervision tasks performed during the 
period 

 Coordination – discuss non-field interagency and FDOT coordination 

 Performance Measures – discuss how the agency has performed on the Performance Measures outlined in 
the Agreement 

 Problems Encountered/Suggestions for Improvement – provide information on any problems discovered or 
anticipated, and any proposed improvements that would facilitate the streamlining effort of the ETDM 
Process 

Under Summary of ETDM Screening Activities, use the textboxes to describe any problems encountered using 
the EST and to add or edit any other comments. 

 
Under the Anticipated Accomplishments for Next Period, enter a brief description of anticipated activities for the 
next reporting period, and the number of anticipated hours and number of persons performing the anticipated 
activities.  When finished, click the “Save Draft” button on the left side of the screen. 

 
A message will be displayed, confirming that the invoice has been saved. 

After the draft invoice has been saved, it can be submitted for review by 
clicking the Submit Draft Invoice for Review button. 

Clicking the Submit Draft Invoice for Review button opens the View/Submit 
Invoice screen, which will display the Payment Tracking Report for the 
invoice.  The Payment Tracking Record includes a summary of the 
agreement information pertaining to the invoice, followed by the completed 
Schedule A-1 (Salary Costs), Schedule A-2 (Hours Assignment), Schedule E-1 (Reimbursable Direct Expense 
– Travel), Schedule  E-2 (Reimbursable Direct Expense – Training), and Schedule  E-3 (Reimbursable Direct 
Expense – Other) forms.  The Payment Tracking Report also includes the Agency Activity Report, which 
displays the information entered using the Summarize Agency Activities tool and the Log Off-line Activity tool (if 
applicable).  Note that the information for Schedules A-1, E-1, E-2, and E-3 must be entered using the Edit 
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Expenses tool or the Prepare Invoice wizard, and the Schedule A-2 information must be entered using the 
Assign Hours tool, prior to finalizing the invoice. 

If the invoice is for an agency authorized to receive Advance Payments, an Advance Pay Request Report will 
also be displayed (preceding the Payment Tracking Record). 

 
Portions of an example Payment Tracking Report are shown below.  The information can be reviewed.  If any 

changes need to be made, close the View/Submit Invoice window by clicking the  button in the upper right 
corner of the screen.  You can then access the invoice using the Edit Expenses or Assign Hours tools, and 
make changes.  If no changes or additions are needed, proceed with submitting the invoice by entering the 
Agency Invoice Submitter password, and then click the Submit Invoice button.  
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 Update Invoice Status (Updated 07/08/2008) 3.1.10.8

The Update Invoice Status tool is used by the Invoice Administrator to authorize final invoices, and indicate 
when they have been processed.   

1. In the Tools menu, point to Agency Invoices, and then click Update Invoice Status.   

 

 

The Invoice Administrator begins by selecting an agency from the Agency pull-down menu.  The form will 
be repopulated with lists of existing agreements and associated invoices for the selected agency.  The 
Invoice Administrator selects an agreement from the Agreements pull-down menu, then selects the 
invoice from the Invoice pull-down menu.  The current status of the invoice will be displayed in the 
Status field.  The status will be Draft, Final Authorized, Final Submitted or Processed. 
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The Invoice Administrator clicks the View Invoice button to view the invoice.  The Payment 
Tracking Record for the invoice will open in a new window.  After reviewing the invoice, the 
Invoice Administrator clicks the Update Invoice Status tab to return to the Update Invoice Status 
window. 

 
 
 

2. In the Update Invoice Status window, click Load.  

 

In the Invoice # section, the Invoice Administrator can update an invoice status and add 
comments. 

 

3. To change the invoice status, do the following: 

 To send requested changes or an approval to the invoice submitter, type your comments in the 
Comments to invoice submitter field.   

Important:  Before entering your comments, you should ensure you are including 

comments from other reviewers. Open the Invoice Comment Log window to view the list of 
reviewers and comments for the selected invoice.  To access the Invoice Comment Log 
window, go to the EST Reports menu, point to Invoicing Reports, and then click Invoice 
Comment Log.   

Once you have accessed the Invoice Comment Log, print out the log to keep a hard copy 
record of the list of comments. This enables you to keep a record of previous reviewer 
comments that may be deleted and replaced by new comments. 

Then return to the Update Invoice Status window, and type your comments in the 

Comments to invoice submitter field. 
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 In the Status field, click the drop-down arrow  and select one of the following: 

 If changes need to be made to the current draft, click Draft. 

 If no changes need to be made to the current draft, and you have determined it's ready to be 
processed, click Final Authorized. 

 If the invoice has been processed, click Processed. 

Note:  You must add comments before selecting a status in the Status field. 

 

 

Note: The Final Submitted option in the Status field only indicates an agency has submitted a 
final invoice. You cannot make any changes to an invoice status with this selection. 

 Click Update Status. 
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A message appears stating the invoice has been updated and an email notification sent to 
the invoice submitter.  Click OK. 

 

 

Upon submittal of the Final Authorized invoice, the database automatically updates the invoice 
status to Final Submitted.  

 

Note:  If changes need to be made to the draft invoice, the invoice will maintain its unsubmitted 
status. 

 

Tip!  To regenerate a PDF of the invoice, click Regenerate PDF, as illustrated below. 
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 Upload Receipts (Updated 06/27/2008) 3.1.10.9

If a previously saved draft invoice is being edited, the Agency Invoice Submitter clicks the field that needs to be 
edited, and enters the new information.  The Agency Invoice Submitter is required to provide scanned images of 

expense receipts as part of the invoice package.   

In the Tools menu, point to Agency Invoices, and then click Upload Receipts.   

Note: Scanned images of the documentation must be black and white, with a scanning density of 300 dots per 

inch (DPI).   

 

 

The form that opens is divided into three sections.  The Agency Invoice Submitter uses the first section to select 
an Agency, Existing Agreement, and Invoice. This section of the form will be populated with information related 
to the user name used to log on to the EST.  In the example shown below, the user name for a Northwest 
Florida Water Management District Agency Invoice Submitter was used.  (The information shown is for example 
purposes only and does not reflect actual Northwest Florida Water Management District agreements or 
invoices.)  

The Agency Invoice Submitter begins by selecting an agreement using the Existing Agreements pull-down 
menu.  If the Agency Invoice Submitter is uploading a receipt for an unsubmitted invoice saved in the database, 
the Agency Invoice Submitter selects the invoice from the Invoice pull-down menu.  If the receipt is not related 
to an unsubmitted invoice, the Agency Invoice Submitter proceeds to the Upload File portion of the form. 
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The Agency Invoice Submitter uses the second section of the form to view and/or delete receipts that were 
previously uploaded.  The Agency Invoice Submitter selects the receipt from the Pick Receipt pull-down menu.  
The PDF version of the receipt will be displayed in a new window, as shown below.  To keep the receipt as part 
of the invoice package, the Agency Invoice Submitter clicks the Yes – keep receipt button.  To delete the 
receipt, the Agency Invoice Submitter Clicks the No – delete receipt button.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 Environmental Screening Tool Handbook - February 15, 2016 3-325 

 

The Agency Invoice Submitter uses the third section of the form to upload a receipt, as shown below.  Receipts 
may be in BMP, GIF, JPG, PNG or PDF format, but the images must be black and white, with a scanning 
density of 300 dots per inch (DPI).  If the receipt pages are in a format other than PDF, they must be uploaded 
one 8-1/2 x 11-inch page at a time.  To upload images of receipts, the Agency Invoice Submitter uses the 
Browse button to locate and select the file containing the image that has previously been saved on the 
computer.  The Agency Invoice Submitter adds a brief description of the receipt in the Description textbox, then 
clicks the Upload and View Confirmation Page button.  The PDF version of the receipt will be displayed in a 
new window, as shown above.  To keep the receipt as part of the invoice package, click the Yes – keep receipt 
button.  To delete the receipt, click the No – delete receipt button.  

 Record Invoice Comments (Updated 05/15/2008) 3.1.10.10

Once a draft invoice is submitted using the EST, the Invoice Administrator and Invoice Reviewers receive an 
email informing them that the draft invoice is ready for review.  District Invoice Reviewers will receive emails only 
for invoices associated with agencies identified by the District ETDM Coordinator (using the District Review 
Preference tool).  The notification email contains the agency name, agreement number, invoice number, and 
submittal date.  The Invoice Administrator and Invoice Reviewers log on to the EST and review the submitted 
invoice for completeness and correctness using the Record Invoice Comments tool.  The Invoice Administrator 
and Invoice Reviewers use the Record Invoice Comments tool to log comments about the invoice.  The log 
includes the invoice number, name of the person submitting the comment, comment, and date submitted.  
During the commenting period, the Invoice Administrator and Invoice Reviewers may view other reviewers’ 
comments, submit additional comments, and edit their own comments. 

In the Tools menu, point to Agency Invoices, and then click Record Invoice Comments. 
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After the Record Invoice Comments form opens, the Invoice Reviewer selects the invoice from the Invoicing 
Period pull-down menu, then clicks View Invoice.  The Payment Tracking Record for the selected invoice will 
open in a new window.   

 

After reviewing the invoice, the Invoice Reviewer returns to the Record Invoice Comments form by clicking the 
Record Invoice Comments tab at the top of the screen. 

 

The Invoice Reviewer enters comments concerning the invoice in the Comment textbox, then clicks Save when 
finished. 

After clicking Save, a description of the comment will be displayed in the Load/Edit Existing field.   

 

To edit a previously submitted comment, the Invoice Reviewer selects the comment from the Load/Edit 
Existing pull-down menu (note that the comment description will be highlighted in blue), then clicks the Load 
button.   

The comment will be displayed in the Comment textbox, as shown below.  After editing the comment text, the 
Invoice Reviewer clicks Save.  
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If other reviewers have submitted comments concerning the invoice, the comments will be displayed in the 
Comments from other reviewers field.   

 

 Override Invoice Payments (In Development) 3.1.10.11

 Manage Scanned Agreements (In Development) 3.1.10.12

3.1.11 Project Dashboard (New 03/31/2014) (Formerly Project Tracker) 

 Manage Project Tasks (New 07/31/2009) 3.1.11.1

The Manage Project Tasks function in the Environmental Screening Tool (EST) Tools menu enables 
authorized users to manage tasks assigned to a project.  

Users with the following assigned privileges can send the report to EDMS: 

 Environmental Management Office (EMO) Managers 

 Florida Department of Transportation (FDOT) Coordinators Primary 

 FDOT Coordinators  

For a list of roles authorized for using the Manage Project Tasks function, see Table 1-1 in Chapter 1.5 of the 
EST Handbook. 

Using the Manage Project Tasks Tool: 

1. Select a project from the Project Navigation Bar. 

 

Note: You can use the default project that appears in the Active project box, select a project from 
your Saved Searches or Project History lists, or you can click the Advanced Project Search link 
to select another project. See the Navigation chapter of the EST Handbook for information on using 
the Project Navigation Bar. 
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2. On the Tools menu, point to Project Tracker, and then click Project Tasks. 

 

The Manage Project Tasks window opens as a tabbed page, displaying the details for the 
selected project and a page toolbar. 

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 
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 Add the page to your My ETDM preferences. 

3. Under Groups and Tasks, click the drop-down  arrow in the Groups field, and then select a group 

from the list. 

 

 

The Groups and Tasks section expands, displaying a table showing a list of tasks associated with 
the selected project. 

 

 

Note:  Tasks that are grayed out are inactive because they have not been assigned to the 
selected project.   
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4. To assign a task, click the check box in the Assigned column. The EST activates the task and displays it 

in bold font. 

 

 

5. To change the task priority, click the arrows in the far right column of the table.  For example, in the next 

illustration, clicking the up arrow for the Develop SCE Evaluation task moves it above the Complete 

ETAT Review Period (List Date) task. 
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The task—Develop SCE Evaluation—is now displayed before Complete ETAT Review Period 
(List Date), as shown in the next illustration.   

 

Tip!  To remove an assigned task from the project, click the checked box in the Assigned 

column beside the Task name.  The task row will become grayed out and all information related 
to the task will be removed. 

6. Click the pencil icon in the table's far-right column to make edits to or add: 

 Comments 

 Target Date (the task start date) 

 Completed Date (the date the task was completed) 

 Assigned To 

 

The task row expands, displaying fields for editing or adding information and designating task 
assignees. 
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 Do the following: 

 In the Comments column, type your comments in the text box. 

 
 

Note:  Authorized users can only edit or delete their own comments. Only FDOT 
Coordinators and Project Managers can edit or delete other users' comments. 

 

 In the Target Date column, type the task start date. 

Tip!  When typing dates, use the mm/dd/yyyy format.  You can also click the calendar 

icon  and select the dates. 

 

Note:  Task assignees will enter the date the task was completed in the Completed 
Date field.  

 In the Assigned To column, do the following: 

 Type the first three letters of the person's name in the text box, as shown in the next 
illustration. 

 

The EST automatically populates the field with a list of matching names and agencies. 
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Tip!  Click  to cancel the actions.  All information related to the task will be removed. 

 

 Select the person you want to designate as the task assignee from the prepopulated drop-
down list. 

 Click Assign. The designated task assignee's name now appears in the Assigned To 
column. 

 

 Repeat the process to designate additional task assignees. 

 Click  to save your information. 
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The EST now displays the task and designated assignees. 

 

 

Tip!  To remove a designated task assignee, select the name from the Assigned To column, 

and then click the Remove button. 

 

7. Under Task Notification Email,  do the following: 

 In the From field, click the drop-down arrow  and select the name of the person sending the 
Task Notification. 

 In the Task Notification Email table, select the task assignee(s) you want to include in the task 
notification emails by clicking the check box next to the assignee's name.   

Note: If you want to deselect a name from the list, click the checked box beside the assignee's 
name to remove the checkmark. 
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8. Click Send Email.  The EST will send the task assignees a system email with the task information, 

including the: 

 ETDM Project Number 

 ETDM Project Name 

 Group 

 Task 

 Target Date  

Note:  Task assignees only have write-access privileges for entering the Task Completed Date. 

The information entered in the Manage Project Tasks window will appear in the Project Tasks Status 
Report. 

See the Project Tasks Status Report section of the EST Handbook for instructions on navigating the 
Project Tasks Status Report window. 

 Manage Task Groups (New 07/31/2009) 3.1.11.2

The Manage Task Groups function in the Environmental Screening Tool (EST) Tools menu enables 
Environmental Management Office (EMO) Managers, Florida Department of Transportation (FDOT) ETDM 
Coordinators Primary, and FDOT ETDM Coordinators to manage tasks and groups by: 

 Creating groups and assigning new and existing tasks 

 Assigning or removing tasks from an existing group 

 Removing groups 

 Deleting tasks 

Using the Manage Task Groups Tool: 

1. On the Tools menu, point to Project Tracker, and then click Task Groups. 
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The Manage Task Groups window opens as a tabbed page, displaying a search filter and a page 
toolbar. 

 

Tip!   Click on the toolbar icons to: 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 
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2. To create a group and assign tasks to it, do the following: 

 Under Groups and Tasks, type the name of the new group in the New Group Name field, and 
then click Save.  For the next illustration, the new group name is Bob's Group. 

 

 

The new group name—Bob's Group—now appears in the group list of the Groups field.   

 

 

Once you have created a new group name, you can assign tasks to the group by: 

 Assigning existing tasks (See Step 3 for details) 

 Creating and assigning new tasks (See Step 4 for details) 
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3. To assign tasks that already exist in the database, do the following: 

 Under Existing Tasks, select the task(s) from the list of options. 

Tip!  You can select multiple entries by pressing SHIFT+click for adjacent entries or 

CTRL+click for non-adjacent entries. 

 

 Click Assign Task(s). 

 

The selected tasks now appear in the Task for Selected Group field, and the EST displays a 
message that the Task(s) were successfully assigned. 
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4. To create a new task and assign it to a group, do the following: 

 Under Task for selected Group, type the task name in the New Task Name field.  For the next 
illustration, the new task name Develop Documentation was created. 

 

 

 Click Save & Assign. 

 

 

The new task—Develop Documentation—now appears in the Task for selected Group field 
and in the Existing Tasks field, which means it can be assigned to other groups. 
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5. To manage the tasks for an existing group, do the following: 

 Click the drop-down arrow   in the Groups field, and then select a group from the list.  

 

The group name now appears in the Groups field along with the list of tasks assigned to the 
group. 

 

6. To remove tasks from a group or create a new task and assign it to the group, do the following: 

 To remove an assigned task from a group, select the task from the Task for selected Group field, 
and then click Remove. 

 

Note:  A task can only be removed from a group if there are no other projects assigned to that 
task. 

A message appears asking you to confirm the deletion. Click OK. 

 

The task is removed from the list of tasks for the selected group.  
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Note: Tasks removed from the list in the Task for a selected group field are not deleted 
from the list of Existing Tasks.  

 To create a new task for an existing group, do the following: 

 Type the task name in the New Task Name field.   

 

 

 Click Save & Assign. 

 

 

The new task name appears in the Task for selected Group field. 
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7. To delete a group from the list in the Groups field, do the following: 

 Click the drop-down arrow   in the Groups field, and then select a group from the list.  For the 
next illustration, the group Bob's Group was selected. 

 

Note: A group cannot be deleted if there are other projects that have assigned tasks for that 
group. 

 Click Delete. 

 

A message appears asking you to confirm the deletion. Click OK. 

 

The group is removed from the list of in the Groups field.   

8. To delete tasks from the Existing Tasks list, do the following: 
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 Click the drop-down arrow   in the Existing Tasks field, and then select a task from the list.  
For the next illustration, the task Document Review was selected. 

 

 Click Delete Task. 

 

Note: A task cannot be deleted if it is still assigned to another group or project. 

 Average District Project Costs and Times (New 02/22/2014) 3.1.11.3

The Average District Project Cost and Time feature in the EST Dashboard menu enables District 

ETDM Coordinators Primary, ETDM Coordinators, and ETDM Coordinator Management Team to enter 

and update project costs and times for a District’s PD&E studies. This feature allows users to perform the 
following actions: 

 Accessing the Average Project Cost and Time page 

 Searching by District and Fiscal Year 

 Entering Average District Project Costs and Times 

 Removing a Cost Category Row 

3.1.11.3.1 Accessing the Average District Project Cost and Time Page 

 

1. In the Tools menus, point to Project Dashboard, and then click Average District Project Cost and Time. 

 

The Average District Project Cost and Time page opens and displays a search form.  
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2. Go to Step 1 of the next section, Searching by District and Fiscal Year . 

3.1.11.3.2 Searching by District and Fiscal Year 

 
The search feature on the Average District Project Cost and Time page allows you to search for project 
cost and time information by District (if you have jurisdiction over multiple districts) and by fiscal year.  
 

1. For Districts, do the following: 

 If only one District is in your jurisdiction — The District name will appear on the screen as the 
default selection. No action is required. 

 If you have jurisdiction over multiple Districts — Click the Districts arrow and select the 
appropriate value.  

2. Click the Fiscal Year arrow and then select the appropriate value. 

3. Click Search.   

 

The page displays a form for entering the cost and time information.  
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4. Go to Step 1 of the next section, Entering Average District Project Costs and Times. 

3.1.11.3.3 Entering Average District Project Costs and Times 

This section provides steps for entering costs and times for a project.  

3.1.11.3.3.1 Entering Average District Project Costs 

 

1. Click Add Cost. 

 

The Cost Category column displays a list box. 

2. Click the Select Cost Category arrow to display the list of available cost categories.  Do one of the 

following: 

 If a cost category appears on the list – Go to Step 3 of these instructions. 

 If the cost category does not appear on the list – Go to Step 4 of these instructions. 

3. Choose the appropriate category by clicking on it. Go to Step 5 of these instructions. 

 

4. To add a New Cost Category, do the following: 

 Beside Enter New Cost Category, click the Add button. 
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 Type the name of the new cost category. 

 Click Add. 

 

The new category will appear in the Cost Category column. 

Note: The added Cost Category that you enter will appear on the list for other Districts.  

 

5. Type the dollar Amount in the box under the appropriate column heading. The form automatically 

updates the Total Cost for each column. 

 CE – Categorical Exclusion  

 EA – Environmental Assessment 

 EIS – Environmental Impact Statement 

 SEIR – State Environmental Impact Report 

6. Do one of the following: 

 To add another item – Click Add Cost and repeat Steps 1 – 5 of these instructions. 

 To submit the information – Click Submit. 
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3.1.11.3.3.2 Entering Average District Project Times 

 

1. On the Number of Projects Analyzed row, type the number of projects for the appropriate column 

heading. 

2. On the Average Months to Process Document row, type the number of months for the appropriate 

column heading. 

 

3. Click Submit. 

3.1.11.3.4 Removing a Cost Category Row 

 

1. To remove a Cost Category row, click the Remove button. 

 

A message appears requesting confirmation. 

 

2. Click OK. 

3. Click Submit. 
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3.1.12 Project Dashboard (New 03/31/2014)  

The EST Project Dashboard tool allows you to track projects and make updates as the project moves 
through the ETDM process.  The dashboard gives you a tabular and graphical view of projects and 
provides a comprehensive view of project summary data, which allows you to view project milestones, 
evaluate project data, and update project information without having to access multiple forms and reports.  
Because the Project Dashboard is integrated with other EST forms, the information entered into the EST 
database is automatically updated, providing you with an up-to-date view of a project’s status.  The next 
illustration provides an introductory overview of the main components of the Project Dashboard screen.   

 
These instructions provide guidance for performing the following actions: 
 

 Accessing the Project Dashboard 

 Using the Project Dashboard’s Record Table  

 Using the Advanced Search Tool 

 Selecting Records 

 Managing Columns 

 Displaying the Summary List 

 Displaying Project Summary Information 

 Viewing and Editing Project Details 

 Viewing General Project Information 
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 Editing Project Information 

 Editing Project-Specific Contracts 

 Updating the Project Manager List 

 Updating the Project Schedule 

 Viewing Project Alerts 

 Adding and Editing Benefits and Issues 

 Updating Issue Tracker 

 Updating Project Consistency 

 Exporting Project Records to Excel 

 EDMS Integration 

 Generating an Excel File 

 Uploading a File to the EDMS Library 

 Deleting and Replacing an EDMS file 

3.1.12.1.1 Accessing the Project Dashboard 

The projects displayed on the project dashboard screen are based on one or a group of projects that you have 
stored in either your Saved Searches or Project History, or searches made using the Advanced Search tool.  

Note: See the Navigation chapter of this handbook for instructions on searching for and selecting 
projects. 

1. Select an Active project or group of projects from the project navigation bar.  

 

2. On the Tools menu, click Project Dashboard. 

 

The Project Dashboard page opens and displays a table listing the project records from your 
selection.   
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Tip!  Click the toolbar icon to: 

  Export the current page to Excel. 

  Send feedback about the current page. 

  Access online Help. 

  Bookmark the page. 

 Add the page to your My ETDM preferences. 

3.1.12.1.2 Using the Project Record Grid 

At the top of the Project Dashboard page is the project record grid, which displays the project record for a 
single project or project group. The table works like a spreadsheet, providing you with the tools to perform 
functions such as changing the order of the column headings, filtering the column information, and sorting 
columns in ascending or descending order.  You can further refine a project group by using the filter option. 

Tip!  For more information on using the Project Dashboard tool, see the Project Dashboard 

training video located in the Help menu. 

 

The project record table also provides tools that allow you to perform the following actions: 

 Filter the project list. 

 Select one or multiple projects from a group of projects. 

 Display projects by category. 

 Search for projects using the Find Projects tool. 

 Remove/add columns. 

An overview of the dashboard’s table components is provided in the next illustrations. 

 



 

 

 

 Environmental Screening Tool Handbook - February 15, 2016 3-351 

 
 
 

 

 Use the dashboard’s table tools to narrow your search results, refresh the results list, 
remove/insert columns, and display a summary of the selected projects. Click the appropriate tool 
symbol to perform the desired function. 

 

 
 
 
 

 

Table 3-1 Project Dashboard Table Tools 

 
 

Advanced find tool. Allows you to search for 
and manage the records to display on the grid. 

   
Refresh the search results list. 

 

 
 

Hide/Insert columns. 

 
Summarize selected records. 

 



 

 

 

 Environmental Screening Tool Handbook - February 15, 2016 3-352 

 Use the dashboard’s navigation bar to view the total number of results returned from a search 
query and to change the number of results displayed in the view. 

 

 

Table 3-2 Project Dashboard Table Navigation 

 
 

Shows number of results in the current view out of 
total number of results. 

   

Shows current page location out of total number of 
pages. Type a page number in the text box to go 
to a specific page. 
 

 
Select the number of results to display. Click the 

drop-down arrow, , and then select a value from 
the list. 

 

 
 

Go back to page 1. 

 
 

Go to last page. 
 

 
Go back one page. 
 

 
Go ahead one page. 

 
Tip!  Click Hide <<  to expand the Project Dashboard page view.   

  

3.1.12.1.3 Using the Advanced Search Tool 

The advanced search tool displays a dialog box in Boolean format.  This tool allows you to filter project 
records and is especially helpful if you have a large number of records and want to narrow the list to a 
specified group.   
 

1. On the grid toolbar, click the magnifying glass icon, .   
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A dialog box appears, displaying search fields.   

 

2. Narrow your search by selecting the appropriate operators that appear for the fields provided. 

3. Each time you want to add a condition to the search query, click the plus sign beside the AND/OR field. 

This will display another row of search field operators.    

Note: The Advanced Search feature is not case sensitive. 

 

Tip!  Click Reset to clear the fields. 

4. When you have completed your search query, click Find. 

 

The project record grid refreshes and displays the list as specified in the Advanced Search. 



 

 

 

 Environmental Screening Tool Handbook - February 15, 2016 3-354 

 

3.1.12.1.4 Selecting Records  

 
You can select one, multiple, or all records.  

 To summarize all projects shown in the list – Click the check box at the top of the check box 

column. All project rows will be checked and highlighted. 

 

 To summarize one or multiple projects from the list – Click the check box beside the record. The 

row will become highlighted. After making your selections, click Show Selected. 

. 

Tip!  When selecting records, you can also use the standard keyboard functions Shift + Ctrl 

+ Click. 

 

The results list displays only the selected projects. 
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Tip!  Click the refresh icon, , to update a view. 

3.1.12.1.5 Managing Columns 

The following is an overview for managing the columns in the record table.    

Sorting Columns 

Click a column heading to sort the column in ascending or descending order. 

Filtering Columns 

You can display the list according to column (e.g., ETDM number, Project Name, Phase). Each column shown 
in the table includes a text box or, as in the Phase column, a list box. You can further refine your list to display 
projects by column item (e.g., list projects that have the Class of Action of Categorical Exclusion, list projects 
that are shown as LAP). 

 

1. In the text box, type all or part of the word or number related to the column heading.  

2. Type the keyword or number, or select a Phase.  

 

3. Press Enter. Only the matching records will be displayed. The following illustrations show examples for 

using the column filter for each category. 

Note: To reset the grid, clear the filter box and click Enter. 

Changing Column Order 
 
You can change the order of the table columns. To move a column location,  do any of the following: 
 

 Place the mouse pointer on the column header and then drag the column header to the desired 
location. 
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 Use the Columns feature: 

 Click the Columns button at the bottom of the records table. 

 In the Select Columns box, click and drag the column name up or down the list to the 
desired location. 

 
Changing Column Width 
 
Position the mouse pointer on the column line until the directional arrows appear. Left-click on a 
directional arrow and drag it to the desired width. 
 

 
 
 
Hiding/Displaying Columns 
 
In addition to adjusting the height and width of the table columns, you can also display and hide selected 
columns.   
 

1. Click the Columns button. 

 

The Select columns form opens and shows the columns included in the current records table.  
Columns that have been hidden are listed on the left. Columns that are currently displayed in the 
records table are listed on the right. 
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Tip! To quickly locate a column, type the column name into the box at the top of the Select 

columns form.  

 

 To hide a column, click the minus sign symbol    beside the column name. For this illustration, 
FM Number is shown as selected. 

 

 

The selected column appears on the hide list, which is located on the left side of the form. 
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Tip! Hide additional columns by repeating the steps listed above, or click Remove all to hide 

all columns. 

 To add a column, click the plus sign symbol, , beside the column name. 

 

 

The selected column appears in the list of columns that will be displayed in the records table. 

Tip! Click Add all to insert all of the columns. Click Remove all to hide all columns. 

2. Click Ok. 

 

The records table displays the changes. 
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3.1.12.1.6 Displaying the Summary List 

Projects selected from the project dashboard’s search tool are grouped under a Summary # heading on 
the list. As you perform additional project searches, each group of projects will be listed under a separate 
Summary # list, providing easy navigation between summaries.   
 

Note: Project summaries are shown on the Summary list throughout your session on the Project 
Dashboard page.   

 

1. To display the summary information, click Summarize. 

 

The Project Dashboard page expands and displays a Summary # list, which contains a list of the 
projects selected from the dashboard search. 

 

2. Click the Summary icon or project name to display more details for the projects shown on the list.  For 

this illustration, Summary #2 is shown as the chosen selection. 
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The Project Summary # displays the descriptive data for the selection.  

 

 

 To switch to another project, click the project name. The Project Summary will refresh and display the 

information for the selected project. 

 

 

Tip! You can collapse and expand a Summary list by clicking the arrow next to the Summary 

# icon. 
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3. To add another summary, return to the project dashboard search tool and make your selections. (See 

the Selecting Records section of these instructions.) 

3.1.12.1.7 Displaying Project Summary Information 

The Project Summary section provides an overview of project information, which is displayed in tabular 
and graphical formats.  Information is organized by the following categories: Phase, District, Planning 
Organization, Lead Agency, Class of Action, Purpose and Need, Federal Consistency, and Alerts. 
Click a tab to display the category information. 
 
 

 

 

1. Click a tab to view the descriptive data for a category: 

 By Phase – Displays the number of projects in a Planning Screen, Programming Screen, and in 
Project Development. 

 By District – Lists the number of projects in a district. 

 By Planning Organization – Displays number of projects by planning organization. 

 By Lead Agency – Lists Lead Agencies and number of projects assigned to each agency. 

 By Class of Action – Displays types of COAs and indicates if No COA has been assigned. Lists 
number of projects assigned a respective COA. The information does not include projects that 
are in planning screen. 
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 By Purpose and Need – Shows the number of P&N responses for completed project reviews. 
Information is broken down by response (e.g., Understood) and whether the P&N has been 
reviewed by assigned reviewing agencies and the Lead Agency. 

 By Federal Consistency – Lists the number of projects by Federal Consistency Required, 
Federal Consistency Not Required, and Federal Consistency Status Unknown. 

 Alerts – Displays alerts for the projects displayed on the summary list. See the Viewing Project 
Alerts section of these instructions for further information. 

 

3.1.12.1.8 Viewing and Editing Project Details 

The Project Details section displays project-specific data, including general project information, project 
agency coordination, screening information, and schedule information. You can edit the project 
information for projects within your jurisdiction. 
 

1. Click the project name to display the Project Details section (see the previous section) 

Tip!   You can expand and collapse page sections to increase the viewing area. Click the minus 

symbol, , to collapse a section.  Click the plus sign symbol, , to expand it. 

 

2. To view information for a particular category, click the respective tab.  The Project Details section 

includes the following categories: 

 Overview – Displays general project details in addition to providing links that allow you to update 
project information. 

 Coordination – Provides an overview of a project’s agency coordination.  

 Previous Screenings – Displays dates of previous screenings and dates of summary report 
publication. 

Note: The Previous Screenings tab only displays if the project has completed a screening.   
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 Project Schedule – Displays a project’s Class of Action, milestones, scheduled due dates, and 
change history, and provides links to the associated report. 

 Project Alerts – Displays active alerts and required actions for a project.  

 Benefit and Issues – Provides examples of a project’s cost and time savings (in dollars and 
months, respectively) and examples of cost and time increases (i.e., Issues). 

 Issue Tracking – Displays issues and concerns submitted by ETDM participants pertaining to 
policies and procedures. 

 Consistency – Shows the planning consistency status and additional consistency information. 

3.1.12.1.9 Viewing General Project Information 

After selecting a project from the summary list, the Overview tab displays by default, the Overview tab 
displays the project’s name, location, and current phase, along with status information. Depending on 
your EST user role, there are a couple of ways to add or change project information: 
 

 Click a link to open the corresponding EST page as a separate tab.    

 

 

 Click an Edit button shown on the Overview section to open the wizard dialog box within the 
current screen.   

Note: Edit buttons are displayed only for users with District Coordinator or Project Manager 
roles. 
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3.1.12.1.10 Editing Project Information 

ETDM Coordinators and Project Managers can use the Project Dashboard to update information for 
projects within their jurisdiction.  Data submitted through the EST’s Project Dashboard also appear on 
related EST tools and reports pages. The forms displayed on the Project Dashboard work the same way 
as the corresponding tool.  
 

1. Select a project from the summary list (as shown in the Displaying the Summary List section of these 

instructions). 

2. In the Project Details section, click Edit Project. 

 

The Update Project Record wizard opens as a dialog box. The Update Project Record dialog 
box is organized by tabs and works the same way as the Update ETDM Project wizard that is 
found on the EST main menu.   
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Tip! Click and drag the bottom right-hand corner of the dialog box to display the complete form. 

 Type the information into the appropriate fields. 

Tip!  To move to another section, click the section tab or use the Next or Back buttons. 

 

 After you make a change, the page refreshes and displays the updated information.  

Note: A red asterisk shown on a tab heading indicates required fields that need to be complete.  
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 After entering the information in the Update Project Record wizard, click Save. 

 

3.1.12.1.11 Editing Project-Specific Contracts 

Users that have the authority to make edits to contracts have access to the Edit Contract(s) feature on 
the Project Dashboard page. 
 

1. Click the Overview tab. 

2. Click Edit Contract(s). 

 

The Edit Project Specific Contract(s) dialog box opens. 

3. Under Add New Contracts, type the new contract number. 

4. Click Save. 

5. To add more than one contract number to the list, click Add and repeat Steps 3 and 4 listed above. 

6. Click Exit. 

3.1.12.1.12 Updating the Project Manager List 
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The Project Dashboard allows you to assign a project manager or add other project managers to the 
project.  
  

1. Click Edit Manager(s). 

  

The Assign Project Managers dialog box opens, displaying the name(s) and contact information 
for current project managers, along with a list box containing the names of eligible project 
managers. You can use this form to add a project manager to the current project or remove the 
current project manager’s name.  

2. To add a project manager, do the following: 

 Under Select A Project Manager, click the Eligible Project Manager List arrow, and then 
select a name by clicking on it. 

 Click Add. 

Note: To add a name to the list of eligible project managers, contact the ETDM Help Desk. 

The project manager’s name and contact information appears under the Current Project 
Managers header. 

 To select another name, repeat Steps 1 and 2 of these instructions. 

 To delete a name from the Current Project Managers list, click the X beside the name. 

3. Click Done. 

The Project Details section refreshes and displays the updated information on the Overview 
header. 

3.1.12.1.13 Updating the Project Schedule 

The Project Schedule displays events related to Project Development and Environment (PD&E) 
milestones and allows you to view previously recorded events for projects with assigned Classes of 
Action (COAs).  ETDM Coordinators and Project Managers can use the Project Dashboard to make edits. 
Edits made on the dashboard will display on the corresponding Project Schedule Tool page. 
 

Tip!  See the Project Schedule Tool section of the EST User Handbook for navigation details. 

1. In the Project Details section, click the Project Schedule tab. 

2. To view related documents, click a View Report button under Project Schedule Milestones. The 

page associated with the related report opens as a separate tabbed window. 

 

3. To update the project schedule, click Edit. 

3.1.12.1.14 Viewing Project Alerts 
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The Project Alerts tab of the Project Dashboard works the same way as the Project Alerts page 
except it only loads the alerts for the projects you are summarizing. 
 

Tip!  By default, the EST displays alerts from the last 60 days. 

 

1. Click the Project Alerts tab. 

 

2. Click the link in the Action column to open the EST page for completing the action for the corresponding 

ETDM number. 

 After completing an action for an alert, the database removes the alert from the list. The alert will 
no longer appear after the screen is refreshed. 

 To remove an alert from your current view (e.g., an alert that does not require specific action from 
you), click the Dismiss button. 

Tip! To restore a dismissed alert to an active alert, click the Restore button beside the 

corresponding ETDM number. 

Note:  Additional details for viewing and managing alert messages are covered in the Project Alerts 
section of the EST User Handbook. 

3.1.12.1.15 Adding and Editing Benefits and Issues 

The Benefits and Issues tabbed page in the Project Details section displays estimated cost savings 
and increases for a selected project.  FDOT ETDM District Coordinators, FDOT ETDM District 
Coordinators Primary, and members of the ETDM Coordinator Management Team can add and edit 
estimated cost information for projects within their jurisdictions.  
 

1. In the Project Details section, click the Benefits and Issues tab. 

 

The panel displays a Benefits tab and an Issues tab, respectively.   Information pertaining to each 
category will be displayed.   
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2. On the Benefit or Issues tab, click the Edit button. 

 

3. To add or edit, do the following: 

 Click Edit. 

 Enter the information in the fields provided. 

 Under Specific Examples of Benefits/Issues, do the following: 

 If Specific Examples are shown on the list – Click the check box beside the selected 
example. 

 If a Specific Example is not shown on the list – Do the following: 

 Under Enter New Example of Benefit/Issues, type the example in the text box. 

 Click Add. 

 Click Save. 

3.1.12.1.16 Updating Issue Tracker 

The Issue Tracking tab on the Project Dashboard screen displays comments for agency-related project 
issues and allows you to communicate about a particular issue with other members of the project team.  
 

1. Click the Issue Tracking tab. 
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2. Click the Edit button. 

3. On the Issue Tracking form, do any of the following: 

 To add new comments: 

 Click the Add New Comments button. 

 Enter the comment in the appropriate text box. 

 Click Save. 

 Repeat the previous steps for each new comment. 

 To edit existing comments: 

 Make the appropriate text edits. 

 Click Save. 

 To delete a comment: 

 Click the Delete button located immediately above the comments. 

 A message appears asking you to confirm the deletion. Click OK. 

 

3.1.12.1.17 Updating Project Consistency 

 
The Consistency tab on the Project Dashboard screen displays a project’s consistency information and 
allows authorized users to update the information. 
 

1. Click the Consistency tab. 
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2. To make edits, click the Edit button. 

 

The Update Project wizard opens and displays a form for adding information or for making edits. 

3. Follow the instructions and steps in the wizard for completing the consistency information. 

3.1.12.1.18 Exporting Project Records to Excel 

You can export the records displayed on the records grid to Excel.  The export tool allows you to manage the 
information you want to display on the Excel spreadsheet (e.g., ordering column headings, removing columns).   

1. Click the Excel button on the page toolbar. 

 

By default, the Project Dashboard page displays a column export section where you can select 
the columns you want displayed on the spreadsheet. 
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2. Do one of the following: 

 If you want all Selected Columns displayed on the Excel spreadsheet, then go to Step 3 of 
these instructions. 

 If you want the Excel spreadsheet to show only a selected group of columns, you can use the 
Export to Excel File dialog box to indicate which columns to hide by doing the following: 

 Click the minus sign icon  beside the column heading name, or select Remove all. 

 

 

Tip!  If you only want to display one or two columns on the Excel spreadsheet, you can 

expedite the process by clicking the Remove all link. This will save you from having to 
click the minus sign beside each of the column headings on the list of Selected 
Columns. Then, in the Unselected Columns list, click the plus sign beside the 
columns you want to display on the spreadsheet. 

The columns you have deselected (i.e., the columns you do not want to display on the Excel 
spreadsheet) will appear on the left.  
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 To reset a hidden column back to the selected list, click the plus sign or click the Add all link. 

 

 

Tip! You can also reorder the columns by clicking and dragging the column to another 

location.   

 

3. Click Generate Excel File. 

The page displays a message showing the download progress, along with a link for downloading 
the Excel document directly to your desktop.   

Note: You will also receive an email containing a download link. 

 

4. Follow the steps for saving the file to your desktop. 

3.1.12.1.19 EDMS Integration 

The Electronic Document Management System (EDMS) section allows authorized users to upload 
information from the Project Dashboard to the EDMS library.  Documents are generated in an Excel 
format. Reports that you have previously uploaded are listed in a file queue located at the bottom of the 
section.  
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Note: This section only displays for users with an FDOT ETDM Coordinator Primary role.  

 

Tip! Click the excel file link to open a previously generated file in Excel, where you can make 

edits. Click either the Yes or No option to indicate if you want to add the file to the EDMS library. 

3.1.12.1.20 Generating an Excel File 

 

1. Click Generate Excel File. 

 

A message appears alerting you that the file is generating and an email will be sent when it is 
ready. A link to the file will be included in the email. 

2. Click OK. 

3.1.12.1.21 Uploading a File to the EDMS Library 

 
After a file has been generated, you will see a message under the EDMS Integration heading stating that 
an Excel file has been generated. 
 

1. Indicate whether you want to upload the file to EDMS by clicking the appropriate option button Yes or 

No. 
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2. If you want to upload the file to the EDMS library and you have selected the Yes option from Step 1, 

do the following: 

 In the Enter File Description box, type the name of the file. 

 Click Send Excel file to EDMS. 

3.1.12.1.22 Deleting and Replacing an EDMS File 

 
You can delete and replace EDMS files by doing the following: 
 

1. Under EDMS Integration, select the Document Name you would like to remove from the Excel file 

queue. 

2. Click the delete symbol, , located on the file row. 

 

A message appears and asks you for confirmation to remove the file from the EDMS queue. 

3. Click OK. 

The table will refresh and show the deleted file as removed. 

4. To replace a file, follow the steps listed in the sections above, Generating an Excel File and Uploading an 

Excel File to the EDMS Library. 

 Project Alerts (New 09/12/2014) 3.1.12.2

The EST Project Alerts feature monitors and notifies you of required actions for projects in your 
jurisdiction.  Alerts are triggered by two types of events: (1.) when an action needs to occur in order for 
another action to happen, and when (2.) a timed event is set to expire.  The EST displays alerts that have 
been received during the last 60 days. 
 
Note: See the Alert Types and Descriptions at the end of these instructions as a reference for the types 
of alert messages and descriptions. 
 
This section provides navigation steps for performing the following actions: 

 Displaying new alerts 

 Accessing the Project Alerts page through the EST menu 
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 Searching for alerts 

 Viewing active alerts 

 Dismissing and restoring alerts 

3.1.12.2.1 Displaying New Alerts 

New alerts are shown at the top of the EST window (on the EST project navigation bar) as a red box containing 
a number. The number represents unread alerts.   

5. Click the Alerts link to display the Project Alerts page. 

 

Tip!  Right-click to display the alerts on a separate tabbed page (i.e., the page you have in active 

display will remain open, with the Project Alerts page opening on a separate page). 

 

Note: After left-clicking the alerts link, the alert number returns to zero. 

The Project Alerts page opens and displays the New alert as a red box under the Alerts heading. 
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6. For steps on viewing and dismissing alerts, go to the Viewing Active Alerts and Dismissing and Restoring 

Alerts sections of these instructions. 

3.1.12.2.2 Accessing the Project Alerts Page through the EST Menu 

 

1. On the Tools menu, point to Project Dashboard, and then click Project Alerts. 

 

The Project Alerts page opens and displays a search filter, active alerts, and dismissed alerts. 

 

2. Go to Step 1 of the Searching for Alerts section of these instructions. 

3.1.12.2.3 Searching for Alerts 

The Project Alerts page allows you to search for active project alerts.  You can search by clicking one of 
the option buttons shown at the top of the page, or by selecting a time frame.  
 
Note: By default, the My Planning Org option will be shown as selected, but you can change a category 
type by clicking the relevant option button. 
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1. Click an option button to make one of the following selections: 

 Active Project List – Displays only project alerts for projects from the Active Project List (found 
on the EST project navigation bar, located on the top right side of the EST window). 

 My District – Displays only project alerts for the District for which you have jurisdiction. 

 My Planning Org – Displays project alerts for your planning organization. 

 ETDM number(s) – Displays project alerts for selected project(s). 

 My Projects only – Only displays alerts for projects you are assigned to manage. 

Note: This option is only available to project managers and user roles with project manager 
privileges.   

 

2. To search by time, do one of the following:    

 Click one of the options from the drop-down list. 

Note: The default date range is 60 days.  

 Click the Search Alert Date for check box to select another date range from the preformatted 
dates, or click Custom Date Range to enter a date range. 

 

 

3. Click Search. 

4. Go to Step 1 of the Viewing Active Alerts section of these instructions. 



 

 

 

 Environmental Screening Tool Handbook - February 15, 2016 3-379 

3.1.12.2.4 Viewing Active Alerts 

 

1. In the Action column, click the link on the ETDM number row. 

 

The EST page for the selected link opens and displays the information that needs to be updated, 
along with the appropriate form. 

Tip!  You can sort the list within a column category by clicking the column heading. Click the 

heading to sort the information in ascending order. Click the heading again to sort in descending 
order. 

After an action has been completed, the EST will remove the alert from the active alerts list. The 
entry removal will be apparent the next time you access the list.  

3.1.12.2.5 Dismissing and Restoring Alerts 

 
The Alerts feature in the EST allows you to dismiss an alert from the active alerts list (e.g., the alert does 
not apply to your job duties).  Alerts on the Active Alerts or  the Dismissed Alerts lists will be removed 
by the system if the alert no longer applies (e.g., alerts where there are only 5 days remaining).  
 

Note: To confirm an alert has been removed, reload or refresh the page.   

Tip!  You can restore a dismissed alert to the active alerts list by following the instructions in Step 

2 below. 

1. To dismiss an active alert, click the Dismiss button on the ETDM row.  

 

2. To restore a dismissed alert to active status, click the Restore button on the ETDM row under 

Dismissed Alerts. 

 

3.1.12.2.6 Alert Types and Descriptions 

The following table lists the different alert types and their descriptions: 
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Note: Alert types and descriptions are frequently updated. The following list shows only the alert types 
and descriptions that were available at the time of this documentation. 
 

Alert Types and Descriptions 

 

Alert Type 
 

Alert Description 
 

No ACE MM Response from Lead 
 

[Lead Agency] has not submitted an ACE 
Methodology Memorandum review  
 

5 Day Warning - No Project Effects 
Response 
 

Project review ends in 5 days or less and the 
following ETAT members have not submitted a 
degree of effect and/or comments about project 
effects: [list orgs] 
 

Class of Action - Approved/Not Approved 
 

[Lead agency] has [approved/not approved] the 
proposed Class of Action 
 

Elevated Degree of Effect 
 

Degree of Effect of dispute or substantial [List alt, 
agency, issue, DOE] 
 

Lead Action Needed for 
Participating/Cooperating  
 

Outstanding participating/cooperating agencies 
requests from FDOT to [lead] 
 

Participating/Cooperating Agency Request 
Outstanding 
 

Outstanding participating/cooperating Agency 
Requests to FDOT: [list orgs] 
 

ETAT Member Primary has Changed 
 
  

The ETAT Member Primary has changed for: [list 
orgs] 
 

Reviews Posted in last 5 days 
 

The following ETAT members have submitted project 
effects comments within last 5 days: [list orgs] 
 

No Purpose and Need Response from Lead 
 

[Lead agency] has not submitted a purpose and 
need response 
 

Summary Report Required 
 

A summary report needs to be published 
 

No Lead Agency 
 

No Lead Agency identified for this project 
 

5 Day Warning - No Purpose and Need 
Response  
 

Project review ends in 5 days or less and the 
following ETAT members have not responded about 
the purpose and need: [list orgs] 
 

5 Day Warning - No Class of Action 
Response 
 

[Lead Agency] has not responded to proposed COA 
and there are only 5 days or less remaining 
 

5 Day Warning - No ACE MM Response The following ETAT members have not commented 
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Alert Type 
 

Alert Description 
 

 
 
 
 

on an ACE MM review with only 5 days or less 
remaining: [list orgs] 
 

Document Review Requires Comment 
 
 

The following ETAT members have not commented 
on [document review event]:[list orgs] 
 

5 Day Warning - Participating/Cooperating 
Invitations Response Due 
 

 

Outstanding invitations for Participating/Cooperating 
agencies with 5 days or less remaining in invitation: 
[list orgs] 

 
Purpose and Need Not Accepted 
 
  

[Lead Agency] did not accept the purpose and need 
 

Purpose and Need Not Understood 
 

[ETAT] submitted a "Not Understood" on the purpose 
and need 
 

Purpose and Need Accepted 
 

[Lead Agency] accepted the purpose and need 
 

First Review Posted 
 

The first review for this project has been posted by: 
[ETAT member org] 
 

No Alternative Elimination Review from 
Lead Agency 
 

[Lead Agency] has not submitted Alternatives 
Elimination review 
 

 

 Project Benefits and Issues (In Development) 3.1.12.3

 Project Issue Tracking (In Development) 3.1.12.4

3.1.13 Document Review (Updated 12/30/2015) 

 Manage Document Review Events (Updated 09/30/2015) 3.1.13.1

The Manage Document Review Events tool in the EST allows you to set up and manage a document 
review. Use this tool to do the following actions: 
 

 Create a document review. 

 Select the document review participants. 

 Attach one or multiple documents. 

 Modify the notification email template. 

 Edit an existing review event. 
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 Allow comments after a review event has ended. 

 

 Accessing the Manage Document Review Events Page 3.1.13.2

On the Tools menu, move your mouse pointer to Document Review, and click Create or Manage Document 
Review Event. 

 

The Manage Document Review Events screen displays a form for setting up the type of action you want to 
take—setting up a new event or editing an existing event. The form is a drill-down process that displays 
questions that are based on your responses. The first question to appear asks Are you creating a new event, 
or editing an existing event? Click the option button beside the appropriate response. 

 New 

 Existing 

 

Your response determines the questions that will appear.  For this instruction guide, the sequence for creating a 
new event will be described in the next section, which will then be followed by a section on editing an existing 
event. 

 Creating a New Document Review Event 3.1.13.3

When you are disseminating a document for a first-time review, you will direct the EST to establish it as a 
new document review event. This will direct the EST to construct the appropriate questions that will guide 
you through the process of setting up the review. The preliminary step for creating a new event requires 
your response to questions pertaining to the following information: 
 

 Managing Organization – Where the document originated  
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 Name of the review event – Can be the name of a single document or a name for a batch of 

documents 

 Projects associated with document – Lists ETDM projects associated with the document being 

reviewed 

 Primary audience – Individuals or agencies reviewing the document 

 

1. To create a new event, click the New button.  

  

After you click the New button, a sequence of prompts will appear to guide you through the process 
of setting up the components of a new review event. 

2. Respond to each question prompt by either selecting the appropriate option from a drop-down list or 

typing your response into a text field. 

 

3. If you clicked Yes under Is this document related to an ETDM Project?, the screen will display the 

Select an ETDM Project field, type the ETDM project number or name into the field or select from the 

options matching your keyword. 

Tip!  When typing text related to information that is already stored in the ETDM database, you 

only need to type a keyword, or part of a word.  The EST autocomplete displays a list of items 
matching the first few letters or numbers you typed. You can then click on the item to select it. 
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The project name appears.  Repeat this step to add another ETDM project to the list.  

Tip! To remove a project from the document review, click the red X beside the project’s name. 

 

 

3.1.13.3.1 Selecting the Primary Audience 

When creating a new document review event, you will be prompted to select the review participants. The 
primary audience for the review consists of the decision-making bodies who are the direct recipients of a 
document (or batch of documents) and who will be participating in the review as commenters. This 
section instructs the EST on how to configure the email notification that will be sent for the event. The list 
that displays on the screen shows the following options: 
 

 SEMO Manager 

 SIS Central Office 

 FDOT ETDM Coordinator 

 FDOT ETDM Coordinator Primary 

 District Environmental Administrator 

 FDOT Community Liaison Coordinator 

 FDOT Community Liaison Coordinator Primary 

 Project Manager 
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 ETAT  – You will have the option to select all ETAT recipients statewide or from specific Districts, or 

you can choose specific organizations. 

 Other (let me choose individuals) – Use this option if you want to select specific individuals as the 

primary audience.  

 

1. To select the primary audience for the document review event, click the appropriate check box.  (See the 

next two steps for guidance on selecting ETAT and individuals).  

 

 

2. To add ETAT participants, do the following: 

 Click the ETAT check box. 

 

The screen displays additional prompts that allow you to choose All ETAT participants or 
Specific Agencies as the document recipients. 

 To send a document to all ETAT participants – Click the All ETAT button. The section expands 
and displays a Choose Districts option.  

 Do one of the following: 

 Click Statewide to select ETAT members from all Districts. 
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 Click Specific Districts and then click the check box beside one or more Districts. 

 

 To send a document to selected agencies – Click the Specific Agencies button. This will display 
a list of agency roles that you can select from, or you can enter the name of a specific agency.  
Select any of the following: 

 Click the check box beside an agency role (Lead, Cooperating, or Participating) to make 
your selection. 

 Click Other (let me choose agencies) to select or enter a specific agency name. 

 In the Search for an agency field, type part of the agency’s name. A list of agencies 
matching your entry will display. 

 Click on the agency name. The screen displays the agency name. Repeat this step for 
each agency name you want to add. 

 

Tip! To remove an agency from the list, click the Remove button beside the agency’s name. 

3. To select a specific individual, click the Other (let me choose individuals) check box. 
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The screen displays search options that allow you to either type the recipient’s name into a text 
box, or you can select names from your personal ETDM contact lists. 

 

 

 To Search for recipient – Type the recipient’s name into the text box, as shown in the next 
illustration, and then click Enter.  

Note: If the recipient’s name is already in the EST database, an autocomplete list will 
display.  
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 Adding a recipient not found in the database – If the name you type into the Search for 
recipient text box is not in the EST database, the screen displays a No match found 
message, as demonstrated in the next illustration. 

 

You can add a name to the EST database by doing the following: 

 Click the Add New button. 

 

The Add New Contact dialog box displays a form for the contact’s information. 

 

 Complete the fields displayed on the screen.  Fields showing an asterisk, *, are 

required information. 

 Click Next after you complete the fields for the respective information. 
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Note: If you’re entering a new contact whose email address matches the email address 
of another name, the Possible Match Found message will display. This may indicate the 
contact you have added is already in the database under a different spelling of the name. 
You can either click the Use my entry button to use the information you entered into the 
form, click the button beside a name shown on the possible matches list, or click 
Previous to return to the form to make corrections. 

 

 After completing the fields on the Add New Contact form, click Save. 
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The name of the new contact appears on the screen as being a member of the primary 
audience for the document review event. 

 

4. Click Preview Audience to review the names associated with a selected role. 

 

The screen refreshes and displays a list of names associated with the roles that were selected. 
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Note: The names shown along with the associated roles are generated from the EST database, 
and they cannot be removed from the list.  However, a Remove button will be displayed for names 
that you have added. In this case, you can click the Remove button located next to the name, as 
shown in the next illustration. 

5. Click ok. 

 

6. After you have entered your responses to all of the prompts displayed on the page, click Next. 
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3.1.13.3.2 Entering Event and Document Details 

After you enter the event’s preliminary information, the next step in creating a new document event is to 
record the details about the event and the document to be reviewed.  Forms for entering review details 
are displayed as tabbed sections that guide you through the document review setup process. 

Note: Tabs showing a red asterisk, *, indicate required fields that must be completed before a document 

review event can be created. Tabs showing a white dot indicate optional information that has not yet been 
addressed.  When you click a tab displaying a white dot, the dot will disappear whether you complete the 
respective form or not. 
 

 

 Details (Required) – Contains required fields for the event details, including description, the review 

start date, number of days for the review, and whether the document is related to ETDM projects or 

other document review events.   

Tip! You can set up a document review event in advance of the review start date by clicking 

the Review Start Date field and then selecting a date on the calendar tool.  The notification 
email will automatically be sent to recipients on the scheduled date. 

 Document Details (Required) – Displays a link for attaching documents, fields for describing the 

document being reviewed, and an option for indicating whether the document contains line numbers.  

 Audience – Lists the individuals and agencies that were selected as the primary audience. You can 

make edits to the list by using the Edit button located on the tab. 

 Staff – Allows you to add individuals within your organization access to documents and permits them to 

make comments. Staff members who will be reviewing documents and adding comments must first be 
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assigned an Internal Document Review - Staff role within the EST. Staff comments can only be 

viewed by administrators within the organization.  

 Responders – Allows you to add names of individuals from your organization who are assigned to 

respond to reviewing organizations’ comments after a document review event period ends.   Individuals 

tasked with responding to review comments must first be assigned an Internal Document Review - 

Responder role within the EST, 

 Prepare Notification – Displays the email template that will be sent to document recipients to inform 

them that a document review event has started. The system automatically inserts the event information 

that was entered during the setup process (e.g., document name, review start and end dates). 

 Restricted – Indicate if the reviews and responses recorded the document review event will be open to 

non-participants (i.e., other EST users not participating in the document review event and/or the public): 

 Click Yes if the document review is only available to participants of a document review 
event (reviewer, staff, responders, members of the organization that created the event) 
along with EST administrators and State Environmental Management Office Managers.  
This means the Document Reviews and Responses report that is produced will not be 
available for viewing to non-participants (i.e., other EST users and members of the public).  

 If the information from the document review event will be open for public access and other 
EST users, click No. 

 

 

Tip! At the bottom of the screen is a Submit section that contains messages showing you 

the steps that must be completed before you can submit your information.   

 

 
 

1. On the Details form, enter information about the document event into the fields provided. 
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Note:  Indicate if editing is restricted by clicking the appropriate response beside Restricted (click 
Yes to restrict editing; click No if document edits are allowed).                                                                                    

2. Click the Document Details tab to display the form and then do the following: 

 Click the Browse button to navigate to and upload the document. 

 Enter the document’s Name, Description, and Type. 

 Indicate if Line Numbers Available is applicable for the document by clicking Yes or No. 

 Click Save Document. 

  

The screen displays your uploaded document information, along with buttons for editing, 
deleting, and adding additional documents. 

 

3. To view the list of recipients that was created for the document review event’s primary audience, click the 

Audience tab. 

 To make changes to the list, click the Edit button located at the bottom of the list. 
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The page displays the primary audience selection form. 

 

 Make the appropriate changes following the steps shown in the Selecting the Primary Audience 
section of these instructions. 

 Click Close. 
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4. Add staff members and responders to the document review by clicking the respective tab and then typing 

an individual’s name into the Search for box provided, or select names from your ETDM personal 

contact list. 

 

5. Set up the email notification template by completing the available fields: 

 Email Notification CC 

 Email Notification Body (Top and Bottom) 

Note: The date and other event details are automatically entered by the system based on the 
information that was provided on the document review event information forms. 

 

6. Click the Preview button to display a print version of the email. 
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A Notification Preview box displays the email draft.  

 

 

7. Click Load Template. 

 

8. Under Submit, do one of the following: 

 Click Save Draft to save your information. 

 Click Save Final to initiate the document review event. 
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Depending on your previous action, one of the following messages appears: 

 If you clicked Save Draft (i.e., you are not sending the notification email to begin the document 
review event), the screen displays the message shown in the next illustration. 

Tip! Under Event Saved, a link appears for making changes to the review event. Click on the 

click here link to return to the document review setup form. 

 

 If you clicked Save Final (i.e., you are sending the notification email and starting the document 
review event on the same day), the screen displays the message shown in the next illustration. 
Click OK to confirm. 

 

 

 Editing an Existing Event 3.1.13.4

When you save a review event as a draft, you can return to it at a later time to make changes. To make 
changes to an existing event, do the following: 

1. Under the prompt Are you creating a new event, or editing an existing event?, click Existing. 
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The screen displays a search tool, with fields that allow you to search for an event by Keyword(s), 
Event Start Date Range, or by Organization. 

 

2. Enter the appropriate search information. 

3. Click Search. 

 

The screen displays a list of review events. 
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4. Under Event Name, click the link to the event you want to open. 

 

The Manage Document Review Events page displays the tabbed event’s Details form.  

 

5. Make any changes, where appropriate. 

6. Under Submit, click either Save Draft or Save Final. 
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 Extending or Cancelling an Active  Document Review Event 3.1.13.5

After a document review has started, you can extend the end date or cancel the review altogether. 
 
Note: After an event has past its scheduled end date, it will be labeled as completed. You will not be able 
to cancel or extend the end date for a completed event.  
 

1. Access the Manage Document Review Events page by following the steps listed in the first section of 

these instructions. 

2. On the Manage Document Review Events page, under the prompt Are you creating a new event, or 

editing an existing event?, click Existing. 

 

The screen displays the following message. 

 

3. Do one of the following: 

 To extend the review period - Type the revised date into the End Date field, or click on the date 
to select the revised date on the calendar tool, and then click Save. 
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 To cancel a document review event – Click Cancel Event. 

 

 

 Allowing Comments after a Review Event Has Ended 3.1.13.6

If an organization or individual participating in a document review event needs added time to review event 
materials and provide comments, you can grant an extension after a document review event has ended. 
However, you must provide a justification for granting an extension. 
 
Note: Granting an extension to an organization or individual will overwrite any existing extensions that 
have been granted to members within the same organization. 
 
To grant an extension to an organization or individual, do the following: 
 

1. Access the Manage Document Review Events page by following the steps listed in the first section of 

these instructions. 

2. On the Manage Document Review Events page, under the prompt Are you creating a new event, or 

editing an existing event?, click Existing. 

 

The screen displays the following message that the event has ended along with a link for displaying 
the form for granting extensions. 

3. Click the link. 

 

The page expands and displays the Event Documents list and an Allow Comments after Review 
Period section. 
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4.  Under Allow Comments after Review Period, do one of the following: 

 To grant an extension to an organization – Click the Organization button. 

 To grant an extension to an individual – Click the Individual button. 

5. Based on your selection, a list of names will appear. For this illustration, a list of organizations is being 

shown as selected.  (The process for granting extensions to organizations and individuals is the same.) 

 

6. Click the Grant Extension button for the selected Organization/User Name. 

 

A Grant Extension dialog box appears. 
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 In the Justification text box, type a justification for the extension. 

Note: A justification is required. 

 Type or select an End Date on the calendar tool, . 

 Click Submit. 

 

The page refreshes and displays the extension details. 
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 Review Documents (Updated 09/30/2015) 3.1.13.7

The EST’s Review Document tool allows document review participants to examine event documents and 
related information.  During a document review period, participants who have commenter privileges can 
make changes and record their remarks in the text box provided on the Review Document page.  These 
instructions guide you through the following actions: 
 

 Access the Review Document page. 

 Select a document review event. 

 View related review events and ETDM projects. 

 Display attached documents. 

 View comments from other participants. 

 Enter document review comments and attach supporting documents. 

 Search for document reviews and responses. 

 Download and print document reviews and responses. 

 

3.1.13.7.1 Access the Review Document Page 

There a couple of ways to access the Review Document page. 

 An email notification alerting you to the start of a new document review event will contain a link to the 

Review Document tool in the EST, as shown in the next illustration. Click the link to open the tool. 

 

 To access the Review Document page from the EST Tools menu, point your mouse to Document 

Review, and then click Review Document. 



 

 

 

 Environmental Screening Tool Handbook - February 15, 2016 3-406 

 

The Review Document screen opens and displays a list of documents to be reviewed, along with 
the start and end dates. 

 

Note: If no document review events are shown, the screen will display a message, as shown in the 
next illustration. 

 

3.1.13.7.2 Select a Document Review Event 

If you are participating in multiple document review events, you will see a list of event names, along with the 
start and end dates for each event. Click an Event Name link to begin your review. 

 

The Review Document page refreshes and displays the document review event details, along with a link to the 
documents that require a review, a section for entering your comments, and a list of reviewer comments. 
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3.1.13.7.3 View Related Review Events and ETDM Projects 

You can view additional information related to the document review by clicking the links to related document 
review events and ETDM projects.  

 To view Related Document Review Event(s), click the link to the event name.  

 

The Document Reviews and Responses page will display a read-only version of the related 
review event’s information, with a link to the attached documents. 
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 To view Related ETDM Project(s) – Click the link for the ETDM project name. The EST Public Site will 

open, allowing you to search for the project. 

 

3.1.13.7.4 Display Attached Documents 

Under Event Documents you will see a list of the documents that require a review for the event. In the 
Document (PDF) column, click the document name to open it. The document will display on a separate tabbed 
page. 

 

 

 

3.1.13.7.5 View Comments Made by Other Reviewers 

At the bottom of the Review Document screen is the Document Reviews section, which displays comments 
made by other participants during the document review.  The next illustration shows two documents that have 
been reviewed.  A list of Official Reviews displays the location of the comments within the document (e.g., line 
numbers; section(s), page(s), and paragraph(s); or global) along with the Reviewing Organization name and 
the respective Comments. 

If you are from the managing organization that set up the document review event and you have assigned staff 
members from your organization to review the document, you will find their comments under the Staff Reviews 
subhead. 
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3.1.13.7.6 Enter Document Review Comments 

The Review Document tool captures any comments you want to add regarding a document’s content. 

1. By default the name of the attached document will appear in the Document field.  When multiple 

documents are included in a review event, click the drop-down arrow and click on the appropriate 

document name to select it.  
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2. Identify which part of the document you are commenting on by doing the following: 

 If the document has numbered lines, type the line number(s) that your comments apply to. 

 If the document does not have numbered lines, type in the Section(s), Page(s), or Paragraph(s) 
numbers into the respective fields. 

 If your comments apply to the entire document, click the Global check box. 

3. Type your comments for the selected location into the Location Comments text box. 

4. If you have supporting documents that you would like to attach to your review, do the following: 

 Click the Submit Documents tab. 

 

The Review form displays the Attach Document tool. 

 

 Click the Add Document button.  
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The file upload form displays. 

 

 Follow the standard procedure for uploading a document from your desktop.   

 

Note: Documents must be in PDF format.  

 Complete the required fields (noted by a red asterisk *) shown on the form.   

Note: To attach multiple documents to your review, repeat these steps for each document 
you are attaching. 

 Click Save Document. 

 

The screen displays the document name, size, and description along with buttons for making 
edits or for removing the document: 
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Tip!  Click the pencil icon, , to put the form into editing mode, which allows you to revise 

or make changes to the document description or replace the document. Click the trash can 

icon, , to completely remove the attached document. 

 

 

5. Click Save Review. 

 

The screen displays your comments under Document Reviews.  You can then make text changes 
or remove any review comments. 

 

3.1.13.7.7 Edit Your Comments 

After you save your review comments, you can make changes using the edit feature located beside each 
comment. 
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Note: You can only make changes when a document review event is in active status, which is the time period 
between the start and end dates. 

 

 

1. Click the pencil icon, , to start the edit mode. This will place your comments back into the Location 

Comments text box, which is now active. 

 

2. Type your changes into the Location Comments text box. 

3. Click Save Review. 

3.1.13.7.8 Delete Review Comments 

You can remove a review comment using the delete tool. Click the trash can icon, , located on the row of 
the comment you wish to remove.  

 

 

3.1.13.7.9 Search for Document Reviews and Responses 

You can view the reviews and responses from other document review events by using the Document Reviews 
and Responses feature located in the EST’s Reports menu. 
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1. On the EST Reports menu, point to Document Review, and then click Document Reviews and 

Responses. 

 

The Document Reviews and Responses page displays a search panel. 

 

2. Enter your search criteria into any of the fields displayed on the screen. 

3. Click Search. 

 

The screen refreshes and displays a list of document review events that match your selected 
criteria. 
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4. Click on the Event Name link to display the event details, along with the reviews and responses from 

event participants. 

Tip!  You can also click the Back to Search Panel link that is located on the top left corner of a 

Document Reviews and Responses page for a selected event, as shown in the next illustration. 

 

3.1.13.7.10 Download and Print Document Reviews and Responses 

You can save or print a PDF of the reviews and responses for a document review event by clicking the PDF 
icon located on the page toolbar. 
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The screen displays a PDF version of the Document Reviews and Responses page, where you can follow 
the standard process for saving or printing a PDF document. 

 

 Respond to Document Reviews  3.1.13.8

The Respond to Document Reviews tool allows authorized individuals to respond to comments made 
by agency officials and staff during a document review event. 
 

1. To access the Respond to Document Reviews page, go to the EST Tools menu, point your mouse to 

Document Review, and then click Respond to Document Reviews. 

 

The Respond to Document Reviews screen opens and displays a list of Document Review 
events. 
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Click the document review event name to select it. 

 

Details for the document review event along with links to associated documents are displayed.  

2. Under the Official Reviews section, click the appropriate check box located in the Select or Delete 

column to indicate the review you are responding to. 

 

3. Type your comments in the Response text box. 

Note: The Response text box is a required field. 
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4. Click Save Response. 

 

The page refreshes and displays your comments in the Response column. 
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3.1.13.8.1 Deleting a Response 

Let’s say you discovered a typo in a response you just saved. You can delete the response and replace it with a 
new one by doing the following: 

 

1. Under Select or Delete, click the trash can icon. For this illustration, a typo will be corrected. 

 

A message appears asking for confirmation from you to delete the response. 

 

2. Click OK. The response will be removed. 

 

 

 

 


